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1. INTRODUCTION TO ABAQUS VERSION 6.5

This document introduces the new features in ABAQUS Version 6.5. Chapter 1 provides a brief overview of

the ABAQUS products included in this release. Chapters 2–16 provide short descriptions of new Version 6.5

features in ABAQUS/Standard, ABAQUS/Explicit, and ABAQUS/CAE, categorized by subject:

• Chapter 2, “General enhancements”: general changes to the ABAQUS interface.

• Chapter 3, “Execution”: commands and utilities for running any of the ABAQUS products.

• Chapter 4, “Modeling”: features related to creating your model, such as node and element definition in

ABAQUS/Standard or ABAQUS/Explicit and part and assembly definition in ABAQUS/CAE.

• Chapter 5, “Geometry import and repair”: features related to importing parts into ABAQUS/CAE and

repairing problematic geometry.

• Chapter 6, “Analysis procedures”: features related to defining an analysis.

• Chapter 7, “Materials”: new material models or changes to existing material models.

• Chapter 8, “Elements”: elements available in ABAQUS.

• Chapter 9, “Prescribed conditions”: loads, boundary conditions, and fields.

• Chapter 10, “Constraints”: kinematic constraints.

• Chapter 11, “Interactions”: features related to contact and interaction modeling.

• Chapter 12, “Engineering features”: engineering features related to part and assembly modeling.

• Chapter 13, “Meshing”: features related to meshing your model.

• Chapter 14, “User subroutines, utilities, and plug-ins”: additional user programs that can be run with

ABAQUS.

• Chapter 15, “Output and visualization”: obtaining, postprocessing, and visualizing results from

ABAQUS analyses.

• Chapter 16, “ABAQUS Scripting Interface”: using the ABAQUSScripting Interface to write user scripts.

Each entry in these chapters clearly indicates the ABAQUS product or products to which the feature applies

and includes cross-references to more detailed information. Chapter 17, “Summary of changes,” summarizes

in tabular format the changes to ABAQUS elements, MPCs, keyword options, user subroutines, and output

variable identifiers.





INTRODUCTION TO ABAQUS VERSION 6.5

1.1 KEY FEATURES OF VERSION 6.5

Version 6.5 is a major release of ABAQUS. There are significant new features and enhancements in all

ABAQUS products, including the following:

• The Model Tree is a convenient new tool for navigating and managing models. The Model Tree appears

in the ABAQUS/CAE main window, providing a visual description of the model object hierarchy. The

Model Tree also provides shortcuts to the main menu bar, module toolboxes, and the various managers

(“The Model Tree,” Section 2.5).

• ABAQUS/Explicit analyses using domain-level parallelization require significantly less memory per

domain as the number of domains increases in Version 6.5 compared to Version 6.4. The memory

required for single-domain analyses has also been reduced for Version 6.5 (“Memory reductions for

ABAQUS/Explicit analyses,” Section 2.10).

• ABAQUS/Explicit offers a general capability for modeling progressive damage and failure in the Mises,

Johnson-Cook, Hill, and Drucker-Prager plasticity models. Damage initiation criteria are available for

ductile or shear fracture of metals and necking instability of sheet metal as well as damage initiation in

cohesive elements with traction-separation response (“Progressive damage and failure,” Section 7.5).

• A family of cohesive elements is supported in ABAQUS/Standard, ABAQUS/Explicit, and

ABAQUS/CAE for modeling deformation and damage in finite-thickness adhesive layers between

bonded parts. Cohesive elements are typically connected to underlying elements with surface-based tie

constraints, so the mesh used for the cohesive layer can be independent of the mesh used for the bonded

components (“Cohesive elements,” Section 8.6).

• Numerous enhancements have been implemented to improve contact performance and robustness in

ABAQUS/Standard and ABAQUS/Explicit (Chapter 11, “Interactions”).

– The accuracy of ABAQUS/Standard contact stress results improved with the addition of a true

surface-to-surface formulation for small-sliding contact to mitigate contact stress oscillations at

interfaces, even for mismatched meshes. The new formulation also accounts for surface thicknesses

and offsets (“Surface-to-surface small-sliding contact accounting for thickness,” Section 11.1).

– Noise in contact and element stresses near the contact interface is reduced for most second-order

element types in ABAQUS/Standard by specifying a softened pressure-overclosure relationship

or using an augmented Lagrangian contact enforcement method (“Improved contact stresses for

second-order elements,” Section 11.2).

– Improved stabilization methods can be specified for ABAQUS/Standard multi-body contact

problems where rigid body modes exist initially because contact is not present in the first solution

increment. You can apply viscous stabilization for both normal and tangential motions to selected

contact pairs, including a damping coefficient based on the stiffness of the underlying material

(“Stabilization of multi-body contact problems with rigid body modes,” Section 11.11).

• The ability to define and analyze cracks in ABAQUS/CAE increases the coverage of ABAQUS fracture

mechanics functionality.
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– ABAQUS/CAE includes support for fracture mechanics analysis using an embedded seam with

duplicate overlapping nodes. The crack definition can be used to perform fracture calculations using

contour integrals (“Defining a crack in ABAQUS/CAE,” Section 12.5).

– The position of the midside nodes of second-order elements can be adjusted using the

ABAQUS/CAE Edit Mesh toolset to include a singularity at the crack tip for fracture mechanics

analysis (“Using the Edit Mesh toolset to adjust the position of midside nodes,” Section 13.10).

• In addition to improving boundary and surface meshing capabilities, ABAQUS/CAE Version 6.5

includes a completely new tetrahedral meshing algorithm (Chapter 13, “Meshing”).

– Meshing a part in theMeshmodule, as opposed to meshing a part instance from the assembly, allows

the mesh to appear on each instance of the part although the part is meshed only once (“Meshing

parts,” Section 13.1).

– ABAQUS/CAE considers geometric curvature along edges to simplify the task of automatically

seeding models that have holes of various sizes, blends, and other regions of high curvature with

the appropriate target element size for meshing (“Support for curvature-based part seeding,”

Section 13.3).

– ABAQUS/CAE Version 6.5 includes a completely new tetrahedral meshing algorithm providing

fast, reliable, automated meshing of very complex geometries. ABAQUS/CAE users have the

option of selecting either the new (default) algorithm or the Version 6.4 tetrahedral meshing

algorithm (“New tetrahedral meshing algorithm,” Section 13.4).

• View cuts enable visualization of the interior or selected portions of the model or results by creating

planar, cylindrical, or spherical sections through the model. View cuts can also be defined along a

constant contour variable value or isosurface (“Viewing the interior of a model,” Section 15.12).

ABAQUS Version 6.5 includes the following additional infrastructure enhancements:

• Version 6.5 is released on CD-ROM for the following combinations of supported operating systems and

processors:

– Linux/x86-32

– Windows/x86-32

– HP-UX/Itanium

– Linux/Itanium

– AIX/POWER

The full range of ABAQUS products is supported on Windows/x86-32 platforms. All ABAQUS

products except fe-Safe Version 5 are supported on Linux/x86-32 platforms. The analysis products,

ABAQUS/Standard and ABAQUS/Explicit as well as ABAQUS/Aqua and ABAQUS/Design, are

supported on the remaining platforms listed above. For current details on supported ABAQUS products

and platforms, see Support & Services→Technical Support→Systems Information on the

ABAQUS Home Page. For more information on system requirements, see Appendix A, “System

requirements,” of the ABAQUS Installation and Licensing Guide.
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• On Windows platforms ABAQUS/CAE supports native printing, which automatically lists available

printers and selects the current default printer. Standard Windows print settings and dialog controls are

used to choose page formatting and printer-specific options (“Enhanced printing onWindows platforms,”

Section 2.4).

• 3Dconnexion motion controllers are supported in conjunction with the mouse to manipulate the model

view with one hand on the motion controller while using the mouse to select from the model with the

other hand. ABAQUS/CAE provides a set of “Application Functions” available through the standard

3Dconnexion user interface providing shortcuts to view manipulation and display tools (“Support for

3Dconnexion motion controllers,” Section 2.8).

• ABAQUSVersion 6.5 uses FLEXlmVersion 9.2 fromMacrovision Corporation (upgraded from FLEXlm

Version 8.2 for ABAQUS Version 6.4) for license management. For more information, see “Installing

ABAQUS licensing,” Section 2.1.2 of the ABAQUS Installation and Licensing Guide.

The remaining chapters in this book provide details on these and other new features of ABAQUS Version 6.5.

In addition to the enhancements listed here, most of the known bugs in Version 6.4 are corrected.

1.2 ABAQUS PRODUCTS

The various components of the ABAQUS finite element analysis program are described in this section.

Analysis

• ABAQUS/Standard: This module is the general-purpose finite element analysis product. It includes

all analysis capabilities except nonlinear dynamic analysis using explicit time integration—provided in

the ABAQUS/Explicit module—and the add-on analysis functionality described below.

• ABAQUS/Explicit: This product provides nonlinear, transient, dynamic analysis of solids

and structures using explicit time integration. Its powerful contact capabilities, reliability, and

computational efficiency on large models also make it highly effective for quasi-static applications

involving discontinuous nonlinear behavior.

Add-on analysis

• ABAQUS/Aqua: This add-on analysis capability for ABAQUS/Standard provides wave loading, drag,

and buoyancy calculation capabilities for modeling offshore piping and floating platform structures.

• ABAQUS/Design: This add-on analysis capability for ABAQUS/Standard allows the user to perform

design sensitivity analysis (DSA). The derivatives of output variables are calculated with respect to

specified design parameters.

• ABAQUS/Foundation: This analysis option offers more efficient access to the linear static and

dynamic analysis functionality in ABAQUS/Standard.
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Analysis environment

• ABAQUS/CAE: This product is a Complete ABAQUS Environment that provides a simple, consistent

interface for creating, submitting, monitoring, and evaluating results from ABAQUS simulations.

ABAQUS/CAE is divided into modules, where each module defines a logical aspect of the modeling

process; for example, defining the geometry, defining material properties, generating a mesh, submitting

analysis jobs, and interpreting results.

Postprocessing

• ABAQUS/Viewer: This subset of ABAQUS/CAE contains only the postprocessing capabilities of the

Visualization module. It uses the output database (.odb) to obtain results from the analysis products.

The output database is a neutral binary file. Therefore, results from an ABAQUS analysis run on any

platform can be viewed on any other platform supporting ABAQUS/Viewer. It provides deformed

configuration, contour, vector, and X–Y plots, as well as animation of results.

Interfaces

• ABAQUS Interface for MOLDFLOW: This interface translates finite element model

information from a MOLDFLOW analysis to an ABAQUS input file. For Version 6.5 the

ABAQUS Interface for MOLDFLOW supports filled and unfilled three-dimensional MOLDFLOW

simulations. For more information, see the ABAQUS Interface for MOLDFLOW User’s Manual.

• ABAQUS Interface for MSC.ADAMS: This interface allows ABAQUS finite element models to

be included as flexible components within the MSC.ADAMS family of products. The interface is

based on the component mode synthesis formulation of ADAMS/Flex. Specifically, flexibility data

from ABAQUS superelements are translated to the modal neutral (.mnf) file format required by the

ADAMS/Flex product. Although the ADAMS/Flex interface supports only linear flexibility data, the

ABAQUS user may include an arbitrary number of preloading steps before the linear flexibility data are

obtained. Multiple flexible components generated by ABAQUS can be included in an MSC.ADAMS

model. Most ABAQUS structural elements are supported by the interface.

Translators

• ABAQUS translators are provided with the release. They are invoked through the ABAQUS execution

procedure (the “driver”). The translators and the commands to invoke them are described below:

abaqus fromnastran translates a NASTRAN bulk data file to an ABAQUS input file.

abaqus frompamcrash translates a PAM-CRASH input file to a partial ABAQUS input file.

abaqus toOutput2 translates an ABAQUS output database file to the NASTRAN Output2 file

format.

abaqus tozaero enables you to exchange aeroelastic data between the ABAQUS and ZAERO

analysis products.
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Utilities

• Additional programs are included with the release. They are all invoked through the ABAQUS execution

procedure (the “driver”). The utilities and the commands to invoke these programs are described below:

abaqus append joins separate results files into a single file.

abaqus ascfil translates ABAQUS results files between ASCII and binary formats, which is useful

for moving results files between different computer types.

abaqus networkDBConnector creates a connection to a network ODB server that can be used to

access a remote output database.

abaqus doc accesses the online documentation for the ABAQUS manuals.

abaqus fetch extracts example input files from the libraries included with the release.

abaqus findkeyword provides a list of sample problems that use the specified ABAQUS options.

This utility will help users find examples of features they may be using for the first time.

abaqus free converts all fixed format data in an input file to free format.

abaqus licensing provides a summary of the available FLEXlm licensing utilities.

abaqus make compiles and links user-written postprocessing programs for ABAQUS and creates

user-defined libraries of ABAQUS/Standard and ABAQUS/Explicit user subroutines.

abaqus python accesses the Python interpreter.

abaqus resume resumes an ABAQUS analysis job.

abaqus script initiates a Python scripting session.

abaqus suspend suspends an ABAQUS analysis job.

abaqus upgrade upgrades an input file or output database file from previous versions of ABAQUS

to the current version.

• The convertenv utility for converting Version 5.8 and earlier abaqus.env files to Version 6.1 and later

abaqus_v6.env files that use Python syntax has been removed. If you want to convert Version 5.8

and earlier abaqus.env files, use an earlier version of ABAQUS to access the convertenv utility or

convert the file manually.

Documentation

• For Version 6.5 the ABAQUS online documentation is provided in PDF format (in addition to HTML

format). The PDF collection contains all of the books in the ABAQUS HTML online collection except

Getting Started with ABAQUS/Standard: Keywords Version, Getting Started with ABAQUS/Explicit:

Keywords Version, andUsing ABAQUSOnline Documentation. For more information, see Appendix D,

“Using ABAQUS PDF documentation,” of the ABAQUS Installation and Licensing Guide.

• The tutorial sections from the beginning of the ABAQUS/CAE User’s Manual have been moved to the

end of Getting Started with ABAQUS. Getting Started with ABAQUS introduces you to all aspects of

the ABAQUS products, whether you are completely new to ABAQUS or you are already familiar with

the ABAQUS solver products but would like to learn how to create, analyze, or postprocess your model
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in ABAQUS/CAE. See “Getting started with ABAQUS,” Section 1.2 of Getting Started with ABAQUS,

for more information.

• When searching the online books, the expansion of the table of contents is retained. The current location

in the text frame is now highlighted in the table of contents frame. You can easily expand several levels or

collapse all levels of the table of contents using the new Expand/Collapse buttons in the book window.

• The Mozilla web browser is supported on Linux and Windows platforms for viewing online

documentation.

• ABAQUS/CAE usage information has been added to the ABAQUS Analysis User’s Manual.

1.3 ENHANCEMENTS TO THE ABAQUS ENVIRONMENT FILE

The browser_type and browser_path variables can be set in the environment file to control the behavior

of the execution procedure for online documentation. These variables also provide the ability to customize a

supported web browser or to use a web browser not supported by ABAQUS for viewing online documentation,

although these uses are not recommended. For more information, see “System customization parameters,”

Section 4.1.4 of the ABAQUS Installation and Licensing Guide, and “Execution procedure for ABAQUS

HTML documentation,” Section 3.2.7 of the ABAQUS Analysis User’s Manual.

The lmlicensequeuing parameter indicates whether an ABAQUS analysis job or an ABAQUS/CAE or

ABAQUS/Viewer job using the noGui option should queue for a license if one is not available. For more

information, see “License management parameters,” Section 4.1.6 of the ABAQUS Installation and Licensing

Guide.
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2. GENERAL ENHANCEMENTS

This chapter describes the following general enhancements that have been made to ABAQUS:

• “Enhanced ABAQUS installation procedures,” Section 2.1

• “Preselection highlighting,” Section 2.2

• “Enhanced color selection,” Section 2.3

• “Enhanced printing on Windows platforms,” Section 2.4

• “The Model Tree,” Section 2.5

• “Saving your display options and GUI settings,” Section 2.6

• “Suppressing and resuming step-dependent objects,” Section 2.7

• “Support for 3Dconnexion motion controllers,” Section 2.8

• “Exporting to VRML,” Section 2.9

• “Memory reductions for ABAQUS/Explicit analyses,” Section 2.10

• “Display group enhancements,” Section 2.11

• “Performance improvements for ABAQUS/Standard models with many section and/or material

definitions,” Section 2.12

• “Performance improvements for ABAQUS import models,” Section 2.13

• “Viewport annotations and tools,” Section 2.14
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2.1 ENHANCED ABAQUS INSTALLATION PROCEDURES

Benefits: The revised installation procedures offer usability and functional enhancements including a first-

in-class GUI-based upgrade of an ABAQUS FLEXlm license server and support for installation on shared file

systems.

Description: The ABAQUS licensing installation procedure now upgrades an existing ABAQUS FLEXlm

license server provided the existing server was started using the licensing installation procedure. The uninstall

procedure for ABAQUS licensing on Windows platforms has been simplified.

The ABAQUS product installation setup command supports several new options including file-server

installations (-crossplatform option), multiple identical installations (-replay option), and

specification of a Java Runtime Environment (-jre option). You can now configure ABAQUS for parallel

execution during the product installation procedure.

The HTML documentation installation procedure now offers the option to install the HTML

documentation without a web server; however, no search functionality is available with this option.

Reference:

ABAQUS Installation and Licensing Guide

• Chapter 2, “Installing ABAQUS”

2.2 PRESELECTION HIGHLIGHTING

Product: ABAQUS/CAE

Benefits: Preselection highlighting allows you to see exactly which object will be selected from the viewport

before you make a selection. It eliminates any uncertainty when you select an object from the current viewport

in ABAQUS/CAE.

Description: Preselection highlighting is available during procedures that require you to select an object

from the viewport. The highlighting is activated when you stop moving the cursor. If the object near the

cursor is a valid selection for the current procedure, ABAQUS/CAE highlights the object in orange. Hidden

objects, such as some edges and faces in a shaded model view, are also highlighted if they are the selections

nearest to the cursor. Figure 2–1 shows preselection highlighting of the model edge closest to the cursor.

If more than one selection is possible, ABAQUS/CAE displays ellipsis marks (...) to the right of the

cursor and highlights all the choices. Figure 2–2 shows two preselected planes; this ambiguous preselection

occurs if you toggle off the ABAQUS/CAE default behavior to select the object nearest to the screen. You

can reposition the cursor to remove the ambiguity or click mouse button 1 to accept the ambiguous selection.

If you make an ambiguous selection, you must use the Next, Previous, and OK buttons in the prompt area

to cycle through the objects and make your final selection.
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Figure 2–1 Preselection highlighting.

Figure 2–2 Ambiguous preselection.

Preselection in the Sketcher remains unchanged from previous versions of ABAQUS/CAE.

ABAQUS/CAE Usage:

Click the selection options tool that appears in the prompt area, and use the Allow Preselection During

Picking tool to toggle preselection highlighting on or off. Preselection highlighting is toggled on by

default.
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References:

ABAQUS/CAE User’s Manual

• “Selecting and unselecting individual objects,” Section 6.2.1

• “Highlighting objects prior to selection,” Section 6.3.4, in the online version of this manual

• “The Sketcher cursors and preselection,” Section 19.4.5

2.3 ENHANCED COLOR SELECTION

Product: ABAQUS/CAE

Benefits: You can now select colors from the full spectrum when customizing the background, fonts, and

graphic symbols used in the viewports. The expanded color options provide you with more ways to customize

the color of items.

Description: You are no longer limited to a list of color names when you select a color for the background,

fonts, or graphic symbols in ABAQUS/CAE. You can choose any of the following methods to select a new

color:

• A color palette of 24 common colors

• An eyedropper that you can use to select any color on the computer screen

• A full spectrum color wheel with brightness control and a picked point for the current selection

• Red, green, and blue (RGB)

• Hue, saturation, and value (HSV)

• Cyan, magenta, and yellow (CMY)

• A list of several hundred named colors, including shades of gray

You can use these color selection methods to match the colors in a presentation or to enhance the displayed

or printed output from ABAQUS/CAE. In addition, you can choose a solid or gradient viewport background.

Select a new color by opening the dialog box that contains the settings for the item you want to change.

Click the rectangular color sample . The Select Color dialog box shown in Figure 2–3 appears.

Use the methods in the dialog box to select a new color or to modify the current color.

Note: XY Curve Options still uses an abbreviated list of colors.

ABAQUS/CAE Usage:

Any module:

Viewport→Viewport Annotation Options

View→Graphics Options
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Figure 2–3 The Select Color dialog box.

Visualization module:

View→ODB Display Options

Options→Undeformed Shape, Deformed Shape, Contour, Symbol, Material Orientation,

Display Body: Color & Style, or XY Plot

Reference:

ABAQUS/CAE User’s Manual

• “Customizing colors,” Section 3.2.9

2.4 ENHANCED PRINTING ON Windows PLATFORMS

Product: ABAQUS/CAE

Benefits: You can now print images on Windows printers without using a print command.

Description: ABAQUS/CAE lists the printers available on any Windows platform and automatically

selects the current default printer. You can use the default printer or select another printer from the list.

Use the settings and buttons in the Print dialog box to choose page formatting and printer-specific options.

Figure 2–4 shows the Print and the Page Setup dialog boxes; these dialog boxes contain options specific to

ABAQUS/CAE and your selected image.
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Figure 2–4 The Print and Page Setup dialog boxes.

The Properties button opens the Document Properties dialog box that contains printer-specific settings;

you may already be familiar with this dialog box, since it is used by many Windows programs.

If you are using a UNIX or Linux workstation or if your Windows workstation does not have a printer,

you must enter a print command and set the PostScript options to print your image to a PostScript printer.

ABAQUS/CAE Usage:

Any module:

File→Print

References:

ABAQUS/CAE User’s Manual

• “Choosing the destination of your image,” Section 8.2.4

• “Customizing the image sent to a Windows printer,” Section 8.2.5
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2.5 THE MODEL TREE

Product: ABAQUS/CAE

Benefits: The Model Tree provides a visual description of the hierarchy of objects in a model, and it is a

convenient tool for navigating and managing your models. In addition, the Model Tree provides shortcuts to

much of the functionality of the main menu bar, the module toolboxes, and the various managers.

Description: The Model Tree appears on the left side of the ABAQUS/CAE main window. For example,

Figure 2–5 shows the appearance of the Model Tree after completing the cantilever beam analysis in

Appendix B, “Creating and Analyzing a Simple Model in ABAQUS/CAE,” of Getting Started with

ABAQUS.

Figure 2–5 The object Model Tree after completing the cantilever beam tutorial.

The arrangement of the objects in the Model Tree reflects the order in which you are expected to create your

model. A similar logic governs the order of the modules in the module menu.

Clicking mouse button 3 over an item in the Model Tree displays a menu that reproduces much of the

functionality of the main menu bar, the module toolboxes, and the various managers. For example, the menu

allows you to switch modules, create and edit objects, and suppress and resume objects. When you become
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familiar with the Model Tree, you will find that you can use it to quickly and conveniently perform most of

the tasks required to create and manage your models.

You can toggle off the display of the Model Tree by selecting View→Show Model Tree from the main

menu bar. Typing [Cntrl]+T has the same effect.

Reference:

ABAQUS/CAE User’s Manual

• “Working with the Model Tree,” Section 3.5

2.6 SAVING YOUR DISPLAY OPTIONS AND GUI SETTINGS

Product: ABAQUS/CAE

Benefits: Settings that affect the appearance of ABAQUS/CAE, such as the size of the main window and

the render style, can be saved and applied to subsequent sessions.

Description: You can save your modified part and assembly display options settings such as render style

and datum visibility, and ABAQUS/CAE will apply the settings to subsequent sessions. You can also save

your display options settings from the Visualization module, such as render style and fill style in different

plot modes. You can save the settings in a file in your home directory and apply them to all ABAQUS/CAE

sessions. Alternatively, you can save the settings in a file in a local directory and apply them to any

ABAQUS/CAE sessions that you start in that directory.

In addition, if you modify your ABAQUS/CAE GUI settings (for example, the size of the main window

or the size and location of a particular dialog box), ABAQUS/CAE stores the new settings and applies them

to future sessions. ABAQUS/CAE stores the GUI settings in a file in your home directory and applies them

to all subsequent sessions.

ABAQUS/CAE Usage:

Any module:

File→Save Options

References:

ABAQUS/CAE User’s Manual

• “Saving your display options settings,” Section 50.12

• “Saving your ABAQUS/CAE GUI settings,” Section 3.6

• “Using the File menu,” Section 9.6
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2.7 SUPPRESSING AND RESUMING STEP-DEPENDENT OBJECTS

Product: ABAQUS/CAE

Benefits: You can suppress step-dependent objects to exclude them temporarily from the model.

Description: You can suppress output requests, interactions, loads, boundary conditions, and fields using the

step-dependent managers or using the suppress procedures from themainmenu bar in the Step, Interaction, and

Load modules. A previously suppressed object can be resumed in the same manner. Suppressed objects are

not written to the input file and cannot be edited. Figure 2–6 illustrates how suppressed objects are displayed

in the step-dependent managers.

Figure 2–6 The Load Manager indicates that the load named Force is suppressed.

ABAQUS/CAE Usage:

Step module:

Output→Field Output Requests→Suppress or Resume

Output→History Output Requests→Suppress or Resume

Interaction module:

Interaction→Suppress or Resume

Load module:

Load→Suppress or Resume

BC→Suppress or Resume

Field→Suppress or Resume
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Reference:

ABAQUS/CAE User’s Manual

• “Suppressing and resuming step-dependent objects,” Section 3.4.3

2.8 SUPPORT FOR 3DCONNEXION MOTION CONTROLLERS

Product: ABAQUS/CAE

Benefits: You can use the 3Dconnexion motion controllers to manipulate the view of your model in

ABAQUS/CAE and to work more efficiently.

Description: 3Dconnexion (www.3dconnexion.com) manufactures a variety of view manipulation devices

that are popular with users of CAE and CAD systems. One example of their devices is the SpaceBall that is

illustrated in Figure 2–7.

Figure 2–7 The 3Dconnexion SpaceBall.

You can use the 3Dconnexion (www.3dconnexion.com)motion controllers in conjunctionwith the mouse

to work with ABAQUS/CAE. You can manipulate the view of your model with one hand on the motion

controller while using the mouse to select from the model with the other hand.

In addition, ABAQUS/CAE provides a set of “Application Functions” that are available through the

standard 3Dconnexion user interface. These functions provide shortcuts to the view manipulation, view, and

display tools. You can map these functions to the programmable buttons that are built into the 3Dconnexion

motion controllers.

Reference:

ABAQUS/CAE User’s Manual

• “Using the 3Dconnexion motion controllers with ABAQUS/CAE,” Section 5.6, in the online version of

this manual
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2.9 EXPORTING TO VRML

Product: ABAQUS/CAE

Benefits: VRML-format image files increase the portability of ABAQUS/CAE models across networks and

applications.

Description: You can export viewport data from ABAQUS/CAE in Virtual Reality Modeling Language

(VRML) format. You can view VRML-format three-dimensional images in any web browser or stand-alone

client that supports VRML. VRML-format files can be many times smaller than typical model database files

and are easy to share across a network.

ABAQUS/CAE Usage:

Any module:

File→Export→VRML

Reference:

ABAQUS/CAE User’s Manual

• “Exporting viewport data to a VRML-format file,” Section 10.9.4, in the online version of this manual

2.10 MEMORY REDUCTIONS FOR ABAQUS/Explicit ANALYSES

Product: ABAQUS/Explicit

Benefits: Memory requirements for ABAQUS/Explicit analyses that use domain-level parallelization have

been greatly reduced.

Description: In previous versions of ABAQUS/Explicit the memory usage per domain for analyses

conducted with domain-level parallelization was relatively insensitive to the number of domains used:

gradual reductions in memory usage per domain would occur as the number of domains increased. In

Version 6.5 the memory used in scalar (single-domain) analyses has been reduced somewhat in comparison

to Version 6.4, and significant reductions in memory usage per domain can be observed as the number of

domains is increased. These reductions in memory usage result in a significantly lower memory requirement

for ABAQUS/Explicit analyses that use domain-level parallelization. These trends are shown in Table 2–1,

which compares memory usage across versions and in scalar versus parallel analyses for a particular (large)

model.

2–12



GENERAL ENHANCEMENTS

Table 2–1 GBytes per domain.

# domains Version 6.4 Version 6.5

1 4.3 3.6

8 2.9 0.93

Reference:

ABAQUS Analysis User’s Manual

• “Parallel execution in ABAQUS/Explicit,” Section 7.19.3

2.11 DISPLAY GROUP ENHANCEMENTS

Product: ABAQUS/CAE

Benefits: In the Visualization module you can create display groups using element types, material

assignments, and section assignments. You can also select internal sets and surfaces for use in display groups

throughout ABAQUS/CAE.

Description: Internal sets and surfaces are available in all modules that support the use of display groups

(all modules except the Job module and the Sketch module). You can select elements by material or section

assignments; however, material and section assignment information is available only for output databases that

contain the required information (analyses run using ABAQUS Version 6.5).

The selection of nodes and elements by result values in the Visualization module has also been enhanced;

symbols are now used to represent the desired range of result values for use in the display group, as shown

in Figure 2–8.

ABAQUS/CAE Usage:

Visualization module:

Tools→Display Group→Create

References:

ABAQUS/CAE User’s Manual

• “Creating or editing a display group,” Section 51.2.1

• “Selection methods for creating or editing a display group,” Section 51.2.2, in the online version of this

manual
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Figure 2–8 The Create Display Group dialog box.

2.12 PERFORMANCE IMPROVEMENTS FOR ABAQUS/Standard MODELS

WITH MANY SECTION AND/OR MATERIAL DEFINITIONS

Product: ABAQUS/Standard

Benefits: The performance of ABAQUS/Standard models with many section and/or material definitions is

greatly improved in many situations.
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Description: Models with thousands of section and/or material definitions may now run much faster than in

previous versions of ABAQUS/Standard and have much smaller output database (.odb) files. The results in

Table 2–2 illustrate the performance gains for a model with 10000 linear brick elements (61206 DOF), each

with their own unique anisotropic material definition (and, thus, their own section definition). The analysis

consists of one general static step with default output and was run on a 2 GHz Windows/x86-32 machine.

Table 2–2 Performance improvements for a particular ABAQUS/Standard model.

Version Size of the

output database

file (ODB) in MB

Wall clock

time (s): input file

preprocessing

Wall clock

time (s): analysis

6.4 303 1320 3201

6.5 45 163 65

Besides improved performance, the only other visible difference between Version 6.5 and Version 6.4

due to the performance enhancements is how averaging regions for element output averaged at nodes

are computed. To recover the behavior in Version 6.4, set the ABAQUS environment parameter

average_by_section to ON. However, in problems with many section and/or material definitions the default

value of OFF will generally give much better performance than the nondefault value of ON.

References:

ABAQUS Analysis User’s Manual

• “Using the ABAQUS environment settings,” Section 3.4.1

• “Output to the data and results files,” Section 4.1.2

2.13 PERFORMANCE IMPROVEMENTS FOR ABAQUS IMPORT MODELS

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: The performance of ABAQUS models that use the import capability is significantly improved.

Description: Import of elements and nodes and the associated transfer of data from one ABAQUS model

to another have been improved by faster search and data transfer algorithms. Import from ABAQUS/Explicit

to ABAQUS/Standard shows the most improvement: depending on the problem and the hardware used,

the current version is two to three orders of magnitude faster than previous versions. Import from

ABAQUS/Standard to ABAQUS/Standard and from ABAQUS/Standard to ABAQUS/Explicit show

remarkable performance improvements as well.
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Reference:

ABAQUS Analysis User’s Manual

• “Transferring results between ABAQUS analyses: overview,” Section 7.7.1

2.14 VIEWPORT ANNOTATIONS AND TOOLS

Product: ABAQUS/CAE

Benefits: You can now create arrow and text viewport annotations to clarify your model or results. The

annotations are saved with the model or output database, and you can copy them from a model database to

an output database, and vice versa. You can use tools in the new Viewport toolbox to create and manipulate

viewports and viewport annotations.

Description: You can create arrows and text separately, and you can create an arrow annotation with a

text annotation positioned at the tail of the arrow. Even if you create arrow and text annotations together,

ABAQUS/CAE saves each one separately; you can move and edit them independently after you create them.

Arrow and text annotations are anchored to points in either viewport geometry or model geometry. Depending

on the anchor points that you select, the annotations can move with model manipulations or with changes in

viewport geometry. Figure 2–9 shows two viewport annotations on a part (the online version of this figure

is animated to show the difference between anchoring an annotation to the viewport and anchoring it to the

model).

Figure 2–9 Viewport annotations.
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You can reposition the annotations directly in the viewport or open an editor dialog box to enter new

coordinates; select or enter new anchor points; or change arrowheads, line styles, colors, and fonts. You can

use the Annotation Manager to edit, copy, rename, and delete annotations or to plot them in the current

viewport.

Use the tools in the Viewport toolbox, shown in Figure 2–10, to create and manipulate viewports and

viewport annotations.

Viewport tools Annotation tools

create

cascade

tile
horizontal

tile
vertical

create
arrow
and
text

create
arrow

create
text

edit
annotation
manager

viewport
annotation

options

Figure 2–10 The Viewport toolbox.

Use the Viewport Annotation Options dialog box to toggle all annotations on and off in a viewport. You

can control the display of all text and arrow annotations and each type of viewport annotation that is generated

by ABAQUS/CAE (the triad and, in the Visualization module, the legend, title block, and state block). You

can also use the viewport annotation options to customize the annotations generated by ABAQUS/CAE (the

customization options remain unchanged from previous versions of ABAQUS/CAE).

ABAQUS/CAE Usage:

Any module:

Viewport→Viewport Toolbox

Viewport→Annotation Manager

Viewport→Create Annotation

Viewport→Edit Annotations

Viewport→Viewport Annotation Options

References:

ABAQUS/CAE User’s Manual

• “Manipulating viewports and viewport annotations,” Section 4.2
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• Chapter 38, “Customizing viewport annotations”
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3. EXECUTION

This chapter discusses commands and utilities for running any of the ABAQUS products. It provides an

overview of the following enhancements:

• “Parallel execution,” Section 3.1

• “Parallel execution of the element operations in ABAQUS/Standard,” Section 3.2

• “Enhancements to the translator for NASTRAN bulk data files,” Section 3.3

• “Enhancements to the translator for NASTRAN Output2 files,” Section 3.4

• “Translating PAM-CRASH input files to partial ABAQUS input files,” Section 3.5

• “Enhancements to the input file and output database upgrade utility,” Section 3.6

• “Direct submission of input files for analysis in ABAQUS/CAE,” Section 3.7
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3.1 PARALLEL EXECUTION

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: The MPI-based parallel execution mode allows ABAQUS/Standard and ABAQUS/Explicit to be

executed in parallel on both shared and distributed memory architecture platforms.

Description: ABAQUS now provides an MPI-based parallel execution mode in addition to the previously

existing thread-based parallel execution mode. The MPI-based parallel mode is the default in Version 6.5.

This parallel execution mode enables ABAQUS to be run on both shared and distributed memory architecture

platforms, while the thread-based mode is available only for shared memory architecture platforms.

Use the command line parameter mp_mode=mpi to access the MPI-based parallel execution mode and

mp_mode=threads to access the thread-based parallel execution mode. The value of the mp_mode

parameter can also be set in the ABAQUS environment file.

ABAQUS/CAE Usage:

Job module:

Job editor: Parallelization: Multiprocessing mode: MPI or Threads

Reference:

ABAQUS Analysis User’s Manual

• “Parallel processing modes in ABAQUS,” Section 7.19.1

3.2 PARALLEL EXECUTION OF THE ELEMENT OPERATIONS IN

ABAQUS/Standard

Product: ABAQUS/Standard

Benefits: Parallel execution of the element operations in ABAQUS/Standard reduces the run time for large

analyses.

Description: The standard_parallel parameter has been added to the ABAQUS execution procedure.

Along with the command line parameter mp_mode=mpi, setting standard_parallel=all allows for MPI-

based parallel execution of the element operations in ABAQUS/Standard. The required MPI components

must be installed to use the MPI-based parallel capability.

Parallel execution of the element operations is supported only for static stress analyses.

Reference:

ABAQUS Analysis User’s Manual

• “Parallel execution in ABAQUS/Standard,” Section 7.19.2
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3.3 ENHANCEMENTS TO THE TRANSLATOR FOR NASTRAN BULK

DATA FILES

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: You can now translate general matrix data, nonstructural mass, and bushing elements from

NASTRAN to ABAQUS. The new distribution option improves the performance of ABAQUS by reducing

the number of shell sections in the ABAQUS input file.

Description: Substructures and other special matrices created by NASTRAN can be used in ABAQUS. The

mass contribution from nonstructural features in the model is translated to the ABAQUS equivalent. Bushing

elements are translated to ABAQUS connector elements.

NASTRAN shell elements may have their orientations and offsets defined on the element connectivity.

By default, all elements that reference a single PSHELL are translated to a single *SHELL SECTION or

*SHELL GENERAL SECTION option in ABAQUS, and the variation in their properties is defined using the

*ELEMENT PROPERTIES and *DISTRIBUTION options.

Reference:

ABAQUS Analysis User’s Manual

• “Execution procedure for translating NASTRAN bulk data files to ABAQUS input files,” Section 3.2.17

3.4 ENHANCEMENTS TO THE TRANSLATOR FOR NASTRAN OUTPUT2

FILES

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: You can request shell output at corner nodes instead of at the centroid.

Description: The quad4corner option allows you to request shell output at corner nodes instead of at the

centroid. This option is relevant for stress, strain, and section force output.

Reference:

ABAQUS Analysis User’s Manual

• “Execution procedure for translating ABAQUS output database files to NASTRAN Output2 results

files,” Section 3.2.19
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3.5 TRANSLATING PAM-CRASH INPUT FILES TO PARTIAL ABAQUS

INPUT FILES

Product: ABAQUS/Explicit

Benefits: You can use this translator to convert keywords in a PAM-CRASH input file into their equivalent

in an ABAQUS input file.

Description: PAM-CRASH data entries are translated into a partial ABAQUS input file that contains model

data. You must provide history data (including output data) to complete the input.

Reference:

ABAQUS Analysis User’s Manual

• “Execution procedure for translating PAM-CRASH input files to partial ABAQUS input files,”

Section 3.2.18

3.6 ENHANCEMENTS TO THE INPUT FILE AND OUTPUT DATABASE

UPGRADE UTILITY

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: For input file upgrades, you can specify the version number of the file to upgrade and minimize

modeling differences between the old input file and the upgraded input file.

Description: The fromversion option allows you to specify the version of the input file to upgrade. You can

use the previousdefaults option to minimize modeling differences between the old input file and the upgraded

input file.

Reference:

ABAQUS Analysis User’s Manual

• “Execution procedure for input file and output database upgrade utility,” Section 3.2.14
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3.7 DIRECT SUBMISSION OF INPUT FILES FOR ANALYSIS IN

ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: Direct submission of input files for analysis from ABAQUS/CAE allows you to bypass the

command prompt interface for input file submission and take advantage of the convenient ABAQUS/CAE

job manager interface. In addition, you can run legacy input files from ABAQUS/CAE without having to

first import them.

Description: You can create and submit a job based on an existing input file that may or may not have been

created by ABAQUS/CAE; for example, if you have created an input file outside ABAQUS/CAE but would

like to run the analysis, monitor its progress, and view the results in ABAQUS/CAE. The interface for input

file job submission is the same as the interface for submitting jobs based on models created in ABAQUS/CAE.

ABAQUS/CAE Usage:

Job module:

Job→Create: Source: Input file

Reference:

ABAQUS/CAE User’s Manual

• Chapter 18, “The Job module”
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4. MODELING

This chapter discusses features related to creating your model, such as node and element definition in

ABAQUS/Standard or ABAQUS/Explicit and part and assembly definition in ABAQUS/CAE. It provides

an overview of the following enhancements:

• “Introducing dependent part instances,” Section 4.1

• “Filleting and chamfering shell edges,” Section 4.2

• “Creating patterns of instances,” Section 4.3

• “Contact constraint moved,” Section 4.4

• “Translating and rotating part instances with existing constraints applied,” Section 4.5

• “Regeneration of position constraints,” Section 4.6

• “Angle query,” Section 4.7

• “Sketcher tools and enhancements,” Section 4.8

• “Partitioning a cell with a sketch,” Section 4.9

• “ABAQUS/CAE colors different sides of a shell surface,” Section 4.10

• “Using selection groups during selection procedures,” Section 4.11

• “Merging groups of sets or surfaces,” Section 4.12

• “Defining interior cross-section surfaces,” Section 4.13

• “Defining matrices,” Section 4.14

• “Defining a nonstructural mass,” Section 4.15
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4.1 INTRODUCING DEPENDENT PART INSTANCES

Product: ABAQUS/CAE

Benefits: Dependent part instances consume less memory and can speed up the meshing operation.

Description: Previous versions of ABAQUS/CAE always created independent part instances. An

independent part instance is a copy of the geometry of the original part and is independent of other part

instances. You must mesh each independent part instance individually. In addition to meshing, you can

perform most other operations on an independent instance; for example, you can add partitions and create

virtual topology. The disadvantages of independent instances are that they consume more memory resources

and the meshing operations can be time consuming. For example, if you create a 10 × 10 linear pattern of

independent part instances, you must individually mesh each of the 100 instances.

The Assembly module in ABAQUS/CAE now allows you to create dependent part instances. A

dependent instance is only a pointer to the original part. In effect, a dependent instance shares the geometry

and the mesh of the original part. As a result, you can mesh the original part, but you cannot mesh a

dependent instance. When you mesh the original part, ABAQUS/CAE associates the same mesh with all

dependent instances of the part. Now you can create a 10 × 10 linear pattern of dependent part instances and

mesh only the original part; ABAQUS/CAE associates the mesh with each of the 100 instances.

ABAQUS/CAE creates dependent instances by default. Unless your assembly contains only a few parts,

it is recommended that you work with dependent instances because of the memory savings and the resulting

performance gain. You cannot create both a dependent and an independent instance of the same part. As a

result, if you create a dependent instance of a part, all subsequent instances must be dependent. The same

argument applies to independent instances. Instances of orphan mesh parts are always dependent.

Figure 4–1 illustrates that as you move the cursor over an instance in the Model Tree, ABAQUS/CAE

indicates whether the instance is dependent or independent. In addition, you can right-click on selected

instances in the Model Tree and change them from dependent to independent or vice versa.

ABAQUS/CAE Usage:

Assembly module:

Instance→Create

References:

ABAQUS/CAE User’s Manual

• “Working with the Model Tree,” Section 3.5

• “What is the difference between a dependent and an independent part instance?,” Section 13.3.2

• “How do I decide whether to create a dependent or an independent part instance?,” Section 13.3.3

• “Changing from a dependent to an independent part instance or vice versa,” Section 13.3.4

• “Meshing independent and dependent part instances,” Section 17.3.6
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Figure 4–1 The Model Tree indicates whether a part instance is dependent or independent.

4.2 FILLETING AND CHAMFERING SHELL EDGES

Product: ABAQUS/CAE

Benefits: The fillet and chamfer tools are more widely applicable.

Description: You can now fillet and chamfer shell edges. In addition, the fillet and chamfer tools can be

applied to many solid edges that could not be filleted or chamfered with previous versions of ABAQUS/CAE.

For example, the bicycle frame shown in Figure 4–2 has a sequence of edges at the intersection of the tubing

that could not be filleted with previous versions of ABAQUS/CAE. TheRound/Fillet tool can now be applied

to these edges.Edges of parts that contain wires cannot be filleted or chamfered.

ABAQUS/CAE Usage:

Part module:

Shape→Blend→Round/Fillet

Shape→Blend→Chamfer

Reference:

ABAQUS/CAE User’s Manual

• “Blending edges,” Section 11.27, in the online version of this manual
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Figure 4–2 The fillet tool is more widely applicable.

4.3 CREATING PATTERNS OF INSTANCES

Product: ABAQUS/CAE

Benefits: You can easily create complex assemblies by creating new instances in a linear or radial pattern.

Description: You can create a pattern of new instances. You can choose either of the following methods to

define the pattern:

Linear

A linear pattern positions new instances along a direction; for example, the -direction. You can specify

the number of instances and the spacing between the instances, and you can choose to position the

instances in a positive direction or a negative direction. In addition, you can change the angle of the

direction. You can create a matrix of new instances by creating copies in a second direction; for example,

the -direction, as shown in Figure 4–3.

Figure 4–3 Part instances patterned in two linear directions.

Radial

A radial pattern positions new instances in a circular pattern. You can specify the number of instances,

and you can specify the angle between the first and last instance, as shown in Figure 4–4. In addition,

you can select a line from the assembly that defines a new axis of rotation.
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Figure 4–4 A radial pattern of part instances.

ABAQUS/CAE Usage:

Assembly module:

Instance→Linear Pattern

Instance→Radial Pattern

Reference:

ABAQUS/CAE User’s Manual

• “Creating patterns of part instances,” Section 13.5

4.4 CONTACT CONSTRAINT MOVED

Product: ABAQUS/CAE

Benefits: The Assembly module menus have been clarified.

Description: To clarify the Assembly module menus, the contact position constraint has been moved from

Constraint→Contact to Instance→Translate To. A Translate To operation is similar to a Translate

operation in that it is not stored as a feature and cannot be edited.

ABAQUS/CAE Usage:

Assembly module:

Instance→Translate To

Reference:

ABAQUS/CAE User’s Manual

• “Positioning a part instance using the Translate To tool,” Section 13.4.4

4–6



MODELING

4.5 TRANSLATING AND ROTATING PART INSTANCES WITH EXISTING

CONSTRAINTS APPLIED

Product: ABAQUS/CAE

Benefits: The usability of the translate and rotate procedures in the Assembly module has been improved.

Description: If you proceeded with a translation that invalidated a previous position constraint in previous

versions of ABAQUS/CAE, ABAQUS/CAE first converted all existing constraints to an absolute position.

Now ABAQUS/CAE applies the translation components along only the unconstrained degrees of freedom. If

all the degrees of freedom are constrained, ABAQUS/CAE displays an error message and the translation fails.

ABAQUS/CAE Usage:

Assembly module:

Instance→Translate

Instance→Rotate

Reference:

ABAQUS/CAE User’s Manual

• “Creating the assembly,” Section 13.4

4.6 REGENERATION OF POSITION CONSTRAINTS

Product: ABAQUS/CAE

Benefits: After you apply a position constraint and ABAQUS/CAE regenerates the assembly, features such

as partitions and datums move along with the part instances.

Description: By default, when ABAQUS/CAE regenerates the assembly, it regenerates all the position

constraints before regenerating other features that might depend on the position, such as partitions and datums.

If you are working in the assembly-related modules, the Feature Options dialog box includes aConstraints

field that allows you to control this regeneration behavior.

ABAQUS/CAE Usage:

Assembly module:

Feature→Options

References:

ABAQUS/CAE User’s Manual

• “Creating the assembly,” Section 13.4

• “Tuning regeneration performance,” Section 42.4.7, in the online version of this manual
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4.7 ANGLE QUERY

Product: ABAQUS/CAE

Benefits: You can query the angle between edges and faces.

Description: The Query toolset now includes a tool that allows you to measure the angle between two

selected edges or faces or between an edge and a face.

ABAQUS/CAE Usage:

Assembly module:

Tools→Query→Feature

Reference:

ABAQUS/CAE User’s Manual

• “Understanding the role of the Query toolset,” Section 45.1

4.8 SKETCHER TOOLS AND ENHANCEMENTS

Product: ABAQUS/CAE

Benefits: New tools and enhancements to existing tools greatly expand the functionality of the Sketcher for

creating and editing models.

Description: There are several new tools and enhanced functions available. Choose from the following

new tools to create or modify entities in a sketch:

• Use the ellipse tool to create an ellipse by selecting the center and two points to define the size of

the major and minor axes.

• Use the arc through three points tool to sketch an arc by defining its endpoints and a third point

along the arc’s path.

• Use the auto-trim tool to trim edges at the intersection points closest to the cursor.

• Use the trim/extend tool to trim or extend an existing edge at an intersection point or projected

intersection with a second edge that you select. If the second edge is also sketch geometry,

ABAQUS/CAE breaks the second edge at the intersection point.

• Use the break tool to split existing edges at an intersection point.

• Use the merge tool to close small gaps in sketch shapes.
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• Use the offset tool to offset edges by a specified perpendicular distance, expanding or reducing them

in the sketch.

• Use the project edges tool to project existing model edges onto the sketch plane as new edges.

• Use the project references tool to project existing model edges and vertices onto the sketch plane as

reference geometry (this function was previously available only by selecting Add→References from

the main menu bar).

In addition to these new tools, you can now mirror and scale entities to quickly sketch mating part surfaces

or similar features with different sizes. Mirror, scale, translate, and rotate options appear in the prompt area

after you select entities to move or copy or after you add a saved sketch. When using the Sketcher tools, you

can now select a “chain” of edges. Use this new selection method when you want to select a continuous,

unbranched set of edges (all the edges of a polygon, for example).

Sketcher preselection has been expanded. When you are creating new lines (using the connected lines

tool ), ABAQUS/CAE indicates points that will make the current line segment horizontal, vertical,

perpendicular to another edge, or parallel to another edge. The secondary cursor will also trace nearby edges,

allowing you to create exact intersections to any point on an existing edge.

Many Sketcher default settings are revised, and customization options are expanded. Sketcher

preselection now takes priority over snapping to the grid. If both Snap to grid and Preselect geometry are

active, the secondary cursor indicates preselection points in a sketch and does not snap to nearby grid points.

The displayed height of dimension text is now set as a font size so that dimensions are legible regardless of

sketch magnification. When you sketch new features, the sheet and grid size are recalculated based on the

size of the sketch plane that you select. You can now turn off the display of dimensions using the Sketcher

options, and new construction lines and rectangles are rotated to match the rotation of the grid.

ABAQUS/CAE Usage:

Sketcher module:

Add→Ellipse, Offset, Edges, References

Add→Arc→3 Points

Add→Line→Connected Lines

Edit→Auto-Trim, Trim/Extend, Break, Merge

References:

ABAQUS/CAE User’s Manual

• “The Sketcher cursors and preselection,” Section 19.4.5

• “Using the chain method to select edges in the Sketcher,” Section 19.4.6

• “Modifying, copying, and offsetting objects,” Section 19.7

• “Offsetting objects,” Section 19.7.6

• “Sketching ellipses,” Section 19.9.8, in the online version of this manual
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• “Projecting edges onto a sketch,” Section 19.13, in the online version of this manual

• “Modifying objects,” Section 19.14, in the online version of this manual

4.9 PARTITIONING A CELL WITH A SKETCH

Product: ABAQUS/CAE

Benefits: The Partition toolset has been enhanced to allow you to partition a cell with a sketch.

Description: You can partition a cell with a sketch. You can select an existing face on which to sketch,

or you can create a datum plane that cuts through the cell and sketch the partition on the datum plane. You

can use a sketched partition embedded in a part (an edge embedded in a face or a face embedded in a cell) to

create a seam. Figure 4–5 shows how a sketched partition embedded in a cell can be used to define a seam.

sketched
partition

seam
crack

Figure 4–5 A sketched partition embedded in a cell.

ABAQUS/CAE Usage:

Assembly module or Step module:

Tools→Partition

References:

ABAQUS/CAE User’s Manual

• “What is a seam?,” Section 20.1.8

• “An overview of the methods for partitioning cells,” Section 44.4.3

• “Using the sketch method to partition faces,” Section 44.6.1, in the online version of this manual

• “Using the sketch planar partition method to partition a cell,” Section 44.7.6, in the online version of this

manual
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4.10 ABAQUS/CAE COLORS DIFFERENT SIDES OF A SHELL SURFACE

Product: ABAQUS/CAE

Benefits: Selecting the sides of a surface of a shell part has been simplified by replacing the colored

arrowheads that indicated the sides with colored faces.

Description: If you were selecting the side of a surface in previous versions of ABAQUS/CAE,

ABAQUS/CAE displayed colored arrowheads and you chose the color corresponding to the desired side.

These arrowheads remain when you are selecting a side from a wire or an axisymmetric part. However,

when you are selecting a side from a shell, ABAQUS/CAE now displays the two sides using different colors;

you simply choose the color corresponding to the desired side. Figure 4–6 illustrates how much easier it is to

distinguish sides based on colored faces compared to colored arrows.

Figure 4–6 Colored sides are easier to distinguish.

ABAQUS/CAE Usage:

Assembly module or Step module:

Tools→Surface→Create

Reference:

ABAQUS/CAE User’s Manual

• “Specifying a particular side or end of a region,” Section 48.2.5
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4.11 USING SELECTION GROUPS DURING SELECTION PROCEDURES

Product: ABAQUS/CAE

Benefits: The introduction of selection groups has made the process of selecting multiple entities from the

viewport simpler and faster.

Description: To speed up the process of selecting many entities from the viewport, you can append groups

of entities to your selection. The group can be a display group, or it can be a temporary selection group. You

can click mouse button 3 in the viewport and do the following:

• Create a selection group by copying entities (vertices, edges, faces, or cells) that are highlighted in the

viewport into a selection group.

• Append to your selected entities by pasting the entities stored in a selection group or a display group into

your current selection.

For example, you can copy all the small faces highlighted by the Geometry Diagnostics query tool into a

selection group, as shown in Figure 4–7.

Figure 4–7 Copying entities into a selection group.
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You can then paste the same selection group into your selection when you are using the Repair toolset to repair

small faces, as shown in Figure 4–8.

Figure 4–8 Pasting entities from a selection group.

ABAQUS/CAE Usage:

Clickmouse button 3 in the viewport, andCopy highlighted entities into a selection group orPaste a selection

group into your selection.

Reference:

ABAQUS/CAE User’s Manual

• “What is a selection group?,” Section 6.1.2

4.12 MERGING GROUPS OF SETS OR SURFACES

Product: ABAQUS/CAE

Benefits: You can merge a group of surfaces into a single surface. For example, you can merge all the top

faces from a linear pattern of part instances into a single surface and apply a load to the new surface. You can

also merge sets.
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Description: You can select a group of sets or surfaces from the Model Tree and merge them into a single

set or surface. You can use a combination of drag-select, [Shift]+Click, and [Ctrl]+Click to select the desired sets

or surfaces. To merge sets or surfaces, click mouse button 3 on the Model Tree and select Merge from the

menu that appears. Figure 4–9 illustrates a group of surfaces being merged into a single surface.

Figure 4–9 Merging sets from the Model Tree.

Reference:

ABAQUS/CAE User’s Manual

• “Understanding the role of the Set and Surface toolsets,” Section 48.1

4.13 DEFINING INTERIOR CROSS-SECTION SURFACES

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: Interior cross-section surfaces can be used to study the “force-flow” through various paths in a

model.

Description: ABAQUS provides a simple method for creating a cross-section-like interior surface over

element facets, edges, or ends by cutting through one or more components of a model with a plane. The

generated surface is an approximation to the cutting plane.

You can request integrated output of the total force transmitted across these surfaces; see “Integrated

output over a surface,” Section 15.6, for details.
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References:

ABAQUS Analysis User’s Manual

• “Defining element-based surfaces,” Section 2.3.2

ABAQUS Keywords Reference Manual

• *SURFACE, TYPE=CUTTING SURFACE

4.14 DEFINING MATRICES

Product: ABAQUS/Standard

Benefits: User-defined matrices can be input directly into ABAQUS/Standard.

Description: You can now input matrices directly into ABAQUS/Standard. A matrix can be used to

represent stiffness for a part of the model or the entire model. It is defined by giving it a unique name and

by specifying matrix data that may be scaled. It can be given in lower triangular, upper triangular, or square

(including both lower and upper triangles) format. It can be used to provide linear elastic response with

large translations in static analysis. Only the symmetric equation solver can be used for a model containing a

matrix; therefore, the matrix must be symmetric. Except for body forces most loads, boundary conditions,

and constraints can be applied directly to nodes on a matrix. A matrix cannot be used in a model containing

parts and assemblies.

References:

ABAQUS Analysis User’s Manual

• “Defining matrices,” Section 2.10.1

ABAQUS Keywords Reference Manual

• *MATRIX ASSEMBLE

• *MATRIX INPUT

4.15 DEFINING A NONSTRUCTURAL MASS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: You can include in a model the mass contribution from features that have negligible structural

stiffness by smearing that mass over an element set that is typically adjacent to these features.

Description: You can specify a nonstructural mass in the form of a “mass per unit volume,” “mass per

unit area,” “mass per unit length,” or “total mass.” The specification in the form of a “mass per unit area” is
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applicable only to conventional shell, membrane, and surface elements; whereas the form of a “mass per unit

length” is applicable only to beam and truss elements. The remaining forms are applicable to all solid, shell,

membrane, beam, and truss elements. You can define a nonstructural mass over an element set that contains

a mixture of various element types applicable to a given form of the specification. When a “total mass” is

specified, you can distribute it over the elements in the element set in proportion to either their “structural”

mass or their volume.

ABAQUS/CAE Usage:

Property module or Interaction module:

Special→Inertia→Create: Nonstructural mass

References:

ABAQUS Analysis User’s Manual

• “Nonstructural mass definition,” Section 2.6.1

ABAQUS/CAE User’s Manual

• “Defining nonstructural mass,” Section 20.2.4, in the online version of this manual

ABAQUS Keywords Reference Manual

• *NONSTRUCTURAL MASS

4–16



5. GEOMETRY IMPORT AND REPAIR

This chapter discusses features related to importing parts into ABAQUS/CAE and repairing problematic

geometry. It provides an overview of the following enhancements:

• “Import part from output database enhanced,” Section 5.1

• “New geometry repair tools added,” Section 5.2
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5.1 IMPORT PART FROM OUTPUT DATABASE ENHANCED

Product: ABAQUS/CAE

Benefits: More functionality has been added to the procedure to import an orphan mesh part from an output

database.

Description: If the output database contains multiple part instances, you can select the part instances to

import. ABAQUS/CAE imports each part instance as a separate orphan mesh part. In addition, you can

import either the undeformed or the deformed shape. If you import the deformed shape, you can specify the

step and frame from which to import, as shown in Figure 5–1.

Figure 5–1 Importing an orphan mesh part.

ABAQUS/CAE Usage:

Any module:

File→Import→Part: Output database (*.odb*)

Reference:

ABAQUS/CAE User’s Manual

• “Importing a part from an output database,” Section 10.7.11, in the online version of this manual
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5.2 NEW GEOMETRY REPAIR TOOLS ADDED

Product: ABAQUS/CAE

Benefits: Additional tools have been added to the Repair toolset to provide more functionality and greater

flexibility when repairing imported parts.

Description: The tools in the Repair toolset are now grouped by the type of entity being repaired:

• Edges

• Faces

• The entire part

In addition, the following new tools have been added to the Repair toolset:

New edge repair tools

• Repair small edges

• Merge edges

original contains �
multiple edges

edges are merged
into a single edge

Figure 5–2 Merging edges.

• The remove redundant edges and remove redundant vertices tools have been replaced by the remove

redundant entities tool.
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New face repair tools

• Repair small faces

original small faces

small faces removed

Figure 5–3 Repair small faces.

• Replace faces

selected
faces to
replace

Figure 5–4 The effect of replacing selected faces.

• Remove sliver
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original sliver face

sliver face removed

Figure 5–5 Removing a sliver.

New part repair tools

• The functionality of the automated repair tool is now provided as three separate repair tools:

– Stitch

– Convert to analytical

– Convert to precise

• The solid from cell tool can now create a solid region from a cell region; previous versions of

ABAQUS/CAE operated on only an entire part. In addition, you can now select more than one face

from the shell region, in which case ABAQUS/CAE determines the direction in which to add the

solid material.

ABAQUS/CAE Usage:

Part module:

Tools→Repair

References:

ABAQUS/CAE User’s Manual

• “An overview of the methods for repairing edges,” Section 47.2.1

• “An overview of the methods for repairing faces,” Section 47.2.2
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• “An overview of the methods for repairing entire parts,” Section 47.2.3
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6. ANALYSIS PROCEDURES

This chapter discusses features related to defining an analysis. It provides an overview of the following

enhancements:

• “Transferring results between ABAQUS analyses,” Section 6.1

• “Enhancements to the steady-state transport procedure and symmetric model generation technique,”

Section 6.2

• “Removal of limitations for domain-level parallelization in ABAQUS/Explicit,” Section 6.3

• “Extension of adaptive meshing in ABAQUS/Standard,” Section 6.4

• “Contact iterations in ABAQUS/Standard,” Section 6.5

• “Reading temperatures from a previous analysis,” Section 6.6

• “Enhancements to the submodeling analysis procedure,” Section 6.7

• “Modal damping and eigenmode selection by frequency range,” Section 6.8

• “Fluid-structure interaction,” Section 6.9

• “Residual modes,” Section 6.10

• “Enhancements to the iterative equation solver,” Section 6.11
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6.1 TRANSFERRING RESULTS BETWEEN ABAQUS ANALYSES

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: You can specify the transfer of model data and results for models that are defined as assemblies of

part instances. In ABAQUS/CAE you can apply a deformed mesh and its associated material state to selected

instances using data imported from a previous ABAQUS/Standard or ABAQUS/Explicit analysis.

Description: You can import part instances from a previous analysis to specify the transfer of model data

and results for models that are defined as assemblies of part instances. You can use this capability to drive an

ABAQUS/Explicit analysis with the results of an ABAQUS/Standard analysis and vice versa. This is useful

if your problem can be broken down into different stages; for example, you can use ABAQUS/Explicit to

analyze a metal forming problem and ABAQUS/Standard to analyze the following springback. You can also

use this capability to change the model definition between steps.

In ABAQUS/CAE you can apply an initial state field to selected instances in the Load module, as shown

in Figure 6–1.

Figure 6–1 Creating an initial state field using data imported from a specified

step and frame of a previous analysis.

An initial state field applies a deformed mesh and its associated material state to the instances using data

imported from a previous ABAQUS/Standard or ABAQUS/Explicit analysis. ABAQUS/CAE allows you to

select the name of the previous analysis from which the initial state field is imported along with the particular

step and frame of the analysis.
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ABAQUS imposes many restrictions when you try to create an initial state field. For a detailed discussion

of these limitations, see the sections listed below. For example, the mesh of the part instances that you select

from the current model must match the mesh of the part instances that you are importing.

ABAQUS/CAE Usage:

Load module:

Field→Create: Initial State

References:

ABAQUS Analysis User’s Manual

• “Importing and transferring results,” Section 7.7

ABAQUS/CAE User’s Manual

• “Transferring results between ABAQUS analyses,” Section 16.6

ABAQUS Keywords Reference Manual

• *IMPORT

• *INSTANCE

6.2 ENHANCEMENTS TO THE STEADY-STATE TRANSPORT

PROCEDURE AND SYMMETRIC MODEL GENERATION TECHNIQUE

Product: ABAQUS/Standard

Benefits: Enhancements to the steady-state transport analysis procedure allow convective effects for rate-

independent and rate-dependent materials, such as those used in a disc brake analysis, to be modeled. This

method is cost effective for obtaining a steady-state solution or a state of interest to the analyst. In addition, a

three-dimensional model with a periodic geometry as well as a three-dimensional model with an axisymmetric

geometry can now be generated using the symmetric model generation technique and subsequently used in a

steady-state transport analysis procedure.

Description: The specific class of problems motivating the enhancements to the steady-state transport

analysis procedure and the symmetric model generation technique involves thermo-mechanical analysis of

a disc brake system in the automotive industry. Disc brakes operate by pressing a set of brake pads against a

rotating disc. The friction between the pads and the disc causes deceleration. The severe temperature changes

due to frictional contact as well as mechanical loading cause inelastic deformation and circumferential tensile

stress in the disc, which may eventually lead to the failure of the disc. Hence, the prediction of fatigue and

failure of a disc brake system is fundamental in assessing product performance.

The traditional way of analyzing this type of problem is to use a Lagrangian approach in which the disc

rotates relative to the brake assembly, which is pressed against the disc with contact and friction. Since many

revolutions are typically required to reach the state of interest to the analyst, this approach is prohibitively

6–4



ANALYSIS PROCEDURES

expensive and cumbersome. With the use of the steady-state transport analysis procedure, the Eulerian method

in which the finite element mesh of the disc does not rotate relative to the brake assembly but the material

“flows” through the mesh provides a cost-effective alternative approach. The paths that the material points

follow through the mesh are referred to as streamlines. This kinematic description converts the moving disc

brake problem into a pure spatially dependent simulation.

The steady-state transport procedure allows the steady-state solutions to be obtained directly or by using

a quasi-steady-state (pass-by-pass) technique. You can choose a set of elements in a model to be described in

an Eulerian manner; the rest of the elements in the model are treated in the classical Lagrangian manner.

Most material models that describe mechanical behavior are available for use in a steady-state transport

analysis. In particular, history-dependent viscoelasticity, classical metal plasticity, rate-dependent yield, rate-

dependent creep, and two-layer viscoplasticity can be used in a steady-state transport analysis.

The steady-state transport analysis can be the only step, can follow a general or linear perturbation step,

or can be followed by a natural frequency extraction step or a complex eigenvalue extraction step. Multiple

steady-state transport analysis steps can be included in a single analysis. Restart of a steady-state transport

analysis is also supported.

The three-dimensional model used in a steady-state transport analysis must be generated using the

symmetric model generation technique. A periodic three-dimensional model, such as a vented disc, can

now be generated by revolving a three-dimensional repetitive sector about a symmetry axis using the

symmetric model generation technique. Other enhancements include support for heat transfer and coupled

temperature-displacement elements used with the symmetric model generation and symmetric results transfer

techniques.

(Ave. Crit.: 75%)
S, Mises

+4.266e+00
+3.159e+01
+5.891e+01
+8.623e+01
+1.135e+02
+1.409e+02
+1.682e+02
+1.955e+02
+2.228e+02
+2.502e+02
+2.775e+02
+3.048e+02
+3.321e+02

1

2

3

Figure 6–2 Mises stress distribution in a disc brake system.
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References:

ABAQUS Analysis User’s Manual

• “Steady-state transport analysis,” Section 6.4.1

• “Symmetric model generation,” Section 7.8.1

• “Transferring results from a symmetric mesh or a partial three-dimensional mesh to a full

three-dimensional mesh,” Section 7.8.2

ABAQUS Keywords Reference Manual

• *STEADY STATE TRANSPORT

• *SYMMETRIC MODEL GENERATION

• *SYMMETRIC RESULTS TRANSFER

• *TRANSPORT VELOCITY

ABAQUS Example Problems Manual

• “A sequentially coupled thermal-mechanical analysis of a disc brake with an Eulerian approach,”

Section 5.1.2

ABAQUS Benchmarks Manual

• “Steady-state transport analysis,” Section 1.5.1

ABAQUS Verification Manual

• “Symmetric model generation and results transfer,” Section 3.9.1

6.3 REMOVAL OF LIMITATIONS FOR DOMAIN-LEVEL

PARALLELIZATION IN ABAQUS/Explicit

Product: ABAQUS/Explicit

Benefits: Domain-level parallelization can now be used for ABAQUS/Explicit analyses even if surface

erosion is modeled with general contact. In addition, rigid bodies can now be split across parallel domains,

allowing for improved parallel performance.

Description: Domain-level parallelization was available in previous versions of ABAQUS/Explicit and

typically results in better performance than loop-level parallelization. Together with the removal of the

limitations mentioned above, domain-level parallelization has been made the default in Version 6.5. In

addition, you no longer need to specify the number of domains; by default, this number is set equal to the

number of processors chosen for parallel execution.
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Reference:

ABAQUS Analysis User’s Manual

• “Parallel execution in ABAQUS/Explicit,” Section 7.19.3

6.4 EXTENSION OF ADAPTIVE MESHING IN ABAQUS/Standard

Products: ABAQUS/Standard ABAQUS/CAE

Benefits: Enhancements to the adaptive meshing facility allow application of arbitrary Lagrangian Eulerian

(ALE) mesh smoothing to a broader number of elements in ABAQUS/Standard. These enhancements focus

on providing a flexible user interface for describing mesh constraints as a method for describing material loss,

such as through wear or ablation, from the surface of models. These enhancements are not intended to result

in a general ALE-based mesh smoothing capability, with suitability for bulk deformation analysis.

Description: Adaptive mesh domains can now be defined in geometrically nonlinear static

stress/displacement analysis, coupled pore fluid flow and stress analysis, and fully coupled thermal-stress

analysis.

The generality of the interface for adaptive mesh constraints allows you to provide a mesh displacement

that differs from the current material displacement at the free surface of the adaptive mesh domain, effectively

eroding, or adding, material at the boundary. Using adaptive mesh constraints this way is an effective

technique for modeling wear or ablation processes.

For general boundary shapes the most effective interface for ablation is user subroutine UMESHMOTION,

where you can apply spatial mesh constraints to the nodes on the free surface in general ways according to

solution-dependent variables, if needed. The user subroutine interface provides a local coordinate system that

is normal to the free surface at the surface node, enabling you to describe mesh motions in this local system.

UMESHMOTION is not supported in ABAQUS/CAE.

Table 6–1 lists the elements that are now supported for use with adaptive meshing.

Table 6–1 Elements supported for adaptive meshing.

AC1D2, AC1D3,, AC2D3, AC2D4, AC2D6, AC2D8, AC3D4, AC3D6, AC3D8, AC3D10, AC3D15,

AC3D20, ACAX3, ACAX4, ACAX6, ACAX8

CPS4, CPS4T

CPE4, CPE4H, CPE4T, CPE4HT, CPE4P, CPE4PH

CAX4, CAX4H, CAX4T, CAX4HT, CAX4P, CAX4PH

C3D8, C3D8R, C3D8H, C3D8RH, C3D8T, C3D8HT, C3D8RT, C3D8RHT, C3D8P, C3D8PH, C3D8RP,

C3D8RPH
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ABAQUS/CAE Usage:

Step module:

Other→Adaptive Mesh Domain

Other→Adaptive Mesh Controls

References:

ABAQUS Analysis User’s Manual

• “Defining adaptive mesh domains in ABAQUS/Standard,” Section 7.17.6

• “Adaptive meshing and remapping in ABAQUS/Standard,” Section 7.17.7

• “UMESHMOTION,” Section 25.2.32

ABAQUS/CAE User’s Manual

• “Customizing adaptive meshing,” Section 14.13, in the online version of this manual

ABAQUS Keywords Reference Manual

• *ADAPTIVE MESH

• *ADAPTIVE MESH CONSTRAINT

• *ADAPTIVE MESH CONTROLS

6.5 CONTACT ITERATIONS IN ABAQUS/Standard

Products: ABAQUS/Standard ABAQUS/CAE

Benefits: Contact severe discontinuity iterations are executed faster for frictionless static contact problems.

Contact iterations can be especially effective for the solution of large linear elastic contact problems with

many severe discontinuity iterations.

Description: Contact iterations are executed without reassembling and refactorizing the global stiffness

matrix.

ABAQUS/CAE Usage:

Step module:

Step→Create: General: Geostatic; Soils; Static, General; Static, Riks; or Visco: Other:

Apply contact iteration solution technique

Step→Create: General: Coupled temp-displacement: Other: Solution technique:

Contact Iterations
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References:

ABAQUS Analysis User’s Manual

• “Contact iterations,” Section 8.2.2

ABAQUS Keywords Reference Manual

• *SOLUTION TECHNIQUE, TYPE=CONTACT ITERATIONS

6.6 READING TEMPERATURES FROM A PREVIOUS ANALYSIS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: Temperatures for sequentially coupled thermal-stress analysis can now be read from the output

database file in addition to the results file and interpolated between dissimilar meshes.

Description: For sequentially coupled thermal-stress analysis where the meshes in the heat transfer and

stress/displacement analyses are the same, the temperatures for the stress analysis can be read as initial

conditions or field variables from the results or output database file for the heat transfer analysis.

If the mesh for the heat transfer analysis is different from the mesh for the subsequent stress/displacement

analysis and the temperatures are read from the output database file for the heat transfer analysis, ABAQUS

can interpolate the temperature values from the nodes in the heat transfer model to the current nodal

temperatures.

ABAQUS/CAE Usage:

Load module:

Field→Create: Other, Temperature: Distribution: From results or output database file,

Mesh compatibility: Incompatible

References:

ABAQUS Analysis User’s Manual

• “Sequentially coupled thermal-stress analysis,” Section 6.5.3

• “Initial conditions,” Section 19.2.1

• “Predefined fields,” Section 19.6.1

ABAQUS/CAE User’s Manual

• “Defining a temperature field,” Section 16.11.2, in the online version of this manual

ABAQUS Keywords Reference Manual

• *INITIAL CONDITIONS, TYPE=TEMPERATURE, FILE=file-name, INTERPOLATE

• *TEMPERATURE, FILE=file-name, INTERPOLATE
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ABAQUS Verification Manual

• “*TEMPERATURE, *FIELD, and *PRESSURE STRESS,” Section 5.1.24

• “Shell submodeling,” Section 3.6.8

6.7 ENHANCEMENTS TO THE SUBMODELING ANALYSIS PROCEDURE

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: Enhancements to the submodeling procedure in ABAQUS result in faster processing of the

submodel driven nodes and easier handling of sequentially coupled thermal-stress analysis.

Description: A new search algorithm has been implemented for processing the submodel driven nodes. The

analysis preprocessing time for submodeling analyses has been significantly reduced, especially for cases with

large numbers of driven nodes.

You no longer need to include the results file or output database file extension for the global model. If

the extension is omitted and both results and output database files exist, the results file from the global model

is used for the submodel analysis.

Submodeling thermal-stress analyses can now be carried out in a much more convenient and efficient

manner. Temperature fields can be interpolated between dissimilar meshes (see “Reading temperatures from a

previous analysis,” Section 6.6), which allows you to efficiently perform a sequentially coupled thermal-stress

submodel analysis by reading the temperatures from the output database for the global stress analysis, as

illustrated in Figure 6–3. Alternatively, you can read the temperatures from the output database for the global

heat transfer analysis, as illustrated in Figure 6–4.

References:

ABAQUS Analysis User’s Manual

• “Sequentially coupled thermal-stress analysis,” Section 6.5.3

• “Submodeling,” Section 7.3.1

• “Initial conditions,” Section 19.2.1

• “Predefined fields,” Section 19.6.1

ABAQUS Benchmarks Manual

• “Quenching of an infinite plate,” Section 1.6.4

ABAQUS Verification Manual

• “Shell submodeling,” Section 3.6.8

• “*TEMPERATURE, *FIELD, and *PRESSURE STRESS,” Section 5.1.24

6–10



ANALYSIS PROCEDURES

Field variable
Global_1.odb

Interpolate from
mesh1 to mesh2

Driven variable
Global_2.fil or Global_2.odb

Field variable
Global_2.odb

Interpolate from
mesh2 to mesh3

Global model (mesh1)
Heat transfer analysis

Global model (mesh2)
Static analysis

Read temperatures from Global_1.odb

Submodel (mesh3)
Static analysis

Read temperatures from Global_2.odb

Figure 6–3 Thermal-stress analysis run directly from the global stress analysis.

Global model (mesh1)
Heat transfer analysis

Global model (mesh3)
Static analysis

Read temperatures from Global.odb

Submodel (mesh4)
Static analysis

Read temperatures from Global.odb

Field variables
Global.odb

Interpolate from
mesh1 to mesh 3

Driven variables
Global_u.fil or Global_u.odb

Field variables
Global.odb

Interpolate from
mesh1 to mesh4

Figure 6–4 Thermal-stress analysis run from the global heat transfer analysis.

6.8 MODAL DAMPING AND EIGENMODE SELECTION BY FREQUENCY

RANGE

Products: ABAQUS/Standard ABAQUS/CAE
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Benefits: A more intuitive method of selecting eigenmodes and defining modal damping values in mode-

based procedures has been introduced.

Description: You can now choose to specify frequency ranges when selecting eigenmodes or definingmodal

damping in mode-based procedures.

ABAQUS/CAE Usage:

Step module:

Step→Create: any valid step type: Damping: Specify damping over ranges of:

Modes or Frequencies

References:

ABAQUS Analysis User’s Manual

• “Implicit dynamic analysis using direct integration,” Section 6.3.2

• “Transient modal dynamic analysis,” Section 6.3.7

• “Mode-based steady-state dynamic analysis,” Section 6.3.8

• “Subspace-based steady-state dynamic analysis,” Section 6.3.9

• “Response spectrum analysis,” Section 6.3.10

• “Random response analysis,” Section 6.3.11

ABAQUS Keywords Reference Manual

• *MODAL DAMPING, DEFINITION=MODE NUMBERS or FREQUENCY RANGE

• *SELECT EIGENMODES, DEFINITION=MODE NUMBERS or FREQUENCY RANGE

ABAQUS Example Problems Manual

• “Linear analysis of the Indian Point reactor feedwater line,” Section 2.2.2

6.9 FLUID-STRUCTURE INTERACTION

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: ABAQUS introduces a general co-simulation interface whose primary focus is to solve fluid-

structure interaction analyses using ABAQUS and FLUENT.

Description: Fluid-structure interaction (FSI) covers a broad scope of problems in which the fluid flow

and structural deformations interact and affect one another. The interactions may be thermal, mechanical, or

both. Typical problems include hemo-dynamics in arteries, fluid flow in a pump, tube bundle instabilities in

nuclear power steam generators, airflow over an aircraft wing, heat exchange in a radiator, heat transfer in

turbine discs, airflow in high-speed manufacturing, dispensing of consumer products, MEMS, fluid sloshing

in a tank, and hydroplaning of a tire.
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The ABAQUS co-simulation interface can be used to solve multidisiplinary problems, in which the

physical domains are modeled by different analysis codes and are coupled in a synchronized manner by

exchanging solution quantities. Any code supporting the Mesh-based Parallel Code-Coupling Interface

(MpCCI) can be linked with ABAQUS. Although this does not rule out links to other CFD codes, the

ABAQUS-FLUENT link will be actively supported and tested by both companies.

Performing a co-simulation analysis will consume additional ABAQUS tokens, as well as requiring a

license of MpCCI and either FLUENT or other MpCCI supported third-party analysis codes. For further

information about the ABAQUS co-simulation interface, please contact your ABAQUS sales office.

Figure 6–5 Thermal analysis of an exhaust manifold (figure created

with EnSight Gold, developed by CEI International).

References:

ABAQUS Analysis User’s Manual

• “Co-simulation: overview,” Section 7.9.1

• “Preparing an ABAQUS analysis for co-simulation,” Section 7.9.2

• “Directing the exchange process,” Section 7.9.3

• “Executing the coupled analysis,” Section 7.9.4

ABAQUS Keywords Reference Manual

• *CO-SIMULATION

ABAQUS Example Problems Manual

• “Closure of an air-filled door seal,” Section 2.3.1
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Figure 6–6 Air escaping out of a vent hole of a door seal being closed

(figure created with EnSight Gold, developed by CEI International).

ABAQUS Verification Manual

• “Fluid-structure interaction of a cantilever beam inside a channel,” Section 3.17.1

6.10 RESIDUAL MODES

Products: ABAQUS/Standard ABAQUS/CAE

Benefits: The frequency extraction procedure has been enhanced to include the calculation of residual modes

if desired. If you request residual modes, they will be included automatically with the eigenmodes to form

the basis for projection and superposition in mode-based procedures. Inclusion of these modes can provide

potentially significant gains in accuracy at less cost than simply extracting a larger set of eigenmodes.

Description: A residual mode is representative of the static solution that would be obtained by applying

the same loading pattern as is used for the excitation in the mode-based analysis, but orthogonalized with

respect to the mass and stiffness matrices against the extracted eigenmodes. Consequently, residual modes

effectively compensate for errors introduced when, to reduce cost, higher frequency modes are not extracted

in the frequency step and, hence, not included in the basis for the mode-based analysis. The only prerequisite

for activating the residual mode calculations is that the loading patterns need to be defined in an immediately

preceding static perturbation step. If the static perturbation step includes multiple load cases, one residual
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mode is calculated for each load case. Although by default all residual modes are included in the basis for the

mode-based procedure (like eigenmodes), a subset of the calculated residual modes may be used in a given

mode-based analysis. The printed output file clearly identifies which modes are residual modes and which

modes are eigenmodes. In terms of use in mode-based procedures ABAQUS/Standard does not distinguish

between residual modes and eigenmodes.

ABAQUS/CAE Usage:

Step module:

Step→Create: Frequency: Basic: Include residual modes

References:

ABAQUS Analysis User’s Manual

• “Implicit dynamic analysis using direct integration,” Section 6.3.2

• “Natural frequency extraction,” Section 6.3.5

• “Transient modal dynamic analysis,” Section 6.3.7

• “Mode-based steady-state dynamic analysis,” Section 6.3.8

• “Subspace-based steady-state dynamic analysis,” Section 6.3.9

• “Response spectrum analysis,” Section 6.3.10

• “Random response analysis,” Section 6.3.11

ABAQUS Keywords Reference Manual

• *FREQUENCY, RESIDUAL MODES

• *SELECT EIGENMODES

ABAQUS Example Problems Manual

• “Dynamic analysis of antenna structure utilizing residual modes,” Section 2.2.6

6.11 ENHANCEMENTS TO THE ITERATIVE EQUATION SOLVER

Product: ABAQUS/Standard

Benefits: The iterative linear equation solver now supports parallel execution on distributed memory

hardware. The algorithm for handling deformable-to-deformable contact has been substantially reworked to

improve performance and memory use as well as parallel scaling. Additional improvements to robustness,

memory use, and performance have been made.

Description: The enhancements to the iterative solver can be divided into two categories. First,

parallel calculations are now supported on distributed memory hardware. For large models this can

substantially reduce the execution time as well as take advantage of memory on distributed memory

clusters. Second, robustness and performance improvements have been made, with an emphasis on handling
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deformable-to-deformable contact in a more natural way within the domain decomposition algorithm. For

problems involving large surfaces in contact, the new algorithm is expected to outperform the previous

version with respect to run time, memory use, and parallel scaling. In addition, many of the internal

algorithms in the iterative solver have been reworked to improve robustness, overall memory use, and

performance for more general classes of problems.

References:

ABAQUS Analysis User’s Manual

• “Parallel execution in ABAQUS/Standard,” Section 7.19.2

• “Iterative linear equation solver,” Section 8.1.2
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This chapter discusses new material models or changes to existing material models. It provides an overview

of the following enhancements:

• “Hyperelastic and viscoelastic material evaluation,” Section 7.1

• “Creating a material when you create a section,” Section 7.2

• “Section assignment enhancements,” Section 7.3

• “Shell and beam section editor enhancements,” Section 7.4

• “Progressive damage and failure,” Section 7.5

• “Energy dissipation in elastomeric foams,” Section 7.6

• “Kinematic hardening plasticity in ABAQUS/Explicit,” Section 7.7

• “Evaluation of strain-rate-dependent data in ABAQUS/Explicit,” Section 7.8

• “Orthotropic elastic-plasticity in ABAQUS/Explicit,” Section 7.9
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7.1 HYPERELASTIC AND VISCOELASTIC MATERIAL EVALUATION

Product: ABAQUS/CAE

Benefits: You can now evaluate the Marlow strain energy potential for hyperelastic materials; you can also

evaluate viscoelastic materials.

Description: Material evaluations can now be performed for hyperelastic materials that are defined with

a Marlow strain energy potential. The Poisson’s ratio—previously available in ABAQUS/CAE for use only

with the Marlow model—can now be used to calculate the volumetric response for all of the hyperelastic

strain energy potentials. You can now also evaluate the creep and relaxation response of viscoelastic materials,

provided that the material definition also includes elastic or hyperelastic material data.

In addition, the material editor for viscoelastic materials has been updated. Like the hyperelastic material

editor, the test data options (combined, shear, and volumetric) have been moved to a Test Data menu. The

TRS coefficients remain in the Suboptions menu.

ABAQUS/CAE Usage:

Property module:

Material→Evaluate

Reference:

ABAQUS/CAE User’s Manual

• “Evaluating hyperelastic and viscoelastic material behavior,” Section 12.4.6

7.2 CREATING A MATERIAL WHEN YOU CREATE A SECTION

Product: ABAQUS/CAE

Benefits: In the Property module you can now create a material when you are creating a section.

Description: In the homogeneous solid, generalized plane strain, homogeneous shell, membrane, truss, and

gasket section editors, you can either select an existing material or click Create to define a new material.

ABAQUS/CAE Usage:

Property module:

Section→Create: choose category and type: Create

Reference:

ABAQUS/CAE User’s Manual

• “Creating sections,” Section 12.4.3
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7.3 SECTION ASSIGNMENT ENHANCEMENTS

Product: ABAQUS/CAE

Benefits: You can view, edit, and delete section assignments.

Description: The Section Assignment Manager allows you to view, create, edit, and delete section

assignments. The manager lists section assignments in the order of creation and displays the section name,

section type, material name, and region associated with each section assignment. The Section Assignment

Manager is shown in Figure 7–1. In the Property module ABAQUS/CAE colors a region aqua, as shown in

Figure 7–2, to indicate that the region has a section assignment.

Figure 7–1 The Section Assignment Manager.

ABAQUS/CAE Usage:

Property module:

Section→Assignment Manager

Reference:

ABAQUS/CAE User’s Manual

• “Managing section assignments,” Section 12.9.2

7.4 SHELL AND BEAM SECTION EDITOR ENHANCEMENTS

Product: ABAQUS/CAE

Benefits: The reorganization of the shell and beam section editors improves usability. In addition, transverse

shear stiffness properties for shell and beam sections can now be defined in ABAQUS/CAE, increasing the

coverage of ABAQUS analysis product functionality.
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regions with
section assignments

Figure 7–2 Section assignment coloring in the Property module.

Description: In the homogeneous and composite shell section editors for general shell sections (i.e.,

integrated before analysis) the Options button for Integration has been removed. The editors have been

reorganized so that the integration options are now located on the Basic tabbed page; in addition, the

temperature variation options are now located on the Advanced tabbed page. In the homogeneous and

composite shell section editors for both general shell sections and shell sections integrated during analysis,

the section Poisson’s ratio options are now located on the Advanced tabbed page. Figure 7–3 shows an

example of the new shell section editors.

In the beam section editor for a general beam section (i.e., integrated before analysis) theOptions buttons

for Output Pts, Damping, and Offset have been removed. The editor has been reorganized so that the

damping and offset options are now located on the Advanced tabbed page, and the output points options are

now located on the Output Points tabbed page. The Linear properties button has been removed; you now

enter the beam section properties in a data table on the Basic tabbed page. Figure 7–4 shows the new general

beam section editor.When you select the profile shape for a beam section, you can either select an existing

profile or click Create to define a new profile.

In addition, transverse shear stiffness properties for shell and beam sections can now be specified on the

Advanced tabbed page of each section editor (or on the main page of the editor for beam sections integrated

during analysis).

ABAQUS/CAE Usage:

Property module:

Section→Create: Shell, Homogeneous or Composite

Section→Create: Beam, Beam
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Figure 7–3 The homogeneous shell section editor.

References:

ABAQUS/CAE User’s Manual

• “Creating homogeneous shell sections,” Section 12.8.3, in the online version of this manual

• “Creating composite shell sections,” Section 12.8.4, in the online version of this manual

• “Creating beam sections,” Section 12.8.7, in the online version of this manual

7.5 PROGRESSIVE DAMAGE AND FAILURE

Product: ABAQUS/Explicit

Benefits: This capability provides a general framework for modeling progressive damage and failure for

the Mises, Johnson-Cook, Hill, and Drucker-Prager plasticity materials.
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Figure 7–4 The general beam section editor.

Description: ABAQUS/Explicit offers a general capability for modeling progressive damage and failure

of materials. In the most general case, modeling material damage and failure requires the specification of the

following:

• the undamaged response of the material;

• a damage initiation criterion; and

• a damage evolution response, including a choice of element removal.
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The damage initiation criterion defines the condition that must be satisfied at the material point prior

to the onset of progressive damage. ABAQUS offers a variety of choices of damage initiation criteria, each

associated with distinct types of material failure. They can be classified in the following two categories:

• Damage initiation criteria for the fracture of metals, including the ductile and shear criteria.

• Damage initiation criteria for necking instability of sheet metal. These include the forming limit diagram

(FLD) and forming limit stress diagram (FLSD) criteria intended to assess the formability of sheet metals

and the Marciniak-Kuczynski (M-K) criterion to predict necking instability in sheet metals numerically,

taking into account the deformation history.

In addition, ABAQUS offers several criteria suitable for modeling damage initiation in cohesive elements

with traction-separation response.

The damage evolution response describes the rate of degradation of the material stiffness once the

corresponding initiation criterion has been reached. Figure 7–5 shows a typical stress-strain response of an

elastic-plastic material undergoing damage. ABAQUS supports different models of damage evolution and

provides controls associated with element deletion due to material failure. All of the available models of

damage evolution use a formulation intended to alleviate the strong mesh dependency of the results that

can arise from strain localization effects during progressive damage. The progressive damage models are

suitable for both quasi-static and dynamic problems.

σ
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Figure 7–5 Stress-strain curve with progressive damage degradation.

References:

ABAQUS Analysis User’s Manual

• “Progressive damage and failure: overview,” Section 11.6.1

• “Damage initiation,” Section 11.6.2

• “Damage evolution and element removal,” Section 11.6.3
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ABAQUS Keywords Reference Manual

• *DAMAGE INITIATION

• *DAMAGE EVOLUTION

ABAQUS Example Problems Manual

• “Eroding projectile impacting eroding plate,” Section 2.1.4

ABAQUS Verification Manual

• “Progressive damage and failure,” Section 2.2.20

7.6 ENERGY DISSIPATION IN ELASTOMERIC FOAMS

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: Modeling of permanent energy dissipation and stress softening effects in elastomeric foams is

allowed.

Description: ABAQUS provides a mechanism to include permanent energy dissipation and stress softening

effects in elastomeric foams. The functionality is intended primarily for modeling energy absorption in foam

components subjected to dynamic loading under deformation rates that are high compared to the characteristic

relaxation time of the foam; in such cases it is acceptable to assume that the foam material is permanently

damaged. The approach is based on the model ofMullins effect in elastomeric rubbers, with the difference that

in the case of elastomeric foams damage occurs due to both deviatoric and volumetric deformation. Therefore,

the model predicts energy absorption under pure hydrostatic loading of the foam. The amount of energy loss

due to damage in the material can be output.

References:

ABAQUS Analysis User’s Manual

• “Mullins effect in elastomers,” Section 10.6.1

• “Energy dissipation in elastomeric foams,” Section 10.6.2

ABAQUS Keywords Reference Manual

• *HYPERFOAM

• *MULLINS EFFECT

ABAQUS Verification Manual

• “Mullins effect,” Section 2.2.3
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Figure 7–6 Typical stress-stretch response of an elastomeric

foam material with energy dissipation.

7.7 KINEMATIC HARDENING PLASTICITY IN ABAQUS/Explicit

Product: ABAQUS/Explicit

Benefits: The kinematic hardening models are used to simulate the inelastic behavior of materials that are

subjected to cyclic loading.

Description: The linear kinematic hardening and the nonlinear (combined) isotropic/kinematic hardening

models already available in ABAQUS/Standard to model the cyclic loading of metals are now supported in

ABAQUS/Explicit. In combination with the initial conditions capability in ABAQUS, the new functionality

provides a powerful tool to include in an ABAQUS/Explicit dynamic analysis the effects of a previous forming

analysis through the specification of initial values of equivalent plastic strains and back stresses.

References:

ABAQUS Analysis User’s Manual

• “Models for metals subjected to cyclic loading,” Section 11.2.2

ABAQUS Keywords Reference Manual

• *PLASTIC, HARDENING=KINEMATIC or COMBINED

• *CYCLIC HARDENING

• *INITIAL CONDITIONS, TYPE=HARDENING
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ABAQUS Verification Manual

• “Rate-independent plasticity in ABAQUS/Standard,” Section 2.2.9

7.8 EVALUATION OF STRAIN-RATE-DEPENDENT DATA IN

ABAQUS/Explicit

Product: ABAQUS/Explicit

Benefits: Data evaluation facilitates the filtering of high-frequency oscillations associated with strain-rate-

dependent material behavior.

Description: Rate-sensitive material constitutive behavior may introduce unphysical high-frequency

oscillations in an explicit dynamic analysis. To overcome this problem, ABAQUS/Explicit computes the

equivalent plastic strain rate used for the evaluation of strain-rate-dependent data in terms of a factor, , that

facilitates filtering the high-frequency oscillations. You can specify the value of the strain rate factor, ,

directly.

References:

ABAQUS Analysis User’s Manual

• “Material data definition,” Section 9.1.2

ABAQUS Keywords Reference Manual

• *MATERIAL, SRATE FACTOR=

7.9 ORTHOTROPIC ELASTIC-PLASTICITY IN ABAQUS/Explicit

Product: ABAQUS/Explicit

Benefits: Orthotropic elastic-plasticity facilitates the modeling of orthotropic materials for which the effects

of orthotropy are important in both the elastic and the plastic response.

Description: ABAQUS/Explicit now supports the combination of orthotropic elasticity with Hill plasticity

to model anisotropy in both the elastic and plastic response. The case of Mises (isotropic) plasticity can be

obtained by setting the yield ratios of the Hill’s potential to one.

References:

ABAQUS Analysis User’s Manual

• “Elastic behavior: overview,” Section 10.1.1

• “Anisotropic yield/creep,” Section 11.2.6
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ABAQUS Keywords Reference Manual

• *ELASTIC, TYPE=ENGINEERING CONSTANTS or ORTHOTROPIC

• *PLASTIC

• *POTENTIAL
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8. ELEMENTS

This chapter discusses elements available in ABAQUS. It provides an overview of the following

enhancements:

• “Continuum shell elements: ABAQUS/CAE support,” Section 8.1

• “Continuum shell elements: modified through-thickness modulus,” Section 8.2

• “Connector elements: new connection types and kinematics,” Section 8.3

• “New connector behaviors,” Section 8.4

• “Enhanced orientation definition methods,” Section 8.5

• “Cohesive elements,” Section 8.6

• “Assigning element properties on an element-by-element basis,” Section 8.7

• “Change in default hourglass control method for elements modeled with finite-strain elasticity,”

Section 8.8

• “Change in default element distortion control for solid elements modeled with finite-strain elastic

materials,” Section 8.9





ELEMENTS

8.1 CONTINUUM SHELL ELEMENTS: ABAQUS/CAE SUPPORT

Product: ABAQUS/CAE

Benefits: The addition of continuum shell elements (introduced in Version 6.4 of ABAQUS/Standard and

ABAQUS/Explicit) to ABAQUS/CAE increases the coverage of ABAQUS analysis product functionality.

Description: You can assign ABAQUS continuum shell elements to hexahedral or wedge elements that you

created using the swept meshing technique. You can also assign continuum shell elements to orphan mesh

part instances.

ABAQUS/CAE Usage:

Mesh module:

Mesh→Element Type

Reference:

ABAQUS/CAE User’s Manual

• “Modeling continuum shells,” Section 21.4

8.2 CONTINUUM SHELL ELEMENTS: MODIFIED THROUGH-THICKNESS

MODULUS

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: The through-thickness modulus is now based on plane stress conditions rather than plane strain

conditions. This modification provides more appropriate results for shell-like applications where the thickness

direction is unconfined and an increased stable time increment size in ABAQUS/Explicit.

Description: The through-thickness stress resultant is related to an effective thickness direction strain by

. The resultant modulus in the thickness direction, , is now based on plane stress conditions.

For an isotropic material the plane stress thickness modulus is

The plane strain thickness modulus used in Version 6.4 can be recovered by using an effective thickness

modulus defined as . Using the plane stress thickness modulus is more appropriate for shell-

like problems that are free to expand or contract in the thickness direction. Furthermore, incompressible

behavior is now allowed, where Poisson’s ratio is 0.5. For analyses in ABAQUS/Explicit where the thickness

direction behavior determines the stable time increment size, larger stable time increments will be used, since

the thickness modulus is lower by a factor related to Poisson’s ratio.
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References:

ABAQUS Analysis User’s Manual

• “Using a shell section integrated during the analysis to define the section behavior,” Section 15.6.5

• “Using a general shell section to define the section behavior,” Section 15.6.6

8.3 CONNECTOR ELEMENTS: NEW CONNECTION TYPES AND

KINEMATICS

Products: ABAQUS/Explicit ABAQUS/CAE

Benefits: The expanded connector element library in ABAQUS/Explicit includes connection types and

kinematics designed for more accurate modeling of several applications such as spot welds and bushings.

Description: Two new basic connection types have been introduced in ABAQUS/Explicit. The

PROJECTION CARTESIAN connection is a basic translational connection type that could be used to

model shear and axial deformations appropriately in certain applications such as bushings and spot welds.

The PROJECTION FLEXION-TORSION connection is a basic rotational connection type that could be

used to model bending and twisting deformations appropriately in the same types of applications. The

new pre-assembled connection type BUSHING is created using the PROJECTION CARTESIAN and

PROJECTION FLEXION-TORSION types together.

ABAQUS/CAE Usage:

Interaction module:

Connector→Property→Create: Assembled types, Assembled type: Bushing; Basic types,

Translational type: Proj. Cartesian, Rotational type: Proj. Flex-Tors.

References:

ABAQUS Analysis User’s Manual

• “Connector elements,” Section 17.1.2

• “Connector element library,” Section 17.1.4

• “Connection-type library,” Section 17.1.5

• “Connector behavior,” Section 17.2.1

ABAQUS/CAE User’s Manual

• “Connection types,” Section 15.7.1

ABAQUS Keywords Reference Manual

• *CONNECTOR SECTION

• *CONNECTOR BEHAVIOR
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ABAQUS Example Problems Manual

• “Buckling of a column with spot welds,” Section 1.2.3

• “Crank mechanism,” Section 4.1.2

• “Flap mechanism,” Section 4.1.4

• “Tail-skid mechanism,” Section 4.1.5

• “Driveshaft mechanism,” Section 4.1.7

ABAQUS Verification Manual

• “Individual connector option tests,” Section 1.9.4

8.4 NEW CONNECTOR BEHAVIORS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: The new connector behaviors allow you to define plastic and damage effects in connectors,

thus allowing for more realistic modeling of many discrete connections, such as spot welds or rivets. The

previously available connector friction modeling behavior has been enhanced.

Description: The following new behaviors are available for connector elements:

Plasticity

Both rigid-plasticity and elastic-plasticity effects can now be modeled in connector elements in

ABAQUS/Standard and ABAQUS/Explicit. Plasticity can be modeled in either connector individual

components of relative motion or in a coupled fashion involving several components of relative motion

simultaneously. Only nonlinear uncoupled plasticity is supported in ABAQUS/CAE. The hardening

behavior can be specified in a similar fashion to metal plasticity using experimental data or precalibrated

parameters. Both isotropic and kinematic hardening can be specified to define the hardening behavior

after the initial yield. Multiple plasticity definitions can be specified in the same connector behavior.

Damage

Damage effects in connectors can now be modeled in ABAQUS/Explicit in either connector individual

components of relative motion or in a coupled fashion involving several components of relative motion

simultaneously. Only nonlinear uncoupled damage is supported in ABAQUS/CAE. Damage is initiated

in a connector when a user-specified criterion is met. Force-based, relative motion-based, or relative

plastic motion-based initiation criteria are available. Once damage is initiated, a user-specified damage

evolution law is used to soften the connector response. Either a relative motion-based or an energy-

based damage evolution law can be used. You can specify multiple competing or cumulative damage

mechanisms (pairs of damage initiation criteria and damage evolution laws) in the connector, and you

can choose the components of relative motion for which the response will be damaged.
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In addition, the connector friction behavior previously available in ABAQUS/Standard and

ABAQUS/Explicit has been enhanced. In addition to the previously available ABAQUS predefined choices,

you can now define customized combinations of connector tractions upon which frictional slip is initiated

in these cases. You can also define more general friction-producing contact forces in connectors than in

previous releases. Predefined friction behavior and uncoupled user-defined friction behavior are supported

in ABAQUS/CAE; coupled user-defined friction behavior is not supported in ABAQUS/CAE.

ABAQUS/CAE Usage:

Interaction module:

Connector→Property→Create: choose connection type: Add→Friction, Add→Plasticity, and/or

Add→Damage

References:

ABAQUS Analysis User’s Manual

• “Connector elements,” Section 17.1.2

• “Connector element library,” Section 17.1.4

• “Connection-type library,” Section 17.1.5

• “Connector behavior,” Section 17.2.1

ABAQUS/CAE User’s Manual

• “Defining friction,” Section 15.14.3, in the online version of this manual

• “Defining plasticity,” Section 15.14.6, in the online version of this manual

• “Defining damage,” Section 15.14.7, in the online version of this manual

ABAQUS Keywords Reference Manual

• *CONNECTOR BEHAVIOR

• *CONNECTOR DAMAGE INITIATION

• *CONNECTOR DAMAGE EVOLUTION

• *CONNECTOR DERIVED COMPONENT

• *CONNECTOR FRICTION

• *CONNECTOR HARDENING

• *CONNECTOR PLASTICITY

• *CONNECTOR POTENTIAL

ABAQUS Example Problems Manual

• “Buckling of a column with spot welds,” Section 1.2.3

• “Substructure analysis of a pick-up truck model,” Section 3.2.2

• “Crank mechanism,” Section 4.1.2

8–6



ELEMENTS

• “Snubber-arm mechanism,” Section 4.1.3

• “Flap mechanism,” Section 4.1.4

• “Tail-skid mechanism,” Section 4.1.5

• “Driveshaft mechanism,” Section 4.1.7

• “Trailing edge flap mechanism,” Section 4.1.9

• “Substructure analysis of a one-piston engine model,” Section 4.1.10

ABAQUS Verification Manual

• “Individual connector option tests,” Section 1.9.4

• “Connector elements in perturbation analyses,” Section 1.9.5

8.5 ENHANCED ORIENTATION DEFINITION METHODS

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: This enhancement provides general convenience in defining local rectangular coordinate systems;

it is particularly useful for defining orientations for connector elements.

Description: The origin of a local rectangular coordinate system can now be defined in terms of arbitrary

nodes or coordinates.

References:

ABAQUS Analysis User’s Manual

• “Orientations,” Section 2.2.5

ABAQUS Keywords Reference Manual

• *ORIENTATION

8.6 COHESIVE ELEMENTS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: Cohesive elements can be used to model the behavior of adhesive joints, interfaces in composites,

and other situations where the integrity and strength of interfaces may be of interest.

Description: A family of cohesive elements has been added. These elements can be used for detailed

modeling of the deformation and damage of cohesive layers at an interface between bonded parts, such as in

the applications shown in Figure 8–1 and Figure 8–2. Typically, the cohesive elements are connected to other

elements in the model with surface-based tie constraints, so that the mesh used for the cohesive layer can be

independent of the mesh used for the components being bonded.
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Figure 8–1 Typical peel test using cohesive elements to model finite thickness adhesives.

stiffener

skin

debonding
bond line

Debonding along skin-stringer interface.

Figure 8–2 Debonding along a skin-stringer interface: typical situation for

traction-separation-based modeling.
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The constitutive behavior of the cohesive elements can be defined with any of the following approaches:

• a continuum-based constitutive model;

• a uniaxial stress-based constitutive model; or

• a constitutive model specified directly in terms of traction versus separation.

The first approach is typically used to model adhesive layers of finite thickness. The second approach is

useful in some applications involving gaskets or small adhesive patches. The third approach is typically used

to model cohesive layers with negligible thickness. See the ABAQUS Analysis User’s Manual for additional

discussions comparing these approaches.

It is commonly desirable to model failure of bonded interfaces. Cohesive elements together with

progressive damage modeling capabilities can be used to model debonding and fracture at an interface,

without the need to introduce an initial crack (although this is allowed). In ABAQUS/Standard damage of a

cohesive layer can be modeled only if the constitutive behavior is defined directly in terms of traction versus

separation plus damage initiation and evolution models; whereas ABAQUS/Explicit also allows for damage

modeling with continuum-based material models. In either case the damage behavior can be specified via

material properties such as fracture toughness; however, these models do not rely on stress intensity factor

calculations.

Cohesive elements are particularly attractive when interface strengths are relatively weak compared to

the adjoining materials. There is some potential for numerical difficulties in the following cases:

• Stiff, thin interfaces tend to reduce the stable time increment in ABAQUS/Explicit. You can mitigate this

effect through mass scaling or decreasing the cohesive stiffness while preserving the fracture toughness.

• Softening material response and sudden reduction in interface strength can lead to convergence

difficulties in ABAQUS/Standard. Viscous regularization is provided to help overcome these

difficulties. The automatic stabilization scheme in ABAQUS/Standard can also help with convergence

issues.

Cohesive elements also have some limited capabilities for modeling gaskets. Compared to the family of

gasket elements in ABAQUS/Standard, the cohesive elements:

• are formulated to account for geometric nonlinearities;

• can have mass; and

• are available in both ABAQUS/Standard and ABAQUS/Explicit.

Only conventional material models that are available in ABAQUS can be used for modeling gaskets with

cohesive elements. Modeling of gasket behavior based on a pressure-closure relationship (as supported with

the family of gasket elements in ABAQUS/Standard) is currently not available.

ABAQUS/CAE Usage:

Mesh module:

Mesh→Element Type
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References:

ABAQUS Analysis User’s Manual

• “Cohesive elements: overview,” Section 18.5.1

• “Choosing a cohesive element,” Section 18.5.2

• “Modeling with cohesive elements,” Section 18.5.3

• “Defining the cohesive element’s initial geometry,” Section 18.5.4

• “Defining the constitutive response of cohesive elements using a continuum approach,” Section 18.5.5

• “Defining the constitutive response of cohesive elements using a traction-separation description,”

Section 18.5.6

• “Two-dimensional cohesive element library,” Section 18.5.7

• “Three-dimensional cohesive element library,” Section 18.5.8

• “Axisymmetric cohesive element library,” Section 18.5.9

ABAQUS/CAE User’s Manual

• “Modeling adhesive joints and bonded interfaces,” Section 21.1

ABAQUS Keywords Reference Manual

• *COHESIVE SECTION

• *DAMAGE INITIATION

• *DAMAGE EVOLUTION

• *ELASTIC

• *ELEMENT

• *SECTION CONTROLS

• *TRANSVERSE SHEAR STIFFNESS

ABAQUS Example Problems Manual

• “Analysis of skin-stiffener debonding under tension,” Section 1.4.5

ABAQUS Benchmarks Manual

• “Delamination analysis of laminated composites,” Section 2.7.1

ABAQUS Verification Manual

• “Cohesive elements,” Section 1.3.45

• “Cohesive element load verification,” Section 1.4.5
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8.7 ASSIGNING ELEMENT PROPERTIES ON AN ELEMENT-BY-

ELEMENT BASIS

Product: ABAQUS/Standard

Benefits: The use of element property assignments can simplify the modeling process when there is a

significant amount of element property variation in a model.

Description: Finite element analyses require the modeling of spatially varying element properties. Element

properties include geometric information, such as shell thickness, and modeling information, such as material

orientation. You can use element property assignments to redefine on an element-by-element basis the

thicknesses, offsets, section stiffness matrices, and material orientations for single-layer shell elements from

the values assigned by shell section definitions. It is also possible to use element property assignments to

redefine the material orientations for non-composite continuum elements from the values assigned by solid

section definitions.

In some applications the element properties may vary significantly. It is not uncommon for aerospace and

marine applications to have thousands of different thicknesses, offsets, and material orientations for the shell

elements in a model. In such cases creating separate section definitions and element sets to accommodate

the different element properties may be inconvenient. An alternative approach that can be used in certain

situations is to use the section definitions to define default element properties and to redefine, as needed,

specific element properties for selected elements using element property assignments.

The following example illustrates a simple use case of redefining the offset of a shell element with an

element property assignment. Consider the four-element shell model shown in Figure 8–3.

5

3 4

1 2

7

4 6

8 9

1 2 3

Figure 8–3 Four-element shell model.

Suppose that all four shell elements have a thickness of 1.0 and their constitutive behavior defined by the

same material. Further suppose that shell elements 1 and 2 have the same offset of 0.1, but elements 3 and 4
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have offsets of 0.3 and 0.4, respectively. One approach is to partition the model with three separate section

definitions to accommodate the different offsets. Since elements 1 and 2 share common element properties

(including their offsets), they can share the same shell section definition.

An alternative approach is to use a single section definition to define a default offset value of 0.1 for

all four elements; then redefine the offsets for elements 3 and 4 with an element property assignment. You

would define an element-based scalar distribution for elements 3 and 4 and use this distribution in the element

property assignment to modify the shell element offsets. Since only elements 3 and 4 would be included in

the distribution definition, the offsets for elements 1 and 2 would remain unchanged from the default value

specified in the shell section definition.

References:

ABAQUS Analysis User’s Manual

• “Distribution definition,” Section 2.7.1

• “Assigning element properties on an element-by-element basis,” Section 13.1.5

ABAQUS Keywords Reference Manual

• *DISTRIBUTION

• *ELEMENT PROPERTIES

ABAQUS Verification Manual

• “Spatially varying element properties,” Section 5.1.3

8.8 CHANGE IN DEFAULT HOURGLASS CONTROL METHOD FOR

ELEMENTS MODELED WITH FINITE-STRAIN ELASTICITY

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: The default enhanced hourglass control method provides increased resistance to hourglassing

for finite-strain elastic materials and compatibility between ABAQUS/Standard and ABAQUS/Explicit for

import analyses.

Description: The enhanced hourglass control method is now used by default for all first-order

reduced-integration elements modeled with finite-strain elastic materials: hyperelastic and hyperfoam

materials in both ABAQUS/Standard and ABAQUS/Explicit and hysteresis materials in ABAQUS/Standard.

This method provides increased resistance to hourglassing for nonlinear materials and better coarse mesh

accuracy in displacement solutions for linear elastic materials than other hourglass control methods. The

enhanced hourglass control approach is compatible between ABAQUS/Standard and ABAQUS/Explicit and

is the recommended method for all import analyses.

In ABAQUS/Explicit the enhanced hourglass method cannot be used for elements modeled with finite-

strain elastic materials that are included in an adaptive mesh domain. Thus, if you decide to use hyperelastic
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or hyperfoam materials in an adaptive mesh domain, you must choose a different hourglass control approach.

The use of adaptive meshing in domains modeled with finite-strain elastic materials is not recommended

since better results are generally predicted using the enhanced hourglass control method. Therefore, for these

materials it is recommended that the analysis be run without adaptive meshing but with enhanced hourglass

control.

To recover the default hourglass control behavior from previous versions (the total stiffness approach

in ABAQUS/Standard and the integral viscoelastic approach in ABAQUS/Explicit), you can use the abaqus

upgrade utility with the previousdefaults option.

References:

ABAQUS Analysis User’s Manual

• “Section controls,” Section 13.1.4

ABAQUS Keywords Reference Manual

• *SECTION CONTROLS, HOURGLASS=ENHANCED

8.9 CHANGE IN DEFAULT ELEMENT DISTORTION CONTROL FOR

SOLID ELEMENTS MODELED WITH FINITE-STRAIN ELASTIC

MATERIALS

Product: ABAQUS/Explicit

Benefits: Element distortion control prevents excessive negative element volumes or other excessive

distortion from occurring under high compressive loads

Description: By default, ABAQUS/Explicit will activate element distortion control for solid elements

modeled with hyperelastic or hyperfoam materials. Distortion control cannot be used when the elements are

included in an adaptive mesh domain; therefore, if you decide to use hyperelastic or hyperfoam materials in

an adaptive mesh domain, you must deactivate distortion control. The use of adaptive meshing in domains

modeled with hyperelastic or hyperfoam materials is not recommended since better results are generally

predicted using the enhanced hourglass control method and distortion control.

To recover the default behavior from previous versions (no element distortion control), you can use the

abaqus upgrade utility with the previousdefaults option.

References:

ABAQUS Analysis User’s Manual

• “Section controls,” Section 13.1.4
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ABAQUS Keywords Reference Manual

• *SECTION CONTROLS, DISTORTION CONTROL=YES
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9. PRESCRIBED CONDITIONS

This chapter discusses loads, boundary conditions, and fields. It provides an overview of the following

enhancements:

• “Distributed surface tractions and edge loads,” Section 9.1





PRESCRIBED CONDITIONS

9.1 DISTRIBUTED SURFACE TRACTIONS AND EDGE LOADS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: General or shear surface tractions can be applied as element-based or surface-based distributed

loads. Distributed edge tractions (general, shear, normal, or transverse) and edge moments can be applied to

shell elements as element-based or surface-based distributed loads.

Description: General surface tractions allow you to specify a traction, , acting on a surface, , in an

arbitrary direction. The resultant load, , is computed by integrating over :

You can also specify a shear surface traction that acts tangent to a surface .

General edge tractions allow you to specify a distributed edge load, , acting on a shell edge, , in an

arbitrary direction. The resultant load, , is computed by integrating over :

You can also specify distributed edge tractions that act in directions tangent, normal, or transverse to a shell

edge and distributed edge moments that always act about a shell edge.

General surface tractions and general edge tractions can be specified to be follower or non-follower loads.

Shear surface tractions and all other edge tractions are modeled as follower loads.

ABAQUS/CAE Usage:

Load module:

Load→Create: Mechanical, Surface traction

Load→Create: Mechanical, Shell edge load

References:

ABAQUS Analysis User’s Manual

• “Distributed loads,” Section 19.4.3

ABAQUS/CAE User’s Manual

• “Defining a shell edge load,” Section 16.9.4, in the online version of this manual

• “Defining a surface traction load,” Section 16.9.5, in the online version of this manual

ABAQUS Keywords Reference Manual

• *DLOAD

• *DSLOAD
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ABAQUS Benchmarks Manual

• “Tip in-plane shear load on a cantilevered hook,” Section 2.3.6

• “Shell bending under a tip load,” Section 2.3.12

• “Variable thickness shells and membranes,” Section 2.3.13

• “3DNLG-4: Lateral torsional buckling of an elastic cantilever subjected to a transverse end load,”

Section 4.10.4

• “3DNLG-6: Buckling of a flat plate when subjected to in-plane shear,” Section 4.10.6

• “3DNLG-10: Elastic-plastic behavior of a stiffened cylindrical panel under compressive end load,”

Section 4.10.10

ABAQUS Verification Manual

• “Distributed traction and edge loads,” Section 1.4.17
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10. CONSTRAINTS

This chapter discusses kinematic constraints. It provides an overview of the following enhancements:

• “Surface-to-surface tie constraint formulation,” Section 10.1

• “Performance improvements for deformable elements declared as rigid,” Section 10.2

• “Embedding beam and shell elements into solid elements,” Section 10.3

• “New fastener interface using connector elements,” Section 10.4





CONSTRAINTS

10.1 SURFACE-TO-SURFACE TIE CONSTRAINT FORMULATION

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: The true surface-to-surface formulation for mesh tie constraints optimizes the stress accuracy for

surface pairings with mismatched meshes.

Description: A true surface-to-surface approach has been added for the generation of mesh tie constraints.

In contrast to the existing node-to-surface approach, this new approach does not lead to stress oscillations

at the interface in the case of mismatched meshes. This is particularly significant for meshes with second-

order elements and most strongly for meshes with second-order tetrahedral elements. You can select the new

surface-to-surface approach or the existing node-to-surface approach for any tie constraint. The surface-to-

surface approach is the default in ABAQUS/Standard, whereas the node-to-surface approach is the default

in ABAQUS/Explicit. In some cases the surface-to-surface approach can result in significantly increased

computational costs; if local stress accuracy is not an important consideration, use of the node-to-surface

approach may be preferred. For example, this may be the case for shell meshes with a large number of tied

constraints. If the slave surface mesh is much coarser than the master surface mesh, the computational cost

can be reduced significantly by reversing the slave and master surfaces in the contact pair definition. This will

usually improve the accuracy of the solution as well.

As an example, consider an analysis of a penny-shaped edge crack in a larger structure. The large

structure is free meshed with C3D10 tetrahedral elements, whereas the structured mesh around the crack

uses C3D20 hexahedral elements.

Figure 10–1 Structured crack mesh tied to surrounding free mesh.
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With the node-to-surface method the Mises stress at the tied interface is very noisy, showing large oscillations

in stresses. On the other hand, with the surface-to-surface method the stresses vary smoothly and have the

same accuracy as the stresses away from the tie constraint.

Figure 10–2 Comparison of Mises stress at the tied interface.

ABAQUS/CAE Usage:

Interaction module:

Constraint→Create: Tie: Constraint enforcement method: Analysis default, Node to surface, or

Surface to surface

References:

ABAQUS Analysis User’s Manual

• “Mesh tie constraints,” Section 20.3.1

ABAQUS/CAE User’s Manual

• “Defining tie constraints,” Section 15.13.1, in the online version of this manual

ABAQUS Keywords Reference Manual

• *TIE, TYPE=SURFACE TO SURFACE or NODE TO SURFACE

10.2 PERFORMANCE IMPROVEMENTS FOR DEFORMABLE ELEMENTS

DECLARED AS RIGID

Product: ABAQUS/Standard
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Benefits: In some situations the performance of ABAQUS/Standard analyses containing deformable

elements declared as rigid has been significantly improved compared to earlier versions of

ABAQUS/Standard.

Description: The magnitude of the performance gains in Version 6.5 for analyses containing deformable

elements declared as rigid depends on several factors. The performance gains are greatest for the following

situations:

• The ratio of deformable elements making up the rigid body to the total number of elements in the model

is large.

• No loads are applied to the deformable elements that have been declared as rigid.

• No output is requested for the deformable elements that have been declared as rigid.

The most significant performance improvements are attained for models where the first and third situations

are combined. The “Geneva mechanism” example problem is representative of such a model. In this example

a factor of 2.5 improvement in wall clock time over Version 6.4 is observed using a single processor on a

Linux/x86-32 workstation.

Reference:

ABAQUS Example Problems Manual

• “Geneva mechanism,” Section 4.1.8

10.3 EMBEDDING BEAM AND SHELL ELEMENTS INTO SOLID

ELEMENTS

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: The embedded element capability is expanded in Version 6.5 to allow embedding of elements

with rotational degrees of freedom into solid elements. Embedding beams or shells, rather than trusses or

membranes, into solids is called for in many cases when the underlying reinforcement of a solid body has a

significant role in resisting bending or buckling.

Description: The embedded element capability has been available in previous versions to model various

types of reinforcement within solid bodies (often in conjunction with the rebar layer capability). Allowing

embedding of element types with rotational degrees of freedom is a simple, yet highly useful, extension of

this capability. The embedded constraints continue to act only on translations: the translational degrees of

freedom of the nodes of the embedded elements are interpolated from the corresponding degrees of freedom

of the host elements. Rotational degrees of freedom are not constrained by the embedding.

The following embedding combinations are now available in Version 6.5:

• Two-dimensional models:

– Beam-in-solid
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– Solid-in-solid

– Truss-in-solid

• Axisymmetric models:

– Membrane-in-solid (ABAQUS/Standard only)

– Shell-in-solid

– Solid-in-solid

– Surface-in-solid (ABAQUS/Standard only)

• Three-dimensional models:

– Beam-in-solid

– Membrane-in-solid

– Shell-in-solid

– Solid-in-solid

– Surface-in-solid

– Truss-in-solid

References:

ABAQUS Analysis User’s Manual

• “Embedded elements,” Section 20.4.1

• “Defining reinforcement,” Section 2.2.3

ABAQUS Keywords Reference Manual

• *EMBEDDED ELEMENT

• *REBAR LAYER

ABAQUS Verification Manual

• “*EMBEDDED ELEMENT,” Section 5.1.8

10.4 NEW FASTENER INTERFACE USING CONNECTOR ELEMENTS

Products: ABAQUS/Standard ABAQUS/Explicit

Benefits: Mesh-independent fasteners can now be modeled using connector elements. Using connector

elements as the basis for a point-to-point connection allows for very complex behavior to be modeled

with fasteners. Like other uses of connector elements, the connection can be fully rigid or can allow for

unconstrained relative motion in local connector components. In addition, deformable behavior can be

specified using a connector behavior definition that can include the effects of elasticity, damping, plasticity,

damage, and friction.
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Description: There are two methods to define fasteners that use connector elements to model the behavior

between attachment points. For both methods the fastener interaction refers to an element set containing the

connector elements. You must specify a connector section definition that refers to this element set.
The most controlled approach to specifying fasteners using connector elements is to define the connector

elements explicitly and associate them with an element set. The fastener interaction refers to the element set.
In the second approach you do not need to define the connector elements explicitly. The fastener

interaction refers to an empty element set. In addition, you assign a reference node set containing a list of

user-defined nodes to the fastener interaction. The nodes in this reference node set are used as reference

points to locate the connector elements modeling the fasteners. The connector elements are given internally

generated element numbers and assigned to the named element set that you specified.

References:

ABAQUS Analysis User’s Manual

• “Mesh-independent fasteners,” Section 20.3.4

ABAQUS Keywords Reference Manual

• *FASTENER

ABAQUS Verification Manual

• “Mesh-independent spot welds,” Section 5.1.14
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11. INTERACTIONS

This chapter discusses features related to contact and interaction modeling. It provides an overview of the

following enhancements:

• “Surface-to-surface small-sliding contact accounting for thickness,” Section 11.1

• “Improved contact stresses for second-order elements,” Section 11.2

• “Accounting for shell offsets in the general contact algorithm,” Section 11.3

• “Specifying feature edge criteria and pure master-slave assignments for general contact interactions,”

Section 11.4

• “Customizing contact controls,” Section 11.5

• “Specifying initial clearances and controlling initial overclosure adjustments for general contact,”

Section 11.6

• “Performance improvements for interacting radiation heat transfer,” Section 11.7

• “Defining concentrated convective and radiative behavior,” Section 11.8

• “Controlling nodal erosion for general contact,” Section 11.9

• “Performance improvements for general contact,” Section 11.10

• “Stabilization of multi-body contact problems with rigid body modes,” Section 11.11

• “Elimination of multiple state and model files during element reordering,” Section 11.12
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11.1 SURFACE-TO-SURFACE SMALL-SLIDING CONTACT ACCOUNTING

FOR THICKNESS

Products: ABAQUS/Standard ABAQUS/CAE

Benefits: The true surface-to-surface formulation for small-sliding contact optimizes stress accuracy for

surface pairings with mismatched meshes and accounts for surface thicknesses.

Description: A true surface-to-surface formulation has been added for small-sliding contact in

ABAQUS/Standard. In contrast to the existing node-to-surface approach, this new approach does not lead

to stress oscillations at a contact interface, even for mismatched meshes. In addition, the new formulation

accounts for surface thicknesses and offsets. The node-to-surface approach remains the default, but you

are encouraged to use the surface-to-surface approach. In some cases the surface-to-surface approach can

result in significantly increased computational cost; see “Surface-to-surface tie constraint formulation,”

Section 10.1, for further discussion.

As an example, consider concentric rings with an interference fit modeled with C3D20 hexahedral

elements and small-sliding contact. The analytical solution has a uniform contact pressure of 0.493.

The surface-to-surface approach significantly reduces the noise in contact pressures compared to the

node-to-surface approach. Contour plots of contact pressures predicted with the node-to-surface approach

show deviations of up to 27% from the analytical solution; whereas these deviations remain within 3% of the

analytical solution with the surface-to-surface approach.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Create: Surface-to-surface contact (Standard): Sliding formulation:

Small sliding, Constraint enforcement method: Surface to surface

References:

ABAQUS Analysis User’s Manual

• “Contact formulation for ABAQUS/Standard contact pairs,” Section 21.2.2

ABAQUS/CAE User’s Manual

• “Defining surface-to-surface contact,” Section 15.12.1, in the online version of this manual

ABAQUS Keywords Reference Manual

• *CONTACT PAIR, SMALL SLIDING, TYPE=SURFACE TO SURFACE

ABAQUS Benchmarks Manual

• “The Hertz contact problem,” Section 1.1.11
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CPRESS

+3.900e-01
+4.100e-01
+4.300e-01
+4.500e-01
+4.700e-01
+4.900e-01
+5.100e-01
+5.300e-01
+5.500e-01
+5.700e-01
+5.900e-01
+6.100e-01
+6.300e-01

 at elem INNER-1.61 node 522
Min +3.977e-01
 at elem INNER-1.49 node 138
Max +6.245e-01

CPRESS

+3.900e-01
+4.100e-01
+4.300e-01
+4.500e-01
+4.700e-01
+4.900e-01
+5.100e-01
+5.300e-01
+5.500e-01
+5.700e-01
+5.900e-01
+6.100e-01
+6.300e-01

 at elem INNER-1.57 node 147
Min +4.881e-01
 at elem INNER-1.49 node 126
Max +5.058e-01

V6.4 results V6.5 results

Figure 11–1 Comparison of contact pressures at the contact interface

between concentric rings modeled with C3D20 elements.

ABAQUS Verification Manual

• “Small-sliding contact between stress/displacement elements,” Section 1.6.1

• “Small-sliding contact between coupled temperature-displacement surfaces,” Section 1.6.2

• “Small-sliding contact between coupled pore pressure-displacement elements,” Section 1.6.3

• “Automatic element conversion for surface contact,” Section 1.6.14

• “Contact with initial overclosure of curved surfaces,” Section 1.6.15

• “Small-sliding contact with specified clearance or overclosure values,” Section 1.6.16

• “Contact surface extensions,” Section 1.6.19

• “Adjusting contact surface normals at symmetry planes,” Section 1.6.20

• “Design sensitivity analysis,” Section 3.11.1

11.2 IMPROVED CONTACT STRESSES FOR SECOND-ORDER

ELEMENTS

Product: ABAQUS/Standard
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Benefits: Contact stresses for most types of second-order elements have been improved if a softened

pressure-overclosure relationship is specified or if an augmented Lagrangian contact enforcement method is

used.

Description: Noise in contact stresses and element stresses near a contact interface has been reduced in

many cases involving second-order elements with the traditional node-to-surface approach (see also “Surface-

to-surface small-sliding contact accounting for thickness,” Section 11.1, regarding improvements in contact

stress accuracy with a surface-to-surface approach for small-sliding contact). These improvements apply to

both small- and finite-sliding contact under the following circumstances:

• A softened pressure-overclosure relationship is specified or the augmented Lagrangian contact

enforcement method is used.

• The contact surfaces are based on any second-order element type with the following exceptions: C3D10

elements or any of the modified triangular and tetrahedral element types whose names end in the letter

“M” (for example, CPS6M and C3D10M).

A comparison of Figure 11–2 (Version 6.4 results) and Figure 11–3 (Version 6.5 results) shows a typical

reduction in element stress noise near a contact interface in Version 6.5. This example uses CAX8 elements

and augmented Lagrangian contact.

Figure 11–2 Underlying element stresses using Version 6.4.

References:

ABAQUS Analysis User’s Manual

• “Solid (continuum) elements,” Section 14.1.1
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Figure 11–3 Underlying element stresses using Version 6.5.

• “Defining contact pairs in ABAQUS/Standard,” Section 21.2.1

• “Common difficulties associated with contact modeling in ABAQUS/Standard,” Section 21.2.9

ABAQUS Keywords Reference Manual

• *SURFACE BEHAVIOR

ABAQUS Benchmarks Manual

• “The Hertz contact problem,” Section 1.1.11

ABAQUS Verification Manual

• “Surface-based pressure penetration,” Section 1.3.42

• “Small-sliding contact between stress/displacement elements,” Section 1.6.1

• “Small-sliding contact between coupled temperature-displacement surfaces,” Section 1.6.2

• “Small-sliding contact between coupled pore pressure-displacement elements,” Section 1.6.3

• “Finite-sliding contact between stress/displacement elements,” Section 1.6.4

• “Finite-sliding contact between a deformable body and a rigid surface,” Section 1.6.5

• “Finite-sliding contact between coupled temperature-displacement elements,” Section 1.6.7

• “Finite-sliding contact between coupled pore pressure-displacement elements,” Section 1.6.8

• “Adjusting contact surface normals at symmetry planes,” Section 1.6.20

• “Complex eigenvalue extraction,” Section 3.16.1
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11.3 ACCOUNTING FOR SHELL OFFSETS IN THE GENERAL CONTACT

ALGORITHM

Products: ABAQUS/Explicit ABAQUS/CAE

Benefits: Double-sided element (for example, shell) offsets are accounted for in the general contact

algorithm.

Description: In some cases the geometry of one surface of a thin shell-like body is known accurately and

is used to construct the model in a preprocessor. If double-sided elements are defined on this surface, an

offset must be defined to specify the position of the midsurface with respect to the reference surface (see

Figure 11–4). This offset must be accounted for in general contact to model the contact behavior correctly.

By default, all offsets specified on element section definitions are recognized by the general contact algorithm.

In addition, the default offset used in the general contact algorithm can be changed (for example, to ignore

shell element offsets).

thickness

offset fraction = 0.0

midsurface = reference surface

element normals

offset fraction = +0.5

reference surface

midsurface

Figure 11–4 Surface offsets in general contact.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Create: General contact (Explicit): Surface Properties:

Shell/Membrane offset assignments: Edit

References:

ABAQUS Analysis User’s Manual

• “Defining general contact interactions,” Section 21.3.1

• “Surface properties for general contact,” Section 21.3.2
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ABAQUS/CAE User’s Manual

• “Specifying surface property assignments for general contact,” Section 15.12.7, in the online version of

this manual

ABAQUS Keywords Reference Manual

• *CONTACT

• *SURFACE PROPERTY ASSIGNMENT

11.4 SPECIFYING FEATURE EDGE CRITERIA AND PURE

MASTER-SLAVE ASSIGNMENTS FOR GENERAL CONTACT

INTERACTIONS

Product: ABAQUS/CAE

Benefits: The ability to specify ABAQUS/Explicit feature edge criteria in ABAQUS/CAE increases

coverage of ABAQUS contact interaction functionality. Highlighting of selected surfaces is now available

in the procedure for defining general contact.

Description: You can now specify the feature edge criteria for the perimeter edges and geometric edges to

include in the general contact domain, as shown in Figure 11–5. In addition, you can specify pure master-slave

weighting for node-to-face contact in a general contact interaction, as shown in Figure 11–6.

When you select surfaces to specify the contact domain or the attribute assignments, ABAQUS/CAE

highlights the surfaces in the viewport by default. However, highlighting does not apply for the (Global),

(Self), and (All) selections. You can toggle offHighlight selected regions to turn off selection highlighting.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Create: General contact (Explicit): Surface Properties:

Feature edge criteria assignments: Edit

Interaction→Create: General contact (Explicit): Contact Formulation:

Pure master-slave assignments: Edit

References:

ABAQUS/CAE User’s Manual

• “Defining general contact,” Section 15.12.5, in the online version of this manual

• “Specifying surface property assignments for general contact,” Section 15.12.7, in the online version of

this manual

• “Specifying master-slave assignments for general contact,” Section 15.12.8, in the online version of this

manual
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Figure 11–5 Specifying feature edge criteria for the general contact domain.

11.5 CUSTOMIZING CONTACT CONTROLS

Product: ABAQUS/CAE

Benefits: The ability to specify controls for ABAQUS/Standard and ABAQUS/Explicit contact interactions

in ABAQUS/CAE increases the coverage of ABAQUS solver functionality.

Description: You can use the contact controls editors in the Interaction module to customize the variables

that control the contact algorithms; however, the default settings are appropriate for most analyses. Contact

controls are for advanced users and should be used with care.

The contact controls in the Interaction module replace the contact controls previously available for

ABAQUS/Explicit analyses in the Step module and extend the functionality to ABAQUS/Standard analyses.
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Figure 11–6 Specifying pure master-slave weighting in a general contact interaction.

You now specify contact controls for interactions instead of analysis steps. To customize the contact controls,

you first modify the variable settings using the contact controls editor in the Interaction module. Then, you

create a surface-to-surface contact or self-contact interaction and specify the contact controls to use for the

interaction in the interaction editor. Figure 11–7 shows the contact controls editor for an ABAQUS/Standard

analysis.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Contact Controls

References:

ABAQUS/CAE User’s Manual

• “Specifying contact controls in an ABAQUS/Standard analysis,” Section 15.12.3, in the online version

of this manual

• “Specifying contact controls in an ABAQUS/Explicit analysis,” Section 15.12.4, in the online version

of this manual
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Figure 11–7 The ABAQUS/Standard contact controls editor in the Interaction module.

11.6 SPECIFYING INITIAL CLEARANCES AND CONTROLLING INITIAL

OVERCLOSURE ADJUSTMENTS FOR GENERAL CONTACT

Product: ABAQUS/Explicit

Benefits: The initial clearance between contact surfaces can be specified precisely when geometry errors

are introduced by the preprocessor or mesh discretization.

Description: Initial contact clearances can be specified to remove initial overclosures or to create initial

gaps between contacting surfaces.
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The default algorithm to remove initial contact overclosures cannot resolve deep penetrations of surfaces

defined on solid elements or separate tangled shell surfaces—you must direct the algorithm to resolve these

overclosures by specifying a zero clearance between specific portions of the interacting surfaces.

In cases where two curved surfaces have precise initial clearances, the discretization of each surface

determines the initial gap between each slave node and its closest point on the opposing surface (see

Figure 11–8). In this case a clearance must be defined to “correct” the discretized geometry and to satisfy the

initial clearance conditions.

Figure 11–8 Specifying a uniform initial gap between concentric circular surfaces.

References:

ABAQUS Analysis User’s Manual

• “Cavity radiation,” Section 24.1.1

ABAQUS Keywords Reference Manual

• *CONTACT

• *CONTACT CLEARANCE

• *CONTACT CLEARANCE ASSIGNMENT
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11.7 PERFORMANCE IMPROVEMENTS FOR INTERACTING RADIATION

HEAT TRANSFER

Product: ABAQUS/Standard

Benefits: Computational speed and memory usage for cavity radiation heat transfer have been improved

substantially.

Description: Heat can be exchanged through radiation between parts of a heated surface in

ABAQUS/Standard. The algorithm to compute the interaction operators has been upgraded significantly

with regard to memory requirements, computational speed, interoperability with multipoint constraints, and

algorithm technology.

The maximum permissible size of a cavity has been doubled to 40 thousand facets. Memory usage

has been observed to reduce between 8% and 46% in test problems, and more accurate memory estimation

procedures allow resources to be utilized more efficiently. Overall computational performance (wall clock

time) has been observed to improve between 20% and 95% in large test problems.

The user interface is unaltered.

References:

ABAQUS Analysis User’s Manual

• “Resolving initial overclosures and specifying initial clearances for general contact,” Section 21.3.5

ABAQUS Keywords Reference Manual

• *CAVITY DEFINITION

• *HEAT TRANSFER

• *RADIATION VIEWFACTOR

11.8 DEFINING CONCENTRATED CONVECTIVE AND RADIATIVE

BEHAVIOR

Product: ABAQUS/CAE

Benefits: The addition of concentrated film and radiation behavior to ABAQUS/CAE increases the coverage

of ABAQUS analysis product functionality.

Description: Concentrated film and radiation thermal interactions, previously available in

ABAQUS/Standard and ABAQUS/Explicit, can be defined in ABAQUS/CAE. You can define convective

and radiative interactions about a selected vertex or set of vertices in your model and about a node or node
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set in an orphan mesh. Concentrated thermal interactions are available in addition to existing distributed

(surface-based) thermal interactions.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Create: choose interaction type: Concentrated film condition or

Concentrated radiation to ambient

References:

ABAQUS/CAE User’s Manual

• “Understanding interactions,” Section 15.3

• “Defining a concentrated convective interaction,” Section 15.12.11, in the online version of this manual

• “Defining a concentrated radiative interaction,” Section 15.12.13, in the online version of this manual

11.9 CONTROLLING NODAL EROSION FOR GENERAL CONTACT

Product: ABAQUS/Explicit

Benefits: You can now control whether contact nodes remain in the contact domain after all the surrounding

faces and edges have eroded due to failure of the underlying elements.

Description: By default, nodes of element-based surfaces remain in the general contact calculations after

all the surrounding elements fail, which is consistent with the behavior in previous versions. These nodes act

as free-floating point masses that can experience contact with active contact faces. In Version 6.5 you can

specify to remove nodes from the contact calculations once all the surrounding faces and edges have eroded.

This process is referred to as nodal erosion.

The motivation for nodal erosion is to reduce computational cost, particularly for analyses conducted

in parallel. Free-flying nodes are likely to move far away from the contact faces that remain active, which

stretches the volume of the contact domain if nodal erosion is not specified, leading to increased contact

search costs and, in parallel analyses, increased cost of communication between processors. However, contact

involving free-flying nodes can contribute significant momentum transfer in some cases, which will not be

accounted for if nodal erosion is specified.

References:

ABAQUS Analysis User’s Manual

• “Contact controls for general contact,” Section 21.3.6

ABAQUS Keywords Reference Manual

• *CONTACT

• *CONTACT CONTROLS ASSIGNMENT
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ABAQUS Example Problems Manual

• “Eroding projectile impacting eroding plate,” Section 2.1.4

11.10 PERFORMANCE IMPROVEMENTS FOR GENERAL CONTACT

Product: ABAQUS/Explicit

Benefits: Computational speed for general contact has been improved.

Description: Significant improvements to the efficiency of general contact have been made in Version 6.5.

Analysis times will typically decrease by 10–20% for ABAQUS/Explicit models in which a large fraction of

elements are exposed to contact.

References:

ABAQUS Analysis User’s Manual

• “Defining general contact interactions,” Section 21.3.1

ABAQUS Keywords Reference Manual

• *CONTACT

11.11 STABILIZATION OF MULTI-BODY CONTACT PROBLEMS WITH

RIGID BODY MODES

Products: ABAQUS/Standard ABAQUS/CAE

Benefits: A new stabilization method addresses multi-body contact problems in which contact is not present

in increment 1 and, therefore, rigid body modes exist initially.

Description: You can add viscous stabilization to any or all contact pairs using a new form of stabilization,

similar to the existing stabilization method, with some important differences:

• The new form of stabilization applies to both normal and tangential motions, the ratio of which you can

control.

• The damping coefficient is calculated based on the stiffness of the underlying material instead of on the

initial opening.

• You can modify the calculated damping coefficient; you can ramp it down or keep it constant.

• The damping works over a limited opening range, which you can control.

• You can apply this form of stabilization to the whole model with overrides for individual contact pairs.

(In ABAQUS/CAE the stabilization can be applied only to individual contact pairs.)

In addition, you can now apply tangential damping directly as an interaction property.

11–15



INTERACTIONS

Stabilization can be applied during any step and remains in force during the step. By default, the damping

is ramped down linearly to zero so that at the end of the step a solution is obtained without damping forces. The

damping stresses CDSTRESS and the dissipated energy ALLSD are available for output. The stabilization

specified in one step is not active in subsequent steps.

ABAQUS/CAE Usage:

Interaction module:

Interaction→Contact Controls→Create: ABAQUS/Standard contact controls: Stabilization

Interaction→Property→Create: Contact: Mechanical→Damping: Tangent fraction

References:

ABAQUS Analysis User’s Manual

• “General and linear perturbation procedures,” Section 6.1.2

• “Common difficulties associated with contact modeling in ABAQUS/Standard,” Section 21.2.9

• “Contact damping,” Section 22.1.3

• “ABAQUS/Standard output variable identifiers,” Section 4.2.1

• “Results file output format,” Section 5.1.2

ABAQUS/CAE User’s Manual

• “Creating interaction properties,” Section 15.11.2, in the online version of this manual

• “Specifying contact controls in an ABAQUS/Standard analysis,” Section 15.12.3, in the online version

of this manual

ABAQUS Keywords Reference Manual

• *CONTACT CONTROLS, STABILIZE

• *CONTACT DAMPING, TANGENT FRACTION

ABAQUS Theory Manual

• “Contact pressure definition,” Section 5.2.1

• “Coulomb friction,” Section 5.2.3

11.12 ELIMINATION OF MULTIPLE STATE AND MODEL FILES DURING

ELEMENT REORDERING

Product: ABAQUS/Standard

Benefits: Multiple state and model files are no longer created if the elements are reordered in

ABAQUS/Standard finite-sliding analyses.
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Description: In previous versions of ABAQUS/Standard new model and state files were created each time

the automated contact patch algorithm resulted in an element reordering. This could result in significant disk

space costs for analyses that underwent multiple reorderings. Version 6.5 no longer generates these files.

Reference:

ABAQUS Analysis User’s Manual

• “Common difficulties associated with contact modeling in ABAQUS/Standard,” Section 21.2.9
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12. ENGINEERING FEATURES

This chapter discusses engineering features related to part and assembly modeling in ABAQUS/CAE. It

provides an overview of the following enhancements:

• “Defining skin reinforcements,” Section 12.1

• “Defining point mass and rotary inertia in ABAQUS/CAE,” Section 12.2

• “Defining damping in ABAQUS/CAE,” Section 12.3

• “Defining heat capacitance in ABAQUS/CAE,” Section 12.4

• “Defining a crack in ABAQUS/CAE,” Section 12.5

• “Defining springs and dashpots in ABAQUS/CAE,” Section 12.6
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12.1 DEFINING SKIN REINFORCEMENTS

Product: ABAQUS/CAE

Benefits: You now use the Special menu in the Property module to define skin reinforcements on a part.

The Skin menu in the Property module has been removed.

Description: You can define a skin that is bonded to the surface of an existing part and specify its engineering

properties. This feature was previously defined using the Skin menu in the Property module; now you define

skins using the Special menu in the Property module.

ABAQUS/CAE Usage:

Property module:

Special→Skin

Reference:

ABAQUS/CAE User’s Manual

• “Modeling skin reinforcements,” Section 20.3

12.2 DEFINING POINT MASS AND ROTARY INERTIA IN ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: You can now define lumped mass and rotary inertia at points on a part or on an assembly and

display symbols in the viewport that represent the mass and inertia.

Description: You can define lumped mass and rotary inertia at a point on a part or on an assembly. These

features were previously defined using section assignments in the Property module; now you define them

using the Special menu in the Property module or the Interaction module. Mass and rotary inertia features

created on a part are instanced along with the part.

ABAQUS/CAE Usage:

Property module or Interaction module:

Special→Inertia→Create: Point mass/inertia

Reference:

ABAQUS/CAE User’s Manual

• “Modeling inertia,” Section 20.2
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12.3 DEFINING DAMPING IN ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: You can now define damping at points on a part or on an assembly in an ABAQUS/Standard

analysis.

Description: In an ABAQUS/Standard analysis you can define mass and inertia proportional damping

and composite damping. These features were previously defined using section assignments in the Property

module; now you define them using the Special menu in the Property module or the Interaction module.

Damping features created on a part are instanced along with the part.

ABAQUS/CAE Usage:

Property module or Interaction module:

Special→Inertia→Create: Point mass/inertia

Reference:

ABAQUS/CAE User’s Manual

• “Modeling inertia,” Section 20.2

12.4 DEFINING HEAT CAPACITANCE IN ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: You can now define heat capacitance at points on a part or on an assembly and display symbols in

the viewport that represent the heat capacitance.

Description: You can define concentrated heat capacitance at a point on a part or on an assembly. This

feature was previously defined using section assignments in the Property module; now you define heat

capacitance using the Special menu in the Property module or the Interaction module. Heat capacitance

features created on a part are instanced along with the part.

ABAQUS/CAE Usage:

Property module or Interaction module:

Special→Inertia→Create: Heat capacitance

Reference:

ABAQUS/CAE User’s Manual

• “Modeling inertia,” Section 20.2
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12.5 DEFINING A CRACK IN ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: The ability to define and analyze cracks in ABAQUS/CAE increases the coverage of ABAQUS

fracture mechanics functionality.

Description: You can define an embedded seam with duplicate overlapping nodes, or you can define a crack

in an existing region. You must choose the crack front, the crack tip or line, and the crack extension direction.

You can use the crack definition to perform a contour integral analysis and to request history output of the

-integral, -integral (for creep), stress intensity factors for both homogeneous materials and interfacial

cracks, and -stress. If you request stress intensity factors, ABAQUS can also compute the crack propagation

direction at initiation. If you are modeling a sharp crack with a small-strain analysis, you can model the

singularity of the strain field along the crack front (see “Using the Edit Mesh toolset to adjust the position of

midside nodes,” Section 13.10).

Figure 12–1 illustrates howABAQUS/CAE computes successive contour integrals for a two-dimensional

model by adding layers of elements surrounding the crack front. If your part is three-dimensional, ABAQUS

computes contour integrals at each node along the crack line, as shown in Figure 12–2.

ABAQUS/CAE Usage:

Interaction module:

Special→Crack→Create: Seam or Crack

Reference:

ABAQUS/CAE User’s Manual

• “Modeling fracture mechanics,” Section 20.1

12.6 DEFINING SPRINGS AND DASHPOTS IN ABAQUS/CAE

Product: ABAQUS/CAE

Benefits: The ability to define springs and dashpots in ABAQUS/CAE increases the coverage of ABAQUS

modeling functionality.

Description: You can easily define springs and dashpots that exhibit the same linear behavior independent

of field variables. You can also define both spring and dashpot behavior on the same set of points. In an

ABAQUS/Explicit or an ABAQUS/Standard analysis you can model springs and dashpots that connect two

points, following the line of action between the two points. In an ABAQUS/Standard analysis you can also

model springs and dashpots that connect two points, acting in a fixed direction, or that connect points to

ground.
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Figure 12–1 Successive contour integrals are calculated by adding layers of elements.
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crack line crack front
(cell)

Figure 12–2 ABAQUS computes the contour integral at each node along the crack line.
You define springs and dashpots using the Special menu in the Property module or the Interaction

module. Springs and dashpots created on a part are instanced along with the part. If you want to include

the spring/dashpot results data in the output database generated by the analysis, you must use the History

Output Request editor in the Step module.

ABAQUS/CAE Usage:

Property module and Interaction module:

Special→Springs/Dashpots→Create

Reference:

ABAQUS/CAE User’s Manual

• “Modeling springs and dashpots,” Section 20.4

12–7





13. MESHING

This chapter discusses features related to meshing your model. It provides an overview of the following

enhancements:

• “Meshing parts,” Section 13.1

• “Merging meshed parts,” Section 13.2

• “Support for curvature-based part seeding,” Section 13.3

• “New tetrahedral meshing algorithm,” Section 13.4

• “Improved advancing front quad-dominated meshes,” Section 13.5

• “Querying the mesh stack direction,” Section 13.6

• “Orienting the mesh stack direction for orphan meshes,” Section 13.7

• “Converting orphan meshes to gasket elements,” Section 13.8

• “Editing the mesh and preserving the user’s intent,” Section 13.9

• “Using the Edit Mesh toolset to adjust the position of midside nodes,” Section 13.10

• “Using the Edit Mesh toolset to create an offset mesh,” Section 13.11
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13.1 MESHING PARTS

Product: ABAQUS/CAE

Benefits: A part that is instanced many times in the assembly needs to be meshed only once. The mesh

appears on each instance of the part.

Description: You can now mesh a part in the Mesh module, as opposed to meshing a part instance from the

assembly. The Object field in the context bar in the Mesh module allows you to do the following:

• Display the assembly and mesh independent part instances.

• Display a selected part and mesh the part. ABAQUS/CAE associates the same mesh with each dependent

instance of the part in the assembly. This approach is convenient when you create a linear or radial pattern

of dependent part instances. You can mesh the original part, and ABAQUS/CAE associates the mesh

with each instance of the part in the pattern.

ABAQUS/CAE instances the meshed representation of a dependent part instance in the input file by

writing a single set of nodal coordinates and element connectivity to define the part along with a transform to

define each part instance. In contrast, ABAQUS/CAE does not take advantage of instantiation in the input file

with independent part instances—sets of nodal coordinates and element connectivity are written to the input

file for each independent part instance.

ABAQUS/CAE Usage:

Mesh module:

Mesh→Instance

Mesh→Part

References:

ABAQUS/CAE User’s Manual

• “What is the difference between a dependent and an independent part instance?,” Section 13.3.2

• “Meshing independent and dependent part instances,” Section 17.3.6

13.2 MERGING MESHED PARTS

Product: ABAQUS/CAE

Benefits: If you have already meshed parts or an independent part instance in the Mesh module, you can

merge their meshes in the Assembly module.

Description: Previous versions of ABAQUS/CAE allowed you to merge ABAQUS/CAE native part

instances or orphan mesh part instances in the Assembly module. The Assembly module now allows you

to view the mesh of ABAQUS/CAE native part instances that you have already meshed. In addition, the

Assembly module now allows you to merge the meshes of ABAQUS/CAE native part instances. The
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procedure is the same as merging orphan mesh part instances with previous versions of ABAQUS/CAE—you

can specify the node merging tolerance, and you can choose whether to merge along only the intersecting

boundaries.

Reference:

ABAQUS/CAE User’s Manual

• “Merging meshed part instances,” Section 13.6.2

13.3 SUPPORT FOR CURVATURE-BASED PART SEEDING

Product: ABAQUS/CAE

Benefits: Seeding can allow for the curvature of an edge. Taking the curvature into account simplifies the

task of seeding models that have holes of various sizes and other regions of high curvature, such as blends.

Description: The part seeding tool allows you to specify a target element size when you are seeding a part

or a part instance. If the geometry of the part is relatively regular, specifying a single target element size can

result in an acceptable mesh. However, if you specify a single target element size and the geometric features

that make up the part vary in size, the resulting mesh may be too coarse to adequately represent any small

features, as shown in Figure 13–1.

Figure 13–1 Seeding and the resulting mesh with no curvature control.
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To avoid the problem of inadequate seeding around small curved features, ABAQUS/CAE applies

curvature control when it seeds a part or part instance. Curvature control allows ABAQUS/CAE to calculate

the seed distribution based on the curvature of the edge along with the target element size. Figure 13–2

shows the same part seeded and meshed with curvature control enabled.

Figure 13–2 Seeding and the resulting mesh with curvature control enabled.

ABAQUS/CAE Usage:

Mesh module:

Seed→Part

Seed→Instance

Reference:

ABAQUS/CAE User’s Manual

• “Applying curvature control to your seeding,” Section 17.4.4

13.4 NEW TETRAHEDRAL MESHING ALGORITHM

Product: ABAQUS/CAE
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Benefits: The robustness of tetrahedral meshes is improved.

Description: A new algorithm for generating a tetrahedral mesh of a solid region using free meshing has

been introduced. In most cases the new algorithm is more robust, particularly when meshing complex shapes

and thin solids. In addition, the default algorithm allows you to increase the size of the interior elements. If

the mesh density is adequate for the model being analyzed and the areas of interest are on the mesh boundary,

increasing the size of the interior elements will increase the computational efficiency.

ABAQUS/CAE Usage:

Mesh module:

Mesh→Controls

Reference:

ABAQUS/CAE User’s Manual

• “Free meshing with triangular and tetrahedral elements,” Section 17.9.3

13.5 IMPROVED ADVANCING FRONT QUAD-DOMINATED MESHES

Product: ABAQUS/CAE

Benefits: The quality of advancing front meshes is improved.

Description: The algorithm that decides where to locate triangles in a quadrilateral-dominated advancing

front mesh has been improved. The resulting mesh is of higher quality and often contains fewer elements than

in previous versions of ABAQUS/CAE.

ABAQUS/CAE Usage:

Mesh module:

Mesh→Controls

Reference:

ABAQUS/CAE User’s Manual

• “What is the difference between the medial axis algorithm and the advancing front algorithm?,”

Section 17.7.6

13.6 QUERYING THE MESH STACK DIRECTION

Product: ABAQUS/CAE

Benefits: You can query the orientation of continuum shell and gasket elements.
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Description: You can use the Query toolset to view the mesh stack orientation and to look for regions where

the mesh stack orientation is inconsistent.

ABAQUS/CAE Usage:

Mesh module:

Tools→Query

Reference:

ABAQUS/CAE User’s Manual

• “Obtaining general information about the model,” Section 45.2.2

13.7 ORIENTING THE MESH STACK DIRECTION FOR ORPHAN MESHES

Product: ABAQUS/CAE

Benefits: You can change the orientation of continuum shell and gasket elements in an orphan mesh part.

Description: You must orient continuum shell and gasket elements correctly. For native ABAQUS/CAE

meshes, the swept meshing technique ensures that the mesh stack orientation is consistent. For orphan mesh

parts, you can use the Edit Mesh toolset to change the orientation.

ABAQUS/CAE Usage:

Mesh module:

Tools→Edit Mesh

Reference:

ABAQUS/CAE User’s Manual

• “Manipulating nodes,” Section 41.1.1

13.8 CONVERTING ORPHAN MESHES TO GASKET ELEMENTS

Product: ABAQUS/CAE

Benefits: You can now convert conventional elements to gasket elements in an orphan mesh part.

Description: Previous versions of ABAQUS/CAE did not allow you to assign gasket elements to a region

of an orphan mesh part to which conventional elements had been assigned. Now that the Edit Mesh toolset

allows you to change the orientation of the stack direction, ABAQUS/CAE allows you to convert conventional

elements to gasket elements in an orphan mesh part.
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ABAQUS/CAE Usage:

Mesh module:

Mesh→Element Type

Reference:

ABAQUS/CAE User’s Manual

• “Associating ABAQUS elements with mesh regions,” Section 17.15.10, in the online version of this

manual

13.9 EDITING THE MESH AND PRESERVING THE USER’S INTENT

Product: ABAQUS/CAE

Benefits: The Edit Mesh toolset preserves your intent when you edit an orphan mesh part.

Description: If you flip the surface normal direction of shell elements or change the orientation of the stack

direction of a continuum shell or gasket mesh using the Edit Mesh toolset, ABAQUS/CAE preserves the

orientation of prescribed conditions or named surfaces.

ABAQUS/CAE Usage:

Part module:

Tools→Edit Mesh

Reference:

ABAQUS/CAE User’s Manual

• “What can I do with the Edit Mesh toolset?,” Section 41.1, in the online version of this manual

13.10 USING THE EDIT MESH TOOLSET TO ADJUST THE POSITION OF

MIDSIDE NODES

Product: ABAQUS/CAE

Benefits: You can adjust the position of the midside nodes of second-order elements to allow for the

singularity at the crack tip in a fracture mechanics analysis.

Description: You can use the Edit Mesh toolset to edit an orphan mesh part and move the midside nodes

along edges connected to selected nodes. Moving the midside nodes allows you to include a singularity

at the crack tip in a fracture mechanics analysis (see “Defining a crack in ABAQUS/CAE,” Section 12.5).

ABAQUS/CAE moves the midside nodes based on the parameter that you enter. For example, if you enter a
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parameter of 0.25, ABAQUS/CAE positions the midside nodes one quarter of the length of the element edge

away from the selected nodes.

ABAQUS/CAE Usage:

Part module:

Tools→Edit Mesh

References:

ABAQUS Analysis User’s Manual

• “Constructing a fracture mechanics mesh for small-strain analysis” in “Contour integral evaluation,”

Section 7.10.2

ABAQUS/CAE User’s Manual

• “Controlling the singularity at the crack tip for a small-strain analysis,” Section 20.1.5

• “What can I do with the Edit Mesh toolset?,” Section 41.1

13.11 USING THE EDIT MESH TOOLSET TO CREATE AN OFFSET MESH

Product: ABAQUS/CAE

Benefits: You can create layers of shell or solid elements that are offset from an existing mesh. You can use

an offset shell mesh to create multi-layered composite models and skin reinforcements. You can use an offset

solid mesh to generate continuum shell and cohesive elements.

Description: You can use the Edit Mesh toolset to create layers of elements that are offset from existing

elements along the surface of an orphan mesh part. The layers that you create can be either shell or solid

elements. A layer of offset shell elements is shown in Figure 13–3.

mesh shell offset mesh

Figure 13–3 A layer of offset shell elements.
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A layer of offset solid elements is shown in Figure 13–4.

solid offset mesh

Figure 13–4 A layer of offset solid elements.

ABAQUS/CAE Usage:

Part module:

Tools→Edit Mesh

Reference:

ABAQUS/CAE User’s Manual

• “Manipulating the mesh,” Section 41.1.3
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14. USER SUBROUTINES, UTILITIES, AND PLUG-INS

This chapter discusses additional user programs that can be run with ABAQUS. It provides an overview of

the following enhancements:

• “User subroutine to define the magnitude and loading directions of nonuniform distributed surface

tractions, edge loads, and edge moments,” Section 14.1

• “User subroutine to specify mesh motion constraints during adaptive meshing,” Section 14.2

• “Utility routine to determine elements adjacent to a node,” Section 14.3

• “Utility routine to read results data averaged at a node,” Section 14.4

• “Utility routine to read nodal results data,” Section 14.5

• “Support for ABAQUS/CAE plug-ins,” Section 14.6

• “Plug-in to display mode contribution factors,” Section 14.7





USER SUBROUTINES, UTILITIES, AND PLUG-INS

14.1 USER SUBROUTINE TO DEFINE THE MAGNITUDE AND LOADING

DIRECTIONS OF NONUNIFORM DISTRIBUTED SURFACE

TRACTIONS, EDGE LOADS, AND EDGE MOMENTS

Product: ABAQUS/Standard

Benefits: This subroutine allows you to define a nonuniform magnitude and loading direction (if needed)

for distributed surface tractions, edge loads, and edge moments.

Description: User subroutine UTRACLOAD can be used to define the variation of a distributed traction load

magnitude as a function of position, time, element number, material point number, etc. It can also be used to

define the loading directions for general surface tractions, shear tractions, and general edge loads.

References:

ABAQUS Analysis User’s Manual

• “Distributed loads,” Section 19.4.3

• “UTRACLOAD,” Section 25.2.41

ABAQUS Keywords Reference Manual

• *DLOAD

• *DSLOAD

ABAQUS Verification Manual

• “Distributed traction and edge loads,” Section 1.4.17

14.2 USER SUBROUTINE TO SPECIFY MESH MOTION CONSTRAINTS

DURING ADAPTIVE MESHING

Product: ABAQUS/Standard

Benefits: This subroutine allows you to define adaptive mesh constraints in directions relative to surface

normals and based on solution variables.

Description: User subroutine UMESHMOTION can be used to define adaptive mesh constraint

displacements or velocities according to general solution-dependent criteria. The user subroutine has

particular value in describing surface wear or ablation. Utility routines GETVRN, GETNODETOELEMCONN,

and GETVRMAVGATNODE can be used to access solution results at the node where the constraint is applied.
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References:

ABAQUS Analysis User’s Manual

• “Adaptive meshing: overview,” Section 7.17.1

• “Defining adaptive mesh domains in ABAQUS/Standard,” Section 7.17.6

• “Adaptive meshing and remapping in ABAQUS/Standard,” Section 7.17.7

• “UMESHMOTION,” Section 25.2.32

• “Obtaining material point information averaged at a node,” Section 26.2.6

• “Obtaining node point information,” Section 26.2.7

• “Obtaining node to element connectivity,” Section 26.2.8

ABAQUS Keywords Reference Manual

• *ADAPTIVE MESH

• *ADAPTIVE MESH CONSTRAINT

ABAQUS Verification Manual

• “Adaptive mesh for solid elements in ABAQUS/Standard,” Section 5.1.1

14.3 UTILITY ROUTINE TO DETERMINE ELEMENTS ADJACENT TO A

NODE

Product: ABAQUS/Standard

Benefits: This utility routine allows you to obtain a list of elements adjacent to a node in user subroutine

UMESHMOTION.

Description: Utility routine GETNODETOELEMCONN can be used to obtain the list of elements adjacent to

a node, which is required in utility routine GETVRMAVGATNODE.

References:

ABAQUS Analysis User’s Manual

• “UMESHMOTION,” Section 25.2.32

• “Obtaining material point information averaged at a node,” Section 26.2.6

ABAQUS Keywords Reference Manual

• *ADAPTIVE MESH CONSTRAINT

ABAQUS Verification Manual

• “Adaptive mesh for solid elements in ABAQUS/Standard,” Section 5.1.1
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14.4 UTILITY ROUTINE TO READ RESULTS DATA AVERAGED AT A

NODE

Product: ABAQUS/Standard

Benefits: This utility routine allows you to obtain material point solution results data at a node in user

subroutine UMESHMOTION.

Description: Utility routine GETVRMAVGATNODE can be used to obtain solution variable results in user

subroutine UMESHMOTION. With these results you can define solution-dependent adaptive mesh constraints.

GETVRMAVGATNODE requires a list of adjacent elements, which can be obtained with utility routine

GETNODETOELEMCONN.

References:

ABAQUS Analysis User’s Manual

• “UMESHMOTION,” Section 25.2.32

• “Obtaining node to element connectivity,” Section 26.2.8

ABAQUS Keywords Reference Manual

• *ADAPTIVE MESH CONSTRAINT

ABAQUS Verification Manual

• “Adaptive mesh for solid elements in ABAQUS/Standard,” Section 5.1.1

14.5 UTILITY ROUTINE TO READ NODAL RESULTS DATA

Product: ABAQUS/Standard

Benefits: This utility routine allows you to obtain solution results data at a node in user subroutine

UMESHMOTION.

Description: Utility routine GETVRN can be used to obtain solution variable results in user subroutine

UMESHMOTION. With these results you can define solution-dependent adaptive mesh constraints.

References:

ABAQUS Analysis User’s Manual

• “UMESHMOTION,” Section 25.2.32

• “Obtaining node point information,” Section 26.2.7
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ABAQUS Keywords Reference Manual

• *ADAPTIVE MESH CONSTRAINT

ABAQUS Verification Manual

• “Adaptive mesh for solid elements in ABAQUS/Standard,” Section 5.1.1

14.6 SUPPORT FOR ABAQUS/CAE PLUG-INS

Product: ABAQUS/CAE

Benefits: You can use plug-ins to extend the capabilities of ABAQUS/CAE.

Description: You can think of plug-ins as a bridge between ABAQUS/CAE macros that play back a

sequence of actions and the more complete functionality provided by the ABAQUS GUI Toolkit. ABAQUS

plug-ins execute ABAQUS Scripting Interface and ABAQUS GUI Toolkit commands, and they provide a

convenient way to customize ABAQUS/CAE for your particular needs or preferences.

The following plug-ins are provided with this release:

• Running the Getting Started with ABAQUS examples

• Creating a GUI plug-in

• Creating a kernel plug-in

• Displaying mode contribution factors

You can also download plug-ins from the ABAQUS Process Automation Portal, or you can write your own

plug-ins.

Reference:

ABAQUS/CAE User’s Manual

• Part VIII, “Using plug-ins”

14.7 PLUG-IN TO DISPLAY MODE CONTRIBUTION FACTORS

Product: ABAQUS/CAE

Benefits: This plug-in allows you to find the dominant modes from the results of a modal frequency response

analysis.

Description: This ABAQUS/CAE plug-in calculates the contribution of each mode to the total structural or

acoustic response. This contribution is called the modal contribution factor (MCF) and is used in automotive

noise, vibration, and harshness (NVH) studies. The plug-in displays the calculated MCFs in separate

viewports in the following forms:
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• X–Y plot

• Projection plot

• Bar graph

• Polar plot

• Vector plot

The bar graph in Figure 14–1 shows the first five ranked modal contribution factors calculated by the plug-in.

The output database used in this example was generated by a coupled acoustic-structural analysis of a pick-up

truck.

Mode: 36 (40.696 Hz)(-44.74)
Mode: 169 (108.91 Hz)(-6.13)
Mode: 8 (16.005 Hz)(9.84)
Mode: 3 (10.783 Hz)(-174.17)
Mode: 24 (33.872 Hz)(-102.32)

Figure 14–1 Displaying modal contribution factors.

Reference:
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ABAQUS/CAE User’s Manual

• “Displaying modal contribution factors,” Section 54.4
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15. OUTPUT AND VISUALIZATION

This chapter discusses obtaining, postprocessing, and visualizing results from ABAQUS analyses. It provides

an overview of the following enhancements:

• “View manipulation and camera options,” Section 15.1

• “Enhanced color coding,” Section 15.2

• “Size control for displayed symbols,” Section 15.3

• “Enhancements to stress linearization,” Section 15.4

• “Creating paths using element edges or circular features,” Section 15.5

• “Integrated output over a surface,” Section 15.6

• “Whole surface contact output in general contact,” Section 15.7

• “Accessing a remote output database,” Section 15.8

• “Job diagnostics enhancements,” Section 15.9

• “Connector output,” Section 15.10

• “Filtering and improved output,” Section 15.11

• “Viewing the interior of a model,” Section 15.12

• “Substructure matrix output,” Section 15.13

• “Steady-state dynamic output enhancements,” Section 15.14

• “Vector image output,” Section 15.15

• “Results averaging and contour plot limits,” Section 15.16





OUTPUT AND VISUALIZATION

15.1 VIEW MANIPULATION AND CAMERA OPTIONS

Product: ABAQUS/CAE

Benefits: You can now view your model from the inside. In the Visualization module you can also position

the camera on a local coordinate system, and the camera can follow that coordinate system during an

animation. You can use these new options to create internal views of car crash simulations or other analyses

without removing external components from the display.

Description: There are now two camera modes available to create the view in a viewport. In the default

mode your model or results are positioned some distance in front of the camera; you can manipulate the

camera, suppress objects, and create display groups to change the view. In the new movie mode you can

use all the same techniques, but the model does not have to remain in front of the camera. You can move

the camera toward, into, and through the model to view internal or hidden portions of the model without

suppressing outer components or creating display groups. In addition, when you apply the movie mode, two

planes limit how close to the camera and how far from it objects can be before they are cut from the view.

Alternate view manipulations are available so that you can fully utilize both camera modes. Use the

[Shift] key in conjunction with the pan, rotate, and magnify tools to access a perspective pan mode, rotate the

camera about itself, and move the camera toward or away from the objects in the view, respectively. These

new view manipulations work in either camera mode, but they are primarily intended for movie mode. For

example, in the default mode you can use the alternate magnify tool to move the camera closer until it “hits”

the outer edge of the model; then the tool stops working. In movie mode you can move the camera into and

through the model. You can manipulate the camera so that it starts in front of the model, passes into the model

so that the model surrounds the camera, and then passes out through the far side of the model so that the model

is behind the camera.

Finally, in the Visualization module you can set the camera to follow the motion of a local coordinate

system. If you use movie mode, you can also position the camera at the origin of that local coordinate system.

Figure 15–1 shows the movie mode camera positioned inside a truck cab.

ABAQUS/CAE Usage:

Any module:

View→View Options

References:

ABAQUS/CAE User’s Manual

• “Understanding camera modes and view options,” Section 5.1

• “The pan view tool,” Section 5.2.2

• “The rotate view tool,” Section 5.2.3

• “The magnify tool,” Section 5.2.4

• “Customizing camera movement,” Section 37.9

15–3



OUTPUT AND VISUALIZATION

Figure 15–1 Movie mode camera.

15.2 ENHANCED COLOR CODING

Product: ABAQUS/CAE

Benefits: You can now color code your model results by element types, materials, and sections. Additional

selection methods and an enhanced user interface, including automatic coloring based on model attributes,

are available in the Visualization module.

Description: The Color Code dialog box has been updated to provide easy access to the many new options

available, as shown in Figure 15–2. The default selection when you open the dialog box is an automatic color

mapping scheme applied to all element sets in the model. You can click Apply to implement the current

selection in the viewport, or you can make any of the following changes:

• Click Auto Color List to edit the colors used for automatic color coding.

• Click column headings in the Color Mapping table to sort the table by that column.

• Select new items by attribute, element, or node.

• Change the selection method for the current item type (Pick from viewport, for example).

• Select one or more cells from the Color Mapping table to edit their colors.

You edit the color of a selection using the Select Color dialog box. (For more information, see “Enhanced

color selection,” Section 2.3.)
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Figure 15–2 The Color Code dialog box.

Note: Color coding by materials or sections is available only for output databases that contain the required

information—i.e., analyses run using ABAQUS Version 6.5.

ABAQUS/CAE Usage:

Visualization module:

Tools→Color Code

References:

ABAQUS/CAE User’s Manual

• “Coloring part instances, elements, nodes, materials, sections, and display groups,” Section 37.4.2, in

the online version of this manual

• “Customizing colors,” Section 3.2.9
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15.3 SIZE CONTROL FOR DISPLAYED SYMBOLS

Product: ABAQUS/CAE

Benefits: You can now control the size of the symbols used to represent model entities in an output database.

In addition, the range of sizes for vector and tensor arrows in a symbol plot has been expanded.

Description: The new symbol size controls in the Visualization module match the symbol size controls in

the assembly-related modules of ABAQUS/CAE. In addition to toggling model entity symbols on or off, you

can now control their size. Figure 15–3 shows the new Symbol size control in the ODB Display Options

dialog box.

Figure 15–3 Symbol size control.
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An identical control in the Symbol Plot Options dialog box changes the display size of vector and tensor

arrows.

Use the sliders in each dialog box to set symbol sizes between 1 and 30; the default size is 6. The sizes

that you choose in the ODB Display Options and Symbol Plot Options dialog boxes are applied to all

model entity symbols and to all vectors and tensors, respectively, in the current viewport.

ABAQUS/CAE Usage:

Visualization module:

View→ODB Display Options: Entity Display

Options→Symbol: Color & Style: Vector or Tensor

References:

ABAQUS/CAE User’s Manual

• “Customizing symbol plot arrows,” Section 28.4.2, in the online version of this manual

• “Controlling the display of model entities,” Section 37.10

15.4 ENHANCEMENTS TO STRESS LINEARIZATION

Product: ABAQUS/CAE

Benefits: You can now save the points in a stress line as a path, create a stress line from a saved path, and

select the components used to compute the results and to create the X–Y data.

Description: The Stress Linearization dialog box is now divided into two tabs.

• The Basic tab includes all the information necessary to create the stress line. To define the endpoints

of your stress line, you can select an existing path, select points from the viewport, or type in values.

ABAQUS/CAE highlights the completed line and labels the start and end in the viewport. Click mouse

button 3 over either endpoint in the dialog box to edit it in the viewport. If you choose to save your stress

line to a path, ABAQUS/CAE creates a path with the same name as your stress line and includes the

endpoints and each interval point in the path.

• The Computations tab includes all the components that ABAQUS/CAE uses to create the report and

to plot the stresses at each interval, as shown in Figure 15–4. Select Components for Creating XY

Data to determine what data ABAQUS/CAE plots in the viewport; your selection does not affect the

data that ABAQUS/CAE writes in the report. Conversely, your selection of components for computing

the invariants affects the report data but does not change the plotted output. The data in the Radius of

Curvature of Center Surface portion of the dialog box affect the computation of both displayed and

printed stress line output. The in-plane radius defines the curvature of the midplane where the stress line

intersects it; the out-of-plane radius defines the curvature axis of symmetry to the same midplane stress

line intersection.
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Figure 15–4 Stress linearization components.

ABAQUS/CAE Usage:

Visualization module:

Tools→Query: Stress linearization

References:

ABAQUS/CAE User’s Manual

• Chapter 33, “Calculating linearized stresses”

• “Linearizing an X–Y data object,” Section 30.4.14
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ABAQUS Theory Manual

• “Stress linearization,” Section 2.17.1

15.5 CREATING PATHS USING ELEMENT EDGES OR CIRCULAR

FEATURES

Product: ABAQUS/CAE

Benefits: You can now create paths that follow element edges, the circumference of a circle, or the radius

of a circle. In addition to the new methods, the endpoints of paths are now clearly labeled, both when first

created and when plotted in a viewport.

Description: You create edge list paths by selecting edges from the viewport; you can also use standard

keyboard and mouse editing techniques to edit the edge labels in the path definition table. Edge labels are of

the form (element number, face number, edge number, direction). In addition, you can

select a single element edge, and ABAQUS/CAE can calculate the shortest element edge path to a node that

you select as the endpoint. If you select an element edge that lies along a feature edge, ABAQUS/CAE can

automatically select the remaining edges between your selection and the end of the feature edge.

To create circumferential or radial paths, you must first define a circle in the viewport. After defining the

circle, you can select a different length for the radius, specify the number of segments in the path, and enter

a start and an end angle for a circumferential path. For a radial path you can select a radial angle, specify the

number of segments in the path, and pick the distance at which the path will start and end along the radius.

You can create circumferential paths to obtain cross-sectional results in a curved portion of a model. You can

use radial paths to obtain results spanning from the inner to the outer face of a curve; radial paths are ideal for

use in stress linearization (for more information, see “Enhancements to stress linearization,” Section 15.4).

Figure 15–5 shows a circumferential path definition and the path that it creates in the viewport. Figure 15–6

shows a radial path definition and the path that it creates in the viewport.

ABAQUS/CAE Usage:

Visualization module:

Tools→Path→Create

Reference:

ABAQUS/CAE User’s Manual

• Chapter 32, “Viewing results along a path”

15.6 INTEGRATED OUTPUT OVER A SURFACE

Products: ABAQUS/Explicit ABAQUS/CAE
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End

Start

Figure 15–5 Creating a circumferential path.

Benefits: You can request history output of the total force and moment transmitted across a surface. You

can also monitor the average translation and rotation of a surface using integrated output sections.

Description: You can obtain the time history of force and moment transmitted across a surface with the

results computed in a coordinate system that is fixed or rotates and translates with deformation. You must

define an integrated output section definition and associate it with an integrated output request when the output

in a moving coordinate system is required. Variables for total force (SOF), total moment (SOM), and total

area of the surface (SOAREA) are available.

See “Defining interior cross-section surfaces,” Section 4.13, for information on creating cross-section-

like “interior” surfaces for which integrated output can be requested to study the force-flow in a model with

a free-body-diagram-type simplification. Integrated output can also be requested for “exterior” surfaces to

monitor the force and moment transmitted across a contact or tie constraint.
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End

Start

Figure 15–6 Creating a radial path.

An integrated output section definition can be used with an integrated output request as described above.

It can also be used to monitor the average motion of a surface by including a reference node in the integrated

output section definition.

ABAQUS/CAE Usage:

Step module:

Output→Integrated Output Sections

History output request editor: Domain: Integrated output section

References:

ABAQUS Analysis User’s Manual

• “Defining element-based surfaces,” Section 2.3.2

• “Integrated output section definition,” Section 2.5.1

• “Output to the output database,” Section 4.1.3

• “ABAQUS/Explicit output variable identifiers,” Section 4.2.2

15–11



OUTPUT AND VISUALIZATION

ABAQUS/CAE User’s Manual

• “Integrated output from ABAQUS/Explicit,” Section 14.5.1

ABAQUS Keywords Reference Manual

• *INTEGRATED OUTPUT

• *INTEGRATED OUTPUT SECTION

• *SURFACE

15.7 WHOLE SURFACE CONTACT OUTPUT IN GENERAL CONTACT

Product: ABAQUS/Explicit

Benefits: History output of total force quantities can be requested to monitor bulk effects of contact between

bodies.

Description: Whole surface contact force resultant output variables (previously available only for contact

pairs) are now available for general contact history output. Variables for total contact force (CFN, CFS, CFT),

total moment due to contact force (CMN, CMS, CMT), center of contact pressure (XN, XS, XT), and total

area in contact (CAREA) are available.

References:

ABAQUS Analysis User’s Manual

• “Defining general contact interactions,” Section 21.3.1

• “ABAQUS/Explicit output variable identifiers,” Section 4.2.2

ABAQUS Keywords Reference Manual

• *CONTACT

• *CONTACT OUTPUT

15.8 ACCESSING A REMOTE OUTPUT DATABASE

Products: ABAQUS/CAE ABAQUS/Viewer

Benefits: You can submit an analysis to a remote system and view the resulting output database from a local

system.

Description: You can create a network ODB connector on a remote system that allows you to do the

following:
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• Open a remote output database in read-only mode and view the contents of the output database using

the Visualization module. The behavior of the Visualization module does not change when the output

database is remote; for example, you can view the output database while the analysis is running on a

remote machine, and more than one user can view the output database.

• Import a part from a remote output database.

• Import a model from a remote output database.

• Upgrade a remote output database.

You can create a network ODB connector from any platform—Windows, UNIX, or Linux. However, the

remote file access server must reside on a UNIX or Linux platform; you cannot access an output database

that resides on a remote Windows system. You can access only a remote output database; you cannot access

a remote model database.

After you create and start a network ODB connector, you can use it to navigate the directory structure

on a remote host. When you open a database from ABAQUS/CAE, a Network connectors entry appears

under Directory in the file selection dialog box.

When you start an ABAQUS/CAE session, a cache is created in the scratch file directory. ABAQUS/CAE

uses this cache for local data storage when you use a network ODB connector to read from a remote output

database. The cache greatly increases the performance of the Visualization module in ABAQUS/CAE when

accessing data from the remote output database. In most cases you will not have to tune the size of the cache.

However, you may have to reduce the size of the cache if it is consuming too much disk space and reducing

the speed of other applications on your system.

References:

ABAQUS/CAE User’s Manual

• “Accessing an output database on a remote computer,” Section 9.3

• “Tuning the cache size to increase the performance of a network ODB,” Section 9.3.3

• “Creating a network ODB connector,” Section 9.7.3, in the online version of this manual

• “Managing network ODB connectors,” Section 9.7.5, in the online version of this manual

15.9 JOB DIAGNOSTICS ENHANCEMENTS

Product: ABAQUS/CAE

Benefits: Diagnostic information generated by an ABAQUS analysis can be conveniently accessed

from within the ABAQUS/CAE environment. The warnings and errors that are most commonly

generated by ABAQUS/Standard jobs—including summary information, cutback information, and element

diagnostics—can now be accessed in the Visualization module.

Description: The summary for each analysis now includes the number of warnings and errors in the analysis,

and the information describing the automatic time incrementation scheme used by ABAQUS/Standard has
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been expanded and reorganized. Tabbed pages help you locate where any problems occurred, filter warnings

and errors by category, and provide a brief description of each type of diagnostic information. By selecting

a stage of the analysis from the Job History tree, you can also limit the display of diagnostic information

to a specific step, increment, attempt, or iteration. In addition, you can highlight in the viewport the nodes

or elements associated with warnings and errors. Figure 15–7 shows the Errors tabbed page in the Job

Diagnostics dialog box.

Figure 15–7 Location and description of an analysis error.

If ABAQUS made a cutback in an analysis attempt, the summary for that attempt now includes a reason

for the cutback—for example, a severe overclosure or a diverging solution. Element diagnostics include

distorting elements, excessive strain increments, and failed constitutive calculations. Interpreting the reason

for cutbacks and element diagnostics is an essential step in resolving convergence problems in an analysis.

Note: Although Job Diagnostics were available in ABAQUS Version 6.4, the enhancements in the current

version do not allow you to view diagnostics for an upgraded output database. To view diagnostic information,

you must run the analysis using ABAQUS Version 6.5.

ABAQUS/CAE Usage:

Visualization module:

Tools→Job Diagnostics

Reference:

ABAQUS/CAE User’s Manual

• Chapter 23, “Viewing diagnostic output”
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15.10 CONNECTOR OUTPUT

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: History output of connector plasticity, damage, and friction quantities can be used to monitor

plasticity, damage, and friction effects in connector elements.

Description: Table 15–1 describes the new connector output variables that are available for history output.

Table 15–2 lists the previously available connector friction output variables that have been renamed.

Table 15–1 Connector output variables.

Connector Output Output Variable

Identifier

Description

CUP Connector plastic relative motion

CUPEQ Connector equivalent relative plastic

motion

Connector plasticity

CALPHAF Connector kinematic hardening shift

force/moment

CDMG Connector overall damage

CDIF Connector force-based damage

initiation criterion

CDIM Connector motion-based damage

initiation criterion

Connector damage

(available only in

ABAQUS/Explicit)

CDIP Connector plastic motion-based

damage initiation criterion

Connector elasticity CUE Connector elastic relative motion

CNF Connector contact force

CSF Connector friction force

CASU Connector accumulated slip

Connector friction

CIVC Connector instantaneous slip velocity
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Table 15–2 Renamed connector friction output variables.

Old Name New Name

CSFSL CSFC

CNFSL CNFC

CASUSL CASUC

CIVSL CIVC

References:

ABAQUS Analysis User’s Manual

• “ABAQUS/Standard output variable identifiers,” Section 4.2.1

• “ABAQUS/Explicit output variable identifiers,” Section 4.2.2

• “Connector behavior,” Section 17.2.1

ABAQUS Keywords Reference Manual

• *CONNECTOR DAMAGE EVOLUTION

• *CONNECTOR DAMAGE INITIATION

• *CONNECTOR FRICTION

• *CONNECTOR PLASTICITY

15.11 FILTERING AND IMPROVED OUTPUT

Products: ABAQUS/Standard ABAQUS/Explicit ABAQUS/CAE

Benefits: Real-time filtering is available in ABAQUS/Explicit to reduce noise in element, nodal, contact,

integrated, and fastener interaction history output. In addition, new field output variables are available in

ABAQUS/Standard and ABAQUS/Explicit; you can use the new variables, filtering, and other output options

to reduce the size of the output database.

Description: You can create and apply three types of Infinite Impulse Response low-pass filters to

ABAQUS/Explicit history output requests: Butterworth, Type I Chebyshev, and Type II Chebyshev. Use

real-time filtering to avoid aliasing your history output; aliasing can occur when data are saved with a

sampling frequency (the time interval between saves) that is not at least double the highest frequency of

interest in the analysis. Without real-time filtering you can ensure that there is no aliasing only if you save

every analysis increment to the output database. You can also filter history output to eliminate the noise

(the high-frequency—and, thus, undesirable—content of your output). You can specify the cutoff frequency

when defining the filter; any frequencies above the cutoff frequency will be eliminated from your output.

15–16



OUTPUT AND VISUALIZATION

With filtering applied, you can safely reduce the sampling frequency for your output, which in turn may

reduce the size of the output database. An antialiasing filter can be also invoked on saved history output

without explicitly defining the filter; the filter is built internally by ABAQUS.

New nodal output variables are available in both ABAQUS/Explicit and ABAQUS/Standard. You can

specify that you are interested in only the translational or rotational components of displacements, velocities,

and accelerations; and you can specify that you are interested in only the reaction forces or reaction moments.

You can also suppress the output of material orientations to reduce the size of the output database. You can

now request element field output in ABAQUS/Explicit for certain section points in shell and beam elements,

just as you can in ABAQUS/Standard.

You can apply filters when you create a history output request and access the new variables and output

options when you create a field output request in ABAQUS/CAE. You must select the output that you want

ABAQUS to save during the analysis; you can toggle on Preselected defaults, if desired, to get the default

output for the current type of step. The output database is reduced in size by saving only the results that you

request and by filtering prior to saving the data.

ABAQUS/CAE Usage:

Step module:

Tools→Filter→Create

Output→Field Output Requests→Create

Output→History Output Requests→Create

References:

ABAQUS Analysis User’s Manual

• “Filtering history output in ABAQUS/Explicit” in “Output to the output database,” Section 4.1.3

• “ABAQUS/Standard output variable identifiers,” Section 4.2.1

• “ABAQUS/Explicit output variable identifiers,” Section 4.2.2

ABAQUS/CAE User’s Manual

• “Defining output requests,” Section 14.11

• Chapter 43, “The Filter toolset”

ABAQUS Keywords Reference Manual

• *FILTER

• *OUTPUT

• *ELEMENT OUTPUT

15.12 VIEWING THE INTERIOR OF A MODEL

Product: ABAQUS/CAE
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Benefits: View cuts allow you to cut through a model so that you can visualize the interior or selected

sections of the model. Cuts can be manipulated easily and quickly in the viewport, enabling high-performance

display of all aspects of complex models.

Description: View cuts are essentially sections defined through a model. You can define planar, cylindrical,

or spherical view cuts. In addition, you can define a view cut along a constant contour variable value (i.e., an

isosurface). Predefined view cuts along the -, -, and -planes are created by default.

Once you have defined a view cut, you can activate it in the current viewport and view the model above,

on, or below the cut. You can customize the view options for each part of the model individually; for example,

you can display the model above the cut in the wireframe render style and the model below the cut in the

shaded render style or you can display the edges of the model that lie on the cut in a different color and style

than the rest of the model.

View cuts can be activated on undeformed, deformed, contour, symbol, or material orientation plots as

well as animations. On a deformed shape plot, you can choose whether or not the cut should deform with the

model. In addition, you can reposition view cuts on the model.

Figure 15–8 shows some examples of the types of view cuts you can define, as well as how you can

customize the view options for the parts of the model on, above, and below the cut.

Figure 15–8 View cuts based on planar, cylindrical, spherical, and isosurface shapes, with

different view options defined for the different parts of the model.
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ABAQUS/CAE Usage:

Visualization module:

Tools→View Cut→Create

Reference:

ABAQUS/CAE User’s Manual

• Chapter 35, “Cutting through a model”

15.13 SUBSTRUCTURE MATRIX OUTPUT

Product: ABAQUS/Standard

Benefits: Substructure matrix output is now available from the output database (.odb) file.

Description: Substructure matrix output includes a substructure’s recovery matrix, reduced stiffness matrix,

mass matrix, load case vectors, and gravity load vectors. You now have the option of saving this output to the

output database in addition to the ABAQUS/Standard results file or a text file of the form filename.mtx.

References:

ABAQUS Analysis User’s Manual

• “Defining substructures,” Section 7.2.2

ABAQUS Keywords Reference Manual

• *SUBSTRUCTURE MATRIX OUTPUT

15.14 STEADY-STATE DYNAMIC OUTPUT ENHANCEMENTS

Product: ABAQUS/Standard

Benefits: Energy output is now available for solid, structural, and acoustic elements in direct-solution

steady-state dynamic or subspace-based steady-state dynamic analysis. The vibration intensity vector variable

INTEN, used to visualize the flow of energy in a vibrating system, is available for these procedures for

structural elements, solid elements, and rebar layers, as well as acoustic elements. Finally, a visualization

script allows you to analyze the relative contributions of modes to sound amplitude at a point, the “modal

contribution factors.”

Description: Element total energies, densities, section point energies, and energy totals can be written to the

output database (.odb) file, the results (.fil) file, or the data (.dat) file. The energy quantities are defined

as period totals in steady-state dynamic analysis, except for strain and kinetic energy, which have zero totals

per period. Therefore, strain and kinetic energy are reported as root-mean-square averages over a period.
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The vibration intensity variable INTEN is a vector quantity available as element output from the output

database. For general steady-state vibration it is complex-valued; for real-only steady-state vibration it is

purely imaginary. In this case, however, the imaginary value is stored in the output database as real.

In complicated analysis of vibrating structural-acoustic systems such as passenger vehicles,

determination of the modes that contribute the most to the acoustic response at a given point is of critical

interest. In ABAQUS this can be achieved by performing a coupled eigenfrequency extraction analysis

of the structural-acoustic system, followed by a steady-state dynamic analysis using the coupled modal

basis; for example, subspace-based steady-state dynamic analysis. A new visualization script automates

many commonly used sorting and graphical procedures based on modal contribution factor methodologies.

Using the visualization script, the results from ABAQUS analyses can be manipulated to depict the relative

contributions of specific modes to the sound levels at any given point. Problematic modes for noise exhibit

modal contribution factors and high-phase coherence with the sound pressure.

References:

ABAQUS Analysis User’s Manual

• “Acoustic, shock, and coupled acoustic-structural analysis,” Section 6.9.1

ABAQUS Keywords Reference Manual

• *FREQUENCY

• *STEADY STATE DYNAMICS, DIRECT or SUBSPACE PROJECTION

• *ELEMENT OUTPUT

• *ENERGY OUTPUT

• *ENERGY PRINT

15.15 VECTOR IMAGE OUTPUT

Product: ABAQUS/CAE

Benefits: Vector PS, EPS, and SVG images of your models and results scale well for use in reports and

presentations.

Description: When you print any viewport image to a PostScript printer or file or an Encapsulated

PostScript file, you can choose whether to output the image in vector or raster format (in previous versions of

ABAQUS/CAE wireframe images were always output in vector format and hidden, filled, or shaded images

were always output in raster format). Vector images are scalable and resolution independent. Raster (or

bitmap) images are pixelated and resolution dependent and tend to decrease in quality when they are scaled.

For vector images you can also choose how curved surfaces will be shaded.

In addition, a new vector image format is available for printing: Scalable Vector Graphics (SVG) is an

industry-standard language for describing two-dimensional graphics in PDF.

15–20



OUTPUT AND VISUALIZATION

ABAQUS/CAE Usage:

Any module:

File→Print

Reference:

ABAQUS/CAE User’s Manual

• Chapter 8, “Printing viewports”

15.16 RESULTS AVERAGING AND CONTOUR PLOT LIMITS

Product: ABAQUS/CAE

Benefits: New controls allow you to specify how ABAQUS/CAE recalculates results data saved at element

centroids or integration points when display methods require nodal data. The available settings allow you

to enhance the visibility of different aspects of the analysis results. Contour plot limits are also affected by

changes in the result averaging.

Description: Certain display methods for field output, such as line- and banded-type contour plots, require

that results data originally saved at the element centroids or integration points be recalculated at the nodes.

Element values are extrapolated to the nodes, and then contributions from multiple elements must be assessed

at the nodes. Figure 15–9 shows the result options that you can use to control the calculations. Use the

averaging controls to view different approximations of the nodal results.

If you choose to use region boundaries, results are averaged only within the defined regions. The default

regions are based on the section assignments in the model, but you can specify your own regions based on

either element sets or display groups. You can view the selected averaging regions by using them to color

code the model. If you have already used display groups to exclude a portion of the model from the view, you

can choose to average nodal results based on all contributing elements or on the displayed elements.

Use the computation order to control how ABAQUS calculates invariants. If invariants are calculated

prior to averaging, you can select a threshold value for the difference in element values at a node; above the

threshold, ABAQUS suspends averaging and displays a discontinuity in the results. To view discontinuities

in the results, you can minimize the threshold value or suppress averaging entirely. If invariants are computed

after averaging, ABAQUS averages all results—hiding any discontinuities—to maintain a valid basis for

computing the invariants.

By default, the auto-computed limits for contour plots now include the averaged results. To set contour

limits using only the extrapolated values (as was the default in previous versions of ABAQUS/CAE), you

must toggle off Average element output at nodes in the Result Options dialog box to suppress nodal

averaging.

Note: You can no longer use the Contour Plot Options to control whether contour limits include averaging.
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Figure 15–9 Averaging controls.
ABAQUS/CAE Usage:

Visualization module:

Result→Options

Options→Contour

References:

ABAQUS/CAE User’s Manual

• “Selecting result options,” Section 24.4

• “Understanding contour limits,” Section 27.1.3
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This chapter discusses using the ABAQUS Scripting Interface to write user scripts. ABAQUS makes every

attempt to be backward compatible and can execute most ABAQUS Scripting Interface scripts from previous

versions of ABAQUS. However, backward compatibility is not guaranteed beyond several versions of

ABAQUS, and it is recommended that you upgrade your commands to the most recent version. This chapter

provides an overview of the following enhancements:

• “Materials, sections, and section assignments in the output database,” Section 16.1

• “Mass and inertia data in the output database,” Section 16.2

• “Tab completion from the command line interface,” Section 16.3

• “Approach to verifying a model database has changed,” Section 16.4
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16.1 MATERIALS, SECTIONS, AND SECTION ASSIGNMENTS IN THE

OUTPUT DATABASE

Product: ABAQUS/CAE

Description: Materials, sections, and section assignments are now available in the output database. In total,

there are over 110 new objects and commands that you can now use in the output database as well as the model

database. You can use these new data objects as an additional means to sort and postprocess output data from

an analysis. The availability of section assignments in the output database makes it possible to color code

elements by their sections or material types in the Visualization module of ABAQUS/CAE.

References:

ABAQUS Scripting User’s Manual

• “Reading model data,” Section 8.5.4

• “Writing model data,” Section 8.6.2

• “Reading model data,” Section 9.10.4

• “Writing model data,” Section 9.11.2

ABAQUS Scripting Reference Manual

• “assignSection,” Section 30.14.7

• “sectionAssignment,” Section 52.15.9

16.2 MASS AND INERTIA DATA IN THE OUTPUT DATABASE

Product: ABAQUS/CAE

Description: The OdbStep object now includes mass and inertia data members to access the relevant

information from the output database.

References:

ABAQUS Scripting Reference Manual

• “OdbStep object,” Section 30.20

• “OdbStep object,” Section 52.21

16.3 TAB COMPLETION FROM THE COMMAND LINE INTERFACE

Product: ABAQUS/CAE
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Description: You can use tab completion from the ABAQUS/CAE command line interface to speed up your

typing and to explore the object model. For example, you can type mdb.models[’Model-1’].parts[

in the command line interface. When you press the [TAB] key, the command line cycles through the parts in

the model. You can also use tab completion when you are accessing an output database from the command

line interface or from the ABAQUS Python prompt.

Reference:

ABAQUS Scripting User’s Manual

• “Using tab completion to explore the object model,” Section 6.1.2

16.4 APPROACH TO VERIFYING A MODEL DATABASE HAS CHANGED

Description: If you have custom kernel scripts that store data in a model database, you should verify that the

model database is compatible with your scripts before allowing the user to interact with the model database.

For example, if you have two different custom kernel applications that are not designed to work independently

on the same model database, you should prevent a model database that was created with the first application

from being operated on by the second application. You use the appData object and the verifyMdb method

to determine if a model database needs to be upgraded. The customKernel module has changed the way that it

handles the appData object and verifyMdb method. You must install your custom appData object by using

the setAppData method, and you must install your verifyMdb method by using the setVerifyMdb

method.

Reference:

ABAQUS Scripting User’s Manual

• “Verifying a model database,” Section 5.6.11
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17. SUMMARY OF CHANGES

This section summarizes the changes and the additions that have been made to the items that define an

ABAQUS model, including elements, MPCs, keywords, and user subroutines. For more information on

these modifications, refer to the preceding chapters.

The following identifiers are used:

new The item is new in Version 6.5.

mod The item existed in Version 6.4 but has been modified or enhanced in Version 6.5.

rem The item existed in Version 6.4 but has been removed in Version 6.5.

(S) The item is new, modified, or removed in ABAQUS/Standard.

(E) The item is new, modified, or removed in ABAQUS/Explicit.

(S)(E) The item is new, modified, or removed in both ABAQUS/Standard and ABAQUS/Explicit.

17.1 CHANGES IN ABAQUS ELEMENTS

This section summarizes the changes and the additions that have been made to the elements that can be used

in an ABAQUS model.

new (S)(E) COH2D4

Two-dimensional 4-node cohesive element.

new (S)(E) COH3D6

Three-dimensional 6-node cohesive element.

new (S)(E) COH3D8

Three-dimensional 8-node cohesive element.

new (S)(E) COHAX4

Axisymmetric 4-node cohesive element.

17.2 CHANGES IN ABAQUS OPTIONS

This section summarizes the changes and the additions that have been made to the options that define an

ABAQUS model.

mod (S) *ADAPTIVE MESH CONSTRAINT

Include the new USER parameter to enable use of user subroutine UMESHMOTION

to describe adaptive mesh constraints.
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new (S)(E) *COHESIVE SECTION

Specify element properties for cohesive elements.

mod (S) *COMPLEX FREQUENCY

The requested eigenvalues can be specified by providing the minimum and/or

maximum frequency of interest.

rem (S)(E) *CONNECTOR CONTACT FORCE

This option has been replaced by the more general *CONNECTOR DERIVED

COMPONENT option.

new (E) *CONNECTOR DAMAGE EVOLUTION

Specify connector damage evolution for connector elements.

new (E) *CONNECTOR DAMAGE INITIATION

Specify connector damage initiation criteria for connector elements.

mod (S)(E) *CONNECTOR DAMPING

The COUPLED parameter has been removed. Linear coupled damping behavior in

connectors is invoked by simply omitting the COMPONENT parameter.

Use the new INDEPENDENT COMPONENTS parameter to specify position- and

motion-dependent damping.

new (S)(E) *CONNECTOR DERIVED COMPONENT

Specify user-defined components in connector elements.

mod (S)(E) *CONNECTOR ELASTICITY

The COUPLED parameter has been removed. Linear coupled elastic behavior in

connectors is invoked by simply omitting the COMPONENT parameter.

The MOTION DEPENDENCIES parameter has been replaced by the more general

INDEPENDENT COMPONENTS parameter to allow for specification of position-

and motion-dependent elasticity.

mod (S)(E) *CONNECTOR FRICTION

The INTERACTION parameter has been removed. To refer to a friction definition,

include the *FRICTION option in the connector friction definition.

Include the new CONTACT FORCE parameter to refer to a contact force defined by

the *CONNECTOR DERIVED COMPONENT option.

new (S)(E) *CONNECTOR HARDENING

Define the plasticity initial yield value and hardening behavior in connector elements.

new (S)(E) *CONNECTOR PLASTICITY

Define plasticity behavior in connector elements.
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new (S)(E) *CONNECTOR POTENTIAL

Specify user-defined potentials in connector elements.

new (E) *CONTACT CLEARANCE

Define contact clearance properties.

new (E) *CONTACT CLEARANCE ASSIGNMENT

Assign contact clearances between surfaces in the general contact domain.

mod (E) *CONTACT OUTPUT

Whole surface contact force resultant variables (for example, CFT, CMT, etc.)

are now available for general contact history output. Include the new SURFACE

parameter to specify a surface in the general contact domain for which this output

will be calculated.

new (S)(E) *CO-SIMULATION

Define coupling regions and quantities to be communicated to and from another

analysis process.

mod (S)(E) *CYCLIC HARDENING

Use the newRATE parameter to include strain-rate effects in the isotropic component

of the nonlinear isotropic/kinematic hardening model. Set this parameter equal to the

value of the equivalent plastic strain rate for which this stress-strain curve applies.

new (S)(E) *DAMAGE EVOLUTION

Specify material properties to define the evolution of damage.

new (S)(E) *DAMAGE INITIATION

Specify material properties to define the initiation of damage.

mod (S)(E) *DLOAD

Use the new CONSTANT RESULTANT parameter to specify whether surface

tractions or edge loads should be integrated over the surface in the current or

reference configuration.

Use the new FOLLOWER parameter to specify whether a general surface traction

or edge load in a large-displacement analysis should rotate with the surface or shell

edge (live load) or remain fixed (dead load).

Use the new ORIENTATION parameter to refer to an orientation used to specify the

local coordinates in which components of general traction, shear traction, or general

edge loads are specified.

new (S)(E) *DISTRIBUTION

Define spatial distributions.
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mod (S)(E) *DSLOAD

Use the new CONSTANT RESULTANT parameter to specify whether surface

tractions or edge loads should be integrated over the surface in the current or

reference configuration.

Use the new FOLLOWER parameter to specify whether a general surface traction

or edge load in a large-displacement analysis should rotate with the surface or shell

edge (live load) or remain fixed (dead load).

Use the new ORIENTATION parameter to refer to an orientation used to specify the

local coordinates in which components of general traction, shear traction, or general

edge loads are specified.

mod (S)(E) *ELASTIC

Use TYPE=TRACTION instead of TYPE=COMPOSITE BEAM to define

orthotropic shear behavior for warping elements.

Use TYPE=TRACTION or TYPE=COUPLED TRACTION to define the elastic

traction-separation response of cohesive elements.

new (S) *ELEMENT PROPERTIES

Modify element properties on an element-by-element basis.

mod (S)(E) *FASTENER

Connector elements can now be used to model complex behavior in fasteners.

Use the new ELSET parameter to refer to the element set containing the user-defined

connector elements that will model the fastener.

Use the new ELSET parameter along with the existing REFERENCE NODE SET

parameter to enable ABAQUS to generate connector elements that will model the

fastener.

mod (S) *FREQUENCY

Include the new RESIDUAL MODES parameter to activate the calculation of

residual modes based on loading patterns defined in an immediately preceding static

perturbation step.

The number of requested eigenvalues is not a required data item for the Lanczos

eigensolver. Instead, you can specify the maximum frequency of interest.

mod (S)(E) *INITIAL CONDITIONS

Include the new INTERPOLATE parameter with the FILE parameter and

TYPE=TEMPERATURE to interpolate the temperature field from a heat transfer

analysis with a dissimilar mesh. The new ABSOLUTE EXTERIOR TOLERANCE

and EXTERIOR TOLERANCE parameters can be used with the INTERPOLATE

parameter to define tolerances for the interpolation.
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Include the SECTION POINTS parameter with TYPE=HARDENING to specify

hardening variables at individual section points through the thickness of a shell

element. This option can be used only when shell properties are defined using the

*SHELL SECTION option. It is not permitted when properties are defined using

the *SHELL GENERAL SECTION option.

new (E) *INTEGRATED OUTPUT

Specify variables integrated over a surface to be written to the output database.

new (E) *INTEGRATED OUTPUT SECTION

Define an integrated output section over a surface with a local coordinate system and

a reference point.

new (S) *MATRIX ASSEMBLE

Define stiffness matrices for a part of the model.

new (S) *MATRIX INPUT

Read in a matrix for a part of the model.

mod (S) *MODAL DAMPING

Include the new DEFINITION parameter to indicate how the damped eigenmodes

are chosen. Set DEFINITION=MODENUMBERS (the default) to assign a damping

coefficient to the eigenmode number. Set DEFINITION=FREQUENCY RANGE to

assign a damping coefficient to frequency ranges.

new (S)(E) *NONSTRUCTURAL MASS

Specify mass contribution to the model from nonstructural features.

mod (S) *SELECT EIGENMODES

Include the new DEFINITION parameter to indicate how the eigenmodes

are chosen. Set DEFINITION=MODE NUMBERS (the default) to select the

eigenmodes by eigenmode numbers. Set DEFINITION=FREQUENCY RANGE to

select the eigenmodes by frequency ranges.

mod (S) *STEADY STATE TRANSPORT

Use the new ELSET parameter to specify an element set for which the rigid body

motion will be described in a spatial or Eulerian manner.

Include the new PASSBYPASS parameter to indicate that a quasi-steady-state (pass-

by-pass) procedure will be used to obtain the steady-state solution.

mod (S) *SHELL SECTION

Include the new POISSON=ELASTIC parameter to define a thickness change in

shell elements based on the elastic material properties.
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mod (S) *SHELL GENERAL SECTION

Include the new POISSON=ELASTIC parameter to define a thickness change in

shell elements based on the elastic material properties.

mod (S) *SUBSTRUCTURE MATRIX OUTPUT

Include the new OUTPUT FILE parameter to specify the type of file to which output

will be saved.

mod (S)(E) *SURFACE

Include the new TYPE=CUTTING SURFACE parameter to generate an

approximate interior cross-section surface automatically by cutting an element set

region with a flat plane. The generated surface is suitable for applications such as

pre-tensioning and output of the force and moment transmitted across a surface.

mod (E) *SURFACE PROPERTY ASSIGNMENT

Include the new TYPE=OFFSET FRACTION parameter to control how shell offsets

are treated for double-sided surfaces in the general contact algorithm.

mod (S) *SYMMETRIC MODEL GENERATION

Include the new PERIODIC parameter to indicate that a periodic three-dimensional

model must be generated by revolving a single three-dimensional repetitive sector of

the model about the symmetry axis. If surface meshes on either side of the original

sector are not matched completely, constraints between the neighboring pairs of

corresponding surfaces will be established automatically when the periodic three-

dimensional model is generated.

mod (S)(E) *TEMPERATURE

Include the new INTERPOLATE parameter with the FILE parameter to interpolate

the temperature field from a heat transfer analysis with a dissimilar mesh. The

new ABSOLUTE EXTERIOR TOLERANCE and EXTERIOR TOLERANCE

parameters can be used with the INTERPOLATE parameter to define tolerances for

the interpolation.

17.3 CHANGES IN ABAQUS USER SUBROUTINES

This section summarizes the changes and the additions that have been made to user subroutines that can be

used in an ABAQUS model.

new (S) UMESHMOTION

User subroutine to specify solution-dependent adaptive mesh constraints.

new (S) UTRACLOAD

User subroutine to specify nonuniform distributed traction loads.
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17.4 CHANGES IN ABAQUS OUTPUT VARIABLE IDENTIFIERS

This section summarizes the changes and the additions that have been made to output variable identifiers used

in ABAQUS.

Element integration point variables

new (S)(E) MAXSCRT

Maximum nominal stress damage initiation criterion for cohesive elements.

new (S)(E) MAXECRT

Maximum nominal strain damage initiation criterion for cohesive elements.

new (S)(E) QUADSCRT

Quadratic nominal stress damage initiation criterion for cohesive elements.

new (S)(E) QUADECRT

Quadratic nominal strain damage initiation criterion for cohesive elements.

new (E) DUCTCRT

Ductile damage initiation criterion.

new (E) SHRCRT

Shear damage initiation criterion.

new (E) FLDCRT

Forming limit diagram (FLD) damage initiation criterion.

new (E) FLSDCRT

Forming limit stress diagram (FLSD) damage initiation criterion.

new (E) MKCRT

Marciniak-Kuczynski (M-K) damage initiation criterion.

new (S)(E) DMICRT

All active components of the damage initiation criteria.

Nodal variables

new (S) VOLC

Change in area or change in volume of an element set solely due to adaptive meshing.

Whole element variables

new (S)(E) CALPHAF

Connector kinematic hardening shift force/moment.
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new (S)(E) CASUC

Connector accumulated frictional slip.

rem (S)(E) CASUSL

Renamed to CASUC.

new (E) CDMG

Connector overall damage variable.

new (E) CDIF

Connector force-based damage initiation criterion.

new (E) CDIM

Connector motion-based damage initiation criterion.

new (E) CDIP

Connector plastic motion-based damage initiation criterion.

new (S)(E) CIVC

Connector instantaneous slip velocity when coupled friction is defined.

rem (S)(E) CIVSL

Renamed to CIVC.

new (S)(E) CNFC

Connector friction-producing contact force when coupled friction is defined.

rem (S)(E) CNFSL

Renamed to CNFC.

new (S)(E) CSFC

Connector friction force when coupled friction is defined.

rem (S)(E) CSFSL

Renamed to CSFC.

new (S)(E) CUE

Connector relative elastic motions.

new (S)(E) CUP

Connector relative plastic motions.

new (S)(E) CUPEQ

Connector equivalent relative plastic motions.
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I. PRODUCT INDEX

ABAQUS/Standard

Section 2.12 Performance improvements for ABAQUS/Standard models with many section

and/or material definitions

Section 2.13 Performance improvements for ABAQUS import models

Section 3.1 Parallel execution

Section 3.2 Parallel execution of the element operations in ABAQUS/Standard

Section 3.3 Enhancements to the translator for NASTRAN bulk data files

Section 3.4 Enhancements to the translator for NASTRAN Output2 files

Section 3.6 Enhancements to the input file and output database upgrade utility

Section 4.13 Defining interior cross-section surfaces

Section 4.14 Defining matrices

Section 4.15 Defining a nonstructural mass

Section 6.1 Transferring results between ABAQUS analyses

Section 6.2 Enhancements to the steady-state transport procedure and symmetric model

generation technique

Section 6.4 Extension of adaptive meshing in ABAQUS/Standard

Section 6.5 Contact iterations in ABAQUS/Standard

Section 6.6 Reading temperatures from a previous analysis

Section 6.7 Enhancements to the submodeling analysis procedure

Section 6.8 Modal damping and eigenmode selection by frequency range

Section 6.9 Fluid-structure interaction

Section 6.10 Residual modes

Section 6.11 Enhancements to the iterative equation solver

Section 7.6 Energy dissipation in elastomeric foams

Section 8.2 Continuum shell elements: modified through-thickness modulus

Section 8.4 New connector behaviors

Section 8.5 Enhanced orientation definition methods

Section 8.6 Cohesive elements

Section 8.7 Assigning element properties on an element-by-element basis

Section 8.8 Change in default hourglass control method for elements modeled with finite-

strain elasticity

Section 9.1 Distributed surface tractions and edge loads

Section 10.1 Surface-to-surface tie constraint formulation

Section 10.2 Performance improvements for deformable elements declared as rigid

Section 10.3 Embedding beam and shell elements into solid elements

Section 10.4 New fastener interface using connector elements

Section 11.1 Surface-to-surface small-sliding contact accounting for thickness

Section 11.2 Improved contact stresses for second-order elements
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Section 11.7 Performance improvements for interacting radiation heat transfer

Section 11.11 Stabilization of multi-body contact problems with rigid body modes

Section 11.12 Elimination of multiple state and model files during element reordering

Section 14.1 User subroutine to define the magnitude and loading directions of nonuniform

distributed surface tractions, edge loads, and edge moments

Section 14.2 User subroutine to specify mesh motion constraints during adaptive meshing

Section 14.3 Utility routine to determine elements adjacent to a node

Section 14.4 Utility routine to read results data averaged at a node

Section 14.5 Utility routine to read nodal results data

Section 15.10 Connector output

Section 15.11 Filtering and improved output

Section 15.13 Substructure matrix output

Section 15.14 Steady-state dynamic output enhancements

ABAQUS/Explicit

Section 2.10 Memory reductions for ABAQUS/Explicit analyses

Section 2.13 Performance improvements for ABAQUS import models

Section 3.1 Parallel execution

Section 3.3 Enhancements to the translator for NASTRAN bulk data files

Section 3.4 Enhancements to the translator for NASTRAN Output2 files

Section 3.5 Translating PAM-CRASH input files to partial ABAQUS input files

Section 3.6 Enhancements to the input file and output database upgrade utility

Section 4.13 Defining interior cross-section surfaces

Section 4.15 Defining a nonstructural mass

Section 6.1 Transferring results between ABAQUS analyses

Section 6.3 Removal of limitations for domain-level parallelization in ABAQUS/Explicit

Section 6.6 Reading temperatures from a previous analysis

Section 6.7 Enhancements to the submodeling analysis procedure

Section 6.9 Fluid-structure interaction

Section 7.5 Progressive damage and failure

Section 7.6 Energy dissipation in elastomeric foams

Section 7.7 Kinematic hardening plasticity in ABAQUS/Explicit

Section 7.8 Evaluation of strain-rate-dependent data in ABAQUS/Explicit

Section 7.9 Orthotropic elastic-plasticity in ABAQUS/Explicit

Section 8.2 Continuum shell elements: modified through-thickness modulus

Section 8.3 Connector elements: new connection types and kinematics

Section 8.4 New connector behaviors

Section 8.5 Enhanced orientation definition methods

Section 8.6 Cohesive elements

Section 8.8 Change in default hourglass control method for elements modeled with finite-

strain elasticity
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Section 8.9 Change in default element distortion control for solid elements modeled with

finite-strain elastic materials

Section 9.1 Distributed surface tractions and edge loads

Section 10.1 Surface-to-surface tie constraint formulation

Section 10.3 Embedding beam and shell elements into solid elements

Section 10.4 New fastener interface using connector elements

Section 11.3 Accounting for shell offsets in the general contact algorithm

Section 11.6 Specifying initial clearances and controlling initial overclosure adjustments for

general contact

Section 11.9 Controlling nodal erosion for general contact

Section 11.10 Performance improvements for general contact

Section 15.6 Integrated output over a surface

Section 15.7 Whole surface contact output in general contact

Section 15.10 Connector output

Section 15.11 Filtering and improved output

ABAQUS/CAE

Section 2.2 Preselection highlighting

Section 2.3 Enhanced color selection

Section 2.4 Enhanced printing on Windows platforms

Section 2.5 The Model Tree

Section 2.6 Saving your display options and GUI settings

Section 2.7 Suppressing and resuming step-dependent objects

Section 2.8 Support for 3Dconnexion motion controllers

Section 2.9 Exporting to VRML

Section 2.11 Display group enhancements

Section 2.14 Viewport annotations and tools

Section 3.1 Parallel execution

Section 3.6 Enhancements to the input file and output database upgrade utility

Section 3.7 Direct submission of input files for analysis in ABAQUS/CAE

Section 4.1 Introducing dependent part instances

Section 4.2 Filleting and chamfering shell edges

Section 4.3 Creating patterns of instances

Section 4.4 Contact constraint moved

Section 4.5 Translating and rotating part instances with existing constraints applied

Section 4.6 Regeneration of position constraints

Section 4.7 Angle query

Section 4.8 Sketcher tools and enhancements

Section 4.9 Partitioning a cell with a sketch

Section 4.10 ABAQUS/CAE colors different sides of a shell surface

Section 4.11 Using selection groups during selection procedures

Section 4.12 Merging groups of sets or surfaces
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Section 4.15 Defining a nonstructural mass

Section 5.1 Import part from output database enhanced

Section 5.2 New geometry repair tools added

Section 6.1 Transferring results between ABAQUS analyses

Section 6.4 Extension of adaptive meshing in ABAQUS/Standard

Section 6.5 Contact iterations in ABAQUS/Standard

Section 6.6 Reading temperatures from a previous analysis

Section 6.7 Enhancements to the submodeling analysis procedure

Section 6.8 Modal damping and eigenmode selection by frequency range

Section 6.10 Residual modes

Section 7.1 Hyperelastic and viscoelastic material evaluation

Section 7.2 Creating a material when you create a section

Section 7.3 Section assignment enhancements

Section 7.4 Shell and beam section editor enhancements

Section 8.1 Continuum shell elements: ABAQUS/CAE support

Section 8.3 Connector elements: new connection types and kinematics

Section 8.4 New connector behaviors

Section 8.6 Cohesive elements

Section 9.1 Distributed surface tractions and edge loads

Section 10.1 Surface-to-surface tie constraint formulation

Section 10.3 Embedding beam and shell elements into solid elements

Section 11.1 Surface-to-surface small-sliding contact accounting for thickness

Section 11.3 Accounting for shell offsets in the general contact algorithm

Section 11.4 Specifying feature edge criteria and pure master-slave assignments for general

contact interactions

Section 11.5 Customizing contact controls

Section 11.8 Defining concentrated convective and radiative behavior

Section 11.11 Stabilization of multi-body contact problems with rigid body modes

Section 12.1 Defining skin reinforcements

Section 12.2 Defining point mass and rotary inertia in ABAQUS/CAE

Section 12.3 Defining damping in ABAQUS/CAE

Section 12.4 Defining heat capacitance in ABAQUS/CAE

Section 12.5 Defining a crack in ABAQUS/CAE

Section 12.6 Defining springs and dashpots in ABAQUS/CAE

Section 13.1 Meshing parts

Section 13.2 Merging meshed parts

Section 13.3 Support for curvature-based part seeding

Section 13.4 New tetrahedral meshing algorithm

Section 13.5 Improved advancing front quad-dominated meshes

Section 13.6 Querying the mesh stack direction

Section 13.7 Orienting the mesh stack direction for orphan meshes

Section 13.8 Converting orphan meshes to gasket elements
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Section 13.9 Editing the mesh and preserving the user’s intent

Section 13.10 Using the Edit Mesh toolset to adjust the position of midside nodes

Section 13.11 Using the Edit Mesh toolset to create an offset mesh

Section 14.6 Support for ABAQUS/CAE plug-ins

Section 14.7 Plug-in to display mode contribution factors

Section 15.1 View manipulation and camera options

Section 15.2 Enhanced color coding

Section 15.3 Size control for displayed symbols

Section 15.4 Enhancements to stress linearization

Section 15.5 Creating paths using element edges or circular features

Section 15.6 Integrated output over a surface

Section 15.8 Accessing a remote output database

Section 15.9 Job diagnostics enhancements

Section 15.10 Connector output

Section 15.11 Filtering and improved output

Section 15.12 Viewing the interior of a model

Section 15.15 Vector image output
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